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About This Guide 
This guide is meant to provide comprehensive information on Virtuozzo for Windows – high-
end server virtualization software for Windows-based computers. The issues discussed in this 
guide cover the necessary theoretical conceptions as well as practical aspects of working with 
Virtuozzo. The guide will familiarize you with the way to create and administer Virtual Private 
Servers (sometimes also called Virtual Environments, or VEs) on Virtuozzo-based Hardware 
Nodes and to employ both the graphical and command line interfaces for performing various 
tasks. 

Note: The guide does not familiarize you with the process of installing, configuring, and 
deploying your Virtuozzo system. Detailed information on all these operations is provided in the 
Virtuozzo 3.5.1 for Windows Installation Guide shipped with Virtuozzo. 

According to the task-oriented approach, most topics of this guide are devoted to a particular 
task and the ways to perform it. However, Virtuozzo is equipped with as many as three different 
tools to perform various administrative tasks: 

1 Virtuozzo Management Console (VZMC) with graphical user interface; 

2 Virtuozzo Control Center (VZCC) with web interface; 

3 Virtuozzo command line utilities. 

Besides, there is another tool for managing VPSs - Virtuozzo Power Panels. However, this tool 
is mainly regarded as a means for individual VPS customers to manage their personal VPSs and 
is therefore not described in this guide. 

VZMC is considered the primary tool for administering Virtuozzo and performing main 
administrative tasks on Hardware Nodes and in the VPS context. Therefore, when describing 
the ways to perform this or that task, we have provided the corresponding procedures for 
Virtuozzo Management Console only. Besides, if you are used to working in the command line, 
you can turn to the Reference chapter to learn to manage Hardware Nodes and VPSs by means 
of Virtuozzo command line utilities. As for VZCC, a web counterpart of VZMC, it is provided 
with its own guide as well as a comprehensive online help system. 
 

C H A P T E R  1  

Preface 
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Who Should Read This Guide 
The primary audience for this book is anyone responsible for administering one or more systems 
running Virtuozzo 3.5.1 for Windows. To fully understand the major Virtuozzo notions and 
learn to perform the main administrative operations, no more than basic Windows 
administration habits is required. 
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Organization of This Guide 
Chapter 2, Virtuozzo Philosophy, is a must-read chapter that helps you grasp the general 
principles of Virtuozzo operation. It provides an outline of Virtuozzo architecture and lets you 
understand the Virtuozzo licensing policy. 

Chapter 3, Operations on Virtual Private Servers, covers those operations that you may perform 
on Virtual Private Servers by means of VZMC: creating and deleting Virtual Private Servers, 
starting and stopping them, migrating between Hardware Nodes, etc. 

Chapter 4, Managing Templates, shows you the way to handle Virtuozzo application templates 
properly – create your own templates, upload and install them on the Hardware Node, add 
templates to Virtual Private Servers, etc. 

Chapter 5, Managing Resources, zeroes in on configuring the resource control parameters for 
different VPSs. These parameters include disk quotas, CPU time, and a set of memory-related 
resources. 

Chapter 6, Managing Hardware Nodes, centers on all those operations you as Hardware Nodes 
administrator can perform on your Nodes. 

Chapter 7, Logs and Monitors, explains the ways to keep track of all system events and the 
consumption of all kinds of resources by the running Virtual Private Servers and the Hardware 
Node itself. 

Chapter 8, Managing Services and Processes, familiarizes you with the operations you can 
perform on processes and services in Virtuozzo by using the VZMC graphical interface. 

Chapter 9, Customizing VZCC/VZPP, contains instructions for experienced administrators on the 
way to customize Virtuozzo Control Center and Virtuozzo Power Panels by changing their 
layout and appearance and modifying certain VZCC/VZPP settings. 

Chapter 10, Advanced Tasks, enumerates those tasks that are intended for advanced system 
administrators who would like to obtain deeper knowledge about Virtuozzo capabilities. 

Chapter 11, Troubleshooting, suggests ways to resolve common inconveniences should they 
occur during your work with the Virtuozzo software. 

Chapter 12, Reference, is a complete reference on the main VPS parameters, action scripts that 
can be executed on performing certain VPS-related operations, and all Hardware Node 
command-line utilities. You can read this chapter if you wish to learn how to configure VPS 
parameters by editing its configuration file, wish to do additional actions by specifying your 
own scripts, need help for a particular command, or are looking for a command to perform a 
certain task. 
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Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. For information on specialized terms used in the documentation, see the Glossary at 
the end of this document. 
 

Typographical Conventions 
The following kinds of formatting in the text identify special information. 

Formatting 
convention 

Type of Information Example 

Preformatted On-screen computer output in your 
command-line sessions; source code in 
XML, C++, or other programming 
languages. 

Saved parameters for VPS 101 

Preformatted 
Bold 

What you type, as contrasted with on-
screen computer output. 

C:\Documents and 
Settings\Administrator> 
vzlist 

Monospace The names of commands, files, and 
directories. 

Use vzctl start to start a VPS. 

Monospace 
Italics 

Designates a command line 
placeholder, which is to be replaced 
with a real name or value. 

To destroy a VPS, type vzctl destroy 
VPSID. 

Special Bold All elements of the graphical user 
interface (GUI): menu items, menu 
options, menu buttons, etc. 

Go to the QoS tab. 

 Titles of chapters, sections, and 
subsections. 

Read the Basic Administration chapter. 

Italics Used to emphasize the importance of a 
point or to introduce a term. 

Host Operating System is an operating 
system installed on the Hardware Node. 

CAPITALS Names of keys on the keyboard. SHIFT, CTRL, ALT 

KEY+KEY Key combinations for which the user 
must press and hold down one key and 
then press another. 

CTRL+P, ALT+F4 

 
 

Prompts in Command Examples 
Command line examples throughout this guide presume that you are using the standard 
Windows command line that can be launched by entering cmd in the standard Windows Run 
dialog window. Inasmuch as you are supposed to work with Virtuozzo with an administrator's 
privileges, the commands presented in this guide are prepended with the following command 
line prompt: C:\Documents and Settings\Administrator>. 
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General Conventions 
Be aware of the following conventions used in this book.  

 Chapters in this guide are divided into sections, which, in turn, are subdivided into 
subsections. For example, Documentation Conventions is a section, and General Conventions 
is a subsection. 

 When following steps or using examples, be sure to type double-quotes (") and single-
quotes (') exactly as shown. 

 

Feedback 
If you spot a typo in this guide, or if you have thought of a way to make this guide better, we 
would love to hear from you! 

If you have a suggestion for improving the documentation (or any other relevant comments), try 
to be as specific as possible when formulating it. If you have found an error, please include the 
chapter/section/subsection name and some of the surrounding text so we can find it easily. 

Please submit a report by e-mail to userdocs@swsoft.com. 
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About Virtuozzo Software 

What is Virtuozzo 
Virtuozzo is a complete server automation and virtualization solution based on a patent-pending 
technology developed by SWsoft. Virtuozzo creates multiple isolated Virtual Private Servers 
(VPSs) on a single physical server to share hardware, licenses, and management effort with 
maximum efficiency. Each VPS performs and executes exactly like a stand-alone server for its 
users and applications as it can be rebooted independently and has its own Administrator access, 
Active Directory domain users, IP addresses, memory, processes, files, applications, system 
libraries, and configuration files. Light overhead and efficient design of Virtuozzo makes it the 
right virtualization choice for production servers with live applications and real-life data. 

The basic Virtuozzo capabilities are: 

 Dynamic Real-time Partitioning – Partition a physical server into tens of VPSs, each with full 
dedicated server functionality. 

 Resource Management – Assign and control VPS resource parameters and re-allocate 
resources in real-time. 

 Virtualization - Move VPSs and its application(s) between physical servers transparently 
with near-zero or zero downtime. 

 Mass Management - Manage a multitude of physical servers and Virtual Private Servers in a 
unified way. 

 

C H A P T E R  2  

Virtuozzo Philosophy 
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What is VPS 
VPS is a virtual private server, which is functionally identical to an isolated standalone server: 

 Each VPS has its own processes, Active Directory domain users, files and provides full 
administrative access. 

 Each VPS has its own IP addresses, port numbers, filtering and routing rules. 
 Each VPS can have its own configuration for the system and application software, as well 

as its own versions of Dynamic Link Libraries (DLLs), system libraries, and registry. It is 
possible to install or customize software packages inside a VPS independently from other 
VPSs or the host system. Multiple distributions of a package can be run on one and the same 
Windows box. 

 Each VPS has its own unique Administrator user with full control over the given VPS 
and full access to other user accounts inside this VPS. 

 Each VPS can be a member of a Windows domain (e.g. access any of the network shares to 
which the VPS user has rights). Moreover, any Virtual Private Server can act as a domain 
controller granting other VPSs and stand-alone servers users access to a set of network 
resources (applications, printers, etc.). 

 

Virtuozzo Applications 
Virtuozzo can be efficiently applied in a wide range of areas: enterprise server consolidation, 
web and applications hosting, software development and testing, user training, and so on. 

If you administer a number of Windows dedicated servers within an enterprise, you can benefit 
from the Virtuozzo solution in the following ways: 

 Reduce the number of required physical servers and corresponding support by grouping a 
multitude of your enterprise servers onto a single computer without losing a bit of valuable 
information and without compromising performance. 

 Increase server utilization and maximize server potential. 
 Provision servers in minutes by using the technology of Virtuozzo templates. 
 Migrate Virtual Private Servers in the time of network data transfer, nearly eliminating the 

planned downtime and enabling fast reaction to unplanned downtime situations. 
 Monitor OS and application versions and update/upgrade the current software easily across 

all of your physical servers running Virtuozzo and their Virtual Private Servers. 
 Guarantee Quality-of-Service (QoS) in accordance with a corporate service level agreement 

(SLA). 
 Automate routine tasks such as upgrades and updates. 
 Minimize software license and support requirements, etc. 

Due to its unique efficiency and completeness, Virtuozzo has also a wide variety of profitable 
uses for Hosting Service Providers allowing them to: 

 Sell new powerful and popular services such as: 
 Advanced Shared for shared hosting with customized application sets and QoS; 

 True VPS for a cheaper, secure, and easier alternative to dedicated servers; 
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 Split Dedicated allowing your customers to split the servers for their better utilization, 
etc. 

 Provide complete self-administration panels (Virtuozzo Power Panels) including system 
backup/restore and monitoring tools. 

 Have a multitude of customers with their individual full-featured Virtual Private Servers 
sharing a single physical server. 

 Transparently move customers and their environments between servers, without any manual 
reconfiguration. 

 Increase profitability through the better management and leverage of hardware and software 
investments. 

 Automate service provisioning by using the technology of Virtuozzo templates, etc. 

Besides, Virtuozzo proves invaluable for IT educational institutions that can now provide every 
student with a personal Windows server, which can be monitored and managed remotely. 
Software development companies may use Virtual Private Servers for testing purposes and the 
like. 
 

Virtuozzo 3.5.1 for 64-bit Processors 
Virtuozzo 3.5.1 is released in two variants – for common 32-bit processors and for the x86-64 
64-bit processors. Depending on the kind of processors to be used, this or that variant of the 
Virtuozzo distribution set should be chosen. 

A list of supported 64-bit processors is presented below: 

 AMD Opteron; 
 AMD Athlon 64; 
 Intel Xeon with EM64T support; 
 Intel Pentium with EM64T support. 

The Virtuozzo 32-bit version has been fully ported to support x86-64 64-bit processors, 
therefore, all its functionality is retained in the 64-bit version. So, you can use any Virtuozzo 
tool and utility in exactly the same way as you would use it on the computers with standard 32-
bit processors. 

However, while working with the 64-bit version of Virtuozzo, you should keep in mind the 
following: 

1 The Virtuozzo 64-bit version should be installed on the computer running Windows Server 
2003 x64 Edition and Windows Server 2003 R2 x64 Edition (English or Japanese). In all 
other respects, installing Virtuozzo is the same as is described in Chapter 3 of the Virtuozzo 
3.5.1 for Windows Installation Guide. 

2 The Virtual Private Servers created under Virtuozzo for x86-64 should use the 64-bit OS 
template. 

3 The Virtuozzo version for the 64-bit processors allows you to add only 64-bit application 
templates to your Virtual Private Servers. 

4 You cannot migrate Virtual Private Servers residing on a Hardware Node running the 
Virtuozzo 32-bit version to Hardware Nodes running the Virtuozzo 64-bit version and vice 
versa. Detailed information on how to migrate VPSs from one Node to another is given in 
the Migrating VPS section (on page 68). 
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5 You can use any Hardware Node as a Backup Node irrespective of the Virtuozzo version 
installed on this Node. So, you can back up a VPS from the Node running the Virtuozzo 32-
bit version and store it on the Node running the Virtuozzo 64-bit version and vice versa. 
More information on VPS backups is provided in the Backing Up and Restoring VPSs 
section (on page 45). 

Except for these points, installing and using Virtuozzo 3.5.1 for 64-bit processors does not differ 
from working with its 32-bit counterpart. 

Note: The 64-bit versions of Virtuozzo allows you to create Virtual Private Servers running 
German, Spanish, French, Simplified Chinese, or Traditional Chinese versions of Windows 
Server 2003 x64 Edition with the help of Multilingual User Interface Pack (MUI). Detailed 
information on MUI is provided in the Preparing Virtuozzo 64-bit for Creating Localized VPSs 
subsection of the Installing and Configuring Virtuozzo on Hardware Node chapter in the Virtuozzo 
3.5.1 for Windows Installation Guide. 
 

Distinctive Features of Virtuozzo 
The concept of Virtuozzo Virtual Private Servers is distinct from the concept of traditional 
virtual machines in the respect that Virtual Private Servers (VPSs) always run the same OS 
kernel as the host system (Linux on Linux, Windows on Windows, etc.). This single-kernel 
implementation technology allows to run Virtual Private Servers with a near-zero overhead. 
Thus, Virtuozzo VPSs offer an order of magnitude higher efficiency and manageability than 
traditional virtualization technologies. 
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OS Virtualization 
From the point of view of applications and Virtual Private Server users, each VPS is an 
independent system. This independence is provided by a virtualization layer over the kernel of 
the Host OS. Note that only a small part of the CPU resources is spent on virtualization (around 
1-2%). The main features of the virtualization layer implemented in Virtuozzo are the 
following: 

 VPS looks like a normal Windows system. Software from vendors can run inside any VPS 
without Virtuozzo-specific modifications or adjustment; 

 VPS has its own unique Administrator user with full control over the given VPS and 
can have a number of other local users with different rights and permissions assigned to 
them in respect of this VPS; 

 Users can install additional application and system software inside VPSs; 
 VPS can be a member of an Active Directory domain (e.g. access any of the network shares 

to which the VPS user has rights). Moreover, any Virtual Private Server can act as an Active 
Directory domain controller granting other VPSs and stand-alone servers users access to a 
set of network resources (applications, printers, etc.); 

 Virtual Private Servers are fully isolated from each other in respect of their users, processes, 
services, file systems, and installed applications; 

 Virtual Private Servers share the same executable code, which greatly saves both RAM and 
disk space; 

 Processes belonging to a VPS are scheduled for execution on all available CPUs. 
Consequently, VPSs are not bound to only one CPU, and any application inside each VPS 
can use all available CPU power. 
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Network Virtualization 
The Virtuozzo network is designed in such a way as to make Virtual Private Servers 
communicate with each other and computers on external networks. The picture below 
demonstrates the structure of such a network: 

 

Figure 1: Network Virtualization 

In Virtuozzo-based systems, all VPSs on the Node use the Virtuozzo Network Adapter 
as the default gateway to send and receive data to/from other networks (shown as the Public 
Network in the picture above). The network adapter is automatically created on the Hardware 
Node during the Virtuozzo installation and has a private IP address assigned to it. All IP packets 
from Virtual Private Servers come to this address (gateway) and are redirected thru a public IP 
address of the Hardware Node to the corresponding computer on the Public Network. In the 
same way, all IP packets coming from the outer world and destined for VPS IP addresses reach 
the public IP address of the Hardware Node first and, afterwards, are sent to the addresses of the 
corresponding Virtual Private Servers. In the latter case, the Node acts as an ARP (Address 
Resolution Protocol) server translating IP addresses to network addresses of Virtual Private 
Servers. 
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The Virtuozzo Network Adapter is also used to exchange the traffic among all the VPSs hosted 
on the given Hardware Node. All the network traffic of a VPS is isolated from that of the other 
VPSs, i.e. all Virtual Private Servers are protected from each other in the way that makes traffic 
snooping impossible. 

Like any other stand-alone computer on a network, each VPS on the Hardware Node should 
have not only a valid IP address (several IP addresses per VPS are allowed), but a subnet mask 
which is used to unite Virtual Private Servers as well as any other stand-alone computers on the 
network into one or several subnets. It is not recommended to have all the VPSs on a Node from 
a single subnet, as in this case you will have to manually change the VPS IP address(es) every 
time you migrate a VPS to another Node. Instead, use the subnets of your entire datacenter. 
Thus, all the Hardware Node administrator has to do while setting up their network is make sure 
that: 

 One or more public IP addresses are assigned to the Hardware Node; 
 At least one valid IP address is assigned to each Virtual Private Server created on the Node; 
 All VPSs belong to subnets not limited to the given Hardware Node; 
 IP packets sent to VPS IP addresses successfully reach the Node public IP address(es). 

All the other operations (creating the private IP address of the Virtuozzo Network Adapter, 
delivering IP packets to the corresponding IP addresses, etc.) are performed by Virtuozzo. 
 

Virtuozzo File System (VZFS) 
VZFS is a file system that allows to share common files among multiple VPSs without 
sacrificing security. Any VPS user can modify, update, replace, and delete any application file 
inside a Virtual Private Server like s/he does it on an isolated stand-alone server. When a user 
modifies a shared file, VZFS creates a private copy of the file transparently for the user. Thus, 
the modifications do not affect the other users of the file. Main benefits of VZFS are the 
following: 

 It saves memory required for executables and Dynamic Link Libraries (DLLs). A typical 
VPS running a simple web site might consume around 30–50 MBytes of RAM just for 
executable images. Sharing this memory improves scalability and total system performance; 

 It saves disk space. A typical Windows server installation occupies several hundred MBytes 
of disk space. Sharing the files allows you to save more than 90% of disk space. 
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Templates 
A template in Virtuozzo is a set of application files and registry settings installed on the Host 
operating system in such a way as to be usable by any VPS by mounting over Virtuozzo File 
System. Virtuozzo provides tools for creating templates, installing and removing them on/from 
the Hardware Node, adding them to a VPS, etc. Using templates lets you: 

 Securely share the RAM among similar applications running in different VPSs to save 
hundreds of megabytes of memory; 

 Securely share the files comprising a template among different VPSs to save gigabytes of 
disk space; 

 Install applications and patches simultaneously in many VPSs. 

There are two types of templates in Virtuozzo. These are OS templates and application 
templates. An OS template is an operating system and the standard set of applications to be 
found right after the installation. Virtuozzo uses OS templates to create new Virtual Private 
Servers with a preinstalled operating system. An application template is a set of files and 
registry settings pertaining to this or that application. Virtuozzo uses application templates to 
add extra software to the existing Virtual Private Servers. For example, you can create a Virtual 
Private Server on the basis of the Windows Server 2003 OS template and add the Microsoft 
SQL server application to it with the help of the MSSql template. 
 

Resource Management 
Virtuozzo Resource Management controls the amount of resources available to Virtual Private 
Servers. The controlled resources include such parameters as CPU power, disk space, a set of 
memory-related parameters. Resource management allows Virtuozzo to: 

 Effectively share available Hardware Node resources among VPSs; 
 Guarantee Quality-of-Service (QoS) in accordance with a service level agreement (SLA); 
 Provide performance and resource isolation and protect from denial-of-service attacks; 
 Simultaneously assign and control resources for a number of Virtual Private Servers; 
 Manage a multitude of Hardware Nodes in a unified way by means of Virtuozzo 

Management Console (VZMC); 
 Collect usage information for system health monitoring, etc. 

Resource Management is much more important for Virtuozzo than for a standalone computer 
since computer resource utilization in a Virtuozzo-based system is considerably higher than that 
in a typical system. 
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Main Principles of Virtuozzo 
Operation 

Basics of Virtuozzo Technology 
In this section we will try to let you form a more or less precise idea of the way the Virtuozzo 
software operates on your computer. Please see the figure below: 

 

Figure 2: Virtuozzo Technology 

This figure presumes that you have a number of physical servers united into a network. In fact, 
you may have only one dedicated server to effectively use Virtuozzo. If you have more than one 
Virtuozzo-based physical server, each one of the servers will have a similar architecture. In 
Virtuozzo terminology, such servers are called Hardware Nodes (or HN, or just Nodes), because 
they represent hardware units within a network. 
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Virtuozzo for Windows is installed on a computer running Windows Server 2003 or Windows 
Server 2003 Service Pack 1 (shown as Host Operating System in the figure above). After 
Virtuozzo is installed, you will be able to run Virtuozzo services supporting virtualization on 
your computer. This support is presented above as Virtuozzo Layer. The Virtuozzo layer ensures 
that Virtual Private Servers, sharing the same Hardware Node and the same OS kernel, are 
isolated from each other. A Virtual Private Server is a kind of ‘sandbox’ for processes and users. 

Before you are able to create a Virtual Private Server, you should install the corresponding OS 
template in Virtuozzo. This is displayed as Virtuozzo Templates in the scheme above. In the 
current version of Virtuozzo for Windows, Virtual Private Servers can run only the Windows 
Server 2003 OS and the Windows Server 2003 OS with Service Pack 1 installed (English, 
German, French, Spanish, Traditional Chinese, Simplified Chinese, or Japanese Standard or 
Enterprise Edition). In this case we say that a VPS is based on the Windows Server 2003 OS 
template. 

After you have installed at least one OS template, you can create any number of VPSs with the 
help of various Virtuozzo management tools (VZMC, VZCC, or the command line tools), 
configure their network and/or other settings, and work with these VPSs as with fully functional 
Windows servers. 

Note: Hereafter, the Windows Server 2003 OS denotation is used to indicate both Windows 
Server 2003 and Windows Server 2003 Service Pack 1. 
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Understanding Templates 
Templates are part and parcel of the Virtuozzo philosophy because they provide a way of 
sharing resources among lots of Virtual Private Servers, thus enabling huge savings in terms of 
disk space and memory. All Virtuozzo templates are divided into OS templates and application 
templates. OS templates are used to create new Virtual Private Servers. In Virtuozzo 3.5.1, only 
the Windows Server 2003 OS template can be used for creating new VPSs. Application 
templates are added to VPSs after the latter have been created; more than one application 
template may be added to one and the same VPS. Examples of application templates are the 
msde, openssh, Plesk templates, or a template with any other application (possibly more 
than one application in a single template) not included into the OS template for some reason. 

Note: The Windows Server 2003 OS template installed on the Node and used to create new 
VPSs can be updated like any other application template by installing the corresponding OS 
updates for this template. 

Let us take, for example, the Plesk application template, representing the Plesk 
comprehensive server management software. It is created by SWsoft on the basis of the original 
Plesk application. When you install this application template in Virtuozzo, Virtuozzo creates the 
C:\vz\Templates\Plesk\ directory containing all the application files that can be shared 
among Virtual Private Servers. When the template is added to a VPS, it contains only special 
placeholders (stubs, in Virtuozzo terminology) of the necessary template files. These stubs 
occupy very little space on the hard disk, the size of the stub files being 0 bytes. They are 
situated in the so-called private area of the VPS. The corresponding directory is 
C:\vz\private\<VPS_ID>\root. The private area of a VPS contains not only stubs, but 
also those files that have been changed by the VPS user and all the private VPS files. 

Note: During the Virtuozzo installation, the Templates subdirectory is automatically created 
in the directory you specify for storing all VPS data. By default, the C:\vz\ directory is used. 
However, you may define another path for this directory. 

Thanks to the fact that the real application files are written to the hard disk only once, gigabytes 
of disk space are saved that would be lost if the application were installed separately into each 
and every VPS. Moreover, the application is also loaded only once into the Node memory, so 
memory savings are also tangible. 

Thus, in order to add a template application to any number of VPSs, you should perform the 
following steps: 

1 Install the Virtuozzo template on the Hardware Node. Upon installation, the corresponding 
C:\vz\Templates\<application_name>\ directory is created on the Hardware 
Node in order to enable sharing common application files among VPSs. 

2 Add the installed template to any number of Virtual Private Servers of your choice. 

All these steps can be performed by using VZMC, VZCC, or by means of the command line 
tools. 

It goes without saying that in case you want to install an application in only one VPS, there is no 
need in working with templates: you can work inside the corresponding VPS as well. 
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VZMC Overview 
Virtuozzo Management Console (VZMC) is a remote management tool for Virtuozzo with 
graphical user interface. It is intended to be installed on the administrator's computer and allows 
the administrator to control multiple Hardware Nodes, to manage all their Virtual Private 
Servers, and to monitor the system. The main window of VZMC consists of two parts: the tree 
pane on the left and the view pane on the right. 

 

 

Figure 3: VZMC Main Window 

There is a list of Hardware Nodes in the tree pane. The Hardware Node subtree contains a 
number of items providing convenient access to various aspects of the Hardware Node 
management, e.g. Configuration, Logs, etc. The contents of the view pane depend on the item 
selected in the tree pane. 

VZMC uses a typical client/server architecture. The client VZMC program runs on Microsoft 
Windows 2000/XP/2003 or Linux. The client application with the graphical user interface 
connects to the Virtuozzo Agent software, which is running in the special Service VPS on the 
Hardware Node. Virtuozzo Agent communicates with the client via the well-documented open 
VZAgent XML API and controls the Hardware Node itself and its Virtual Private Servers. 

Note: For more information on Virtuozzo Agent and on how to access its services by using 
XML, please turn to the VZAgent Developer's Guide and the Getting Started With VZAgent SOAP 
guide shipped with Virtuozzo. 
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Figure 4: VZMC Network Architecture 

The client may control multiple Hardware Nodes simultaneously by connecting to multiple 
Virtuozzo Agents. As the communications between the client and Virtuozzo Agents are secure, 
the VZMC workstation may be located virtually anywhere on the net. 

More detailed information on the VZMC installation, licensing, and functioning is provided in 
the Installing Virtuozzo Management Console chapter of the Virtuozzo 3.5.1 for Windows 
Installation Guide. 
 

VZMC Restrictions 

Though Virtuozzo Management Console is considered the primary tool for administering 
Virtuozzo and allows you to perform most administrative tasks on your Hardware Nodes and 
inside Virtual Private Servers, it does not have graphical counterparts of all the Virtuozzo 
command line utilities. 

Among such utilities are the following: 

vzctl restart - used to consecutively perform the stopping and starting of the 
corresponding VPS; 

vzexport - used to back up the given VPS to some file on the Hardware Node; 

vzimport - used to restore the backed up VPS to its original state; 

vzcache - used to scan the specified Virtual Private Servers for common files and cache 
these files in the Hardware Node template area; 

vzlscache - used to display a list of cache directories created by the vzcache utility; 

vzuncache - used to copy the regular files from the specified cache directory on the 
Hardware Node back to the private area of the specified VPS. 
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On the other hand, all operations that can be performed in VZMC can also be performed by 
means of Virtuozzo command line utilities. Detailed information on all Virtuozzo utilities is 
provided in the Reference chapter. 
 

VZCC Overview 
Virtuozzo Control Center (VZCC) is designed for Hardware Node administrators and provides 
you with the ability to manage a particular Hardware Node and all Virtual Private Servers 
residing on it with the help of a standard Web browser on any platform. A list of supported 
browsers is given below: 

 Internet Explorer 6.0 and above; 
 Mozilla 1.7 and above; 
 Firefox 1.0 and above. 

Chances are that you will also be able to use other browsers, but Virtuozzo has not been 
extensively tested with them. 

In the current version of Virtuozzo, you are able to perform the following main operations on 
the Hardware Node and in the VPS context by using VZCC: 

 View and install Virtuozzo licenses; 
 Create new Virtual Private Servers; 
 Manage VPS backups; 
 Edit the VPS hostname, IP address, and DNS server parameters; 
 Manage VPS applications; 
 Manage VPS configuration templates; 
 Manage both VPS groups and individual VPSs; 
 Manage and monitor Hardware Node and VPS resources; 
 Start, stop, and restart certain services inside the VPS; 
 View the processes currently running on the Node and inside Virtual Private Servers and 

send signals to them; 
 View the Virtuozzo logs; 
 Customize the VZCC interface, etc. 

Note: Detailed information on Virtuozzo Control Center is given in its comprehensive online 
help system and the VZCC Administrator's Guide delivered with VZCC. 
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VPS Administrators' Tools 
Wherever Virtuozzo is applied, there are people that are supposed to be administrators of 
particular VPSs only, with no access rights to Hardware Nodes as such. This is only but natural 
as it corresponds directly to the concept of virtualization technology. Such people can be 
subscribers to a hosting provider, university students, administrators of a particular server within 
an enterprise, etc. Personal VPSs can be managed with the help of Virtuozzo Power Panels 
(VZPP). VZPP is a means for administering personal VPSs thru a common browser - Internet 
Explorer, Mozilla, and others. It allows VPS administrators to: 

 Start, stop, or restart the VPS; 
 Back up and restore the VPS; 
 Change the Administrator password of the VPS; 
 Start, stop, or restart certain services inside the VPS; 
 View the processes currently running in the VPS and send signals to them; 
 View the current resources consumption and resources overusage alerts; 
 Connect to the VPS by means of RDP; 
 View the system logs; 
 Customize the VZPP interface, etc. 

Access rights to administer particular VPSs by means of VZPP are determined by the Hardware 
Node administrator. The Setting VZCC/VZPP to Work section provides instructions on how to 
control access rights to particular Virtual Private Servers thru VZPP. 

Note: Apart from VZPP, VPS administrators are able to use the standard Windows Remote 
Desktop Connection (RDP) or MS Terminal Service Client (MS TSC) to connect to their VPSs 
and work inside them. 
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Understanding Licensing 
Running Virtuozzo 3.5.1 for Windows involves dealing with a number of licenses. Here we will 
try to make an overview of all these licenses - either those issued by SWsoft directly or related 
to the Windows Server 2003 operating system. 

All the licenses can be divided into two groups: 

 Licenses that are to be installed on the Hardware Node. This group includes a standard 
Windows Server 2003 license, a Virtuozzo license, and a VZCC license. While the first two 
licenses are mandatory and required for installing Virtuozzo and starting to work with it, the 
latter one is needed only in case you are going to use Virtuozzo Control Center for 
managing your Node and Virtual Private Servers. 

 Licenses that can be installed on a computer other than the Hardware Node. Currently, there 
is only one license in this group - a VZMC license. You should obtain this license to use 
Virtuozzo Management Console - a Virtuozzo tool facilitating the management of your 
Hardware Nodes and Virtual Private Servers. 

First of all, Virtuozzo is installed on computers running Windows Server 2003 (English, 
German, French, Spanish, Traditional Chinese, Simplified Chinese, or Japanese Standard or 
Enterprise Edition). Before the Virtuozzo 3.5.1 installation, you should install and activate a 
licensed Windows Server 2003 operating system on your computer. Besides, while running the 
Virtuozzo initial configuration wizard, you will be prompted to use the same licensed CD with 
the Windows Server 2003 OS to add the necessary binary files to the Hardware Node to make 
the Windows Server 2003 OS template fully functional. 

Another license is needed to be able to start using Virtuozzo 3.5.1 itself. To this effect, you 
should load a special Virtuozzo license to the Hardware Node after installing Virtuozzo 3.5.1 on 
the computer with Windows Server 2003. Every Hardware Node shall have its own Virtuozzo 
license file. License files (or simply “licenses”) are issued by SWsoft and define the number of 
VPSs the Node may run. One license file can contain one or several Virtuozzo licenses; in the 
latter case, the license file can be uploaded to several Hardware Nodes. Licenses can be time-
limited or permanent. Virtuozzo licenses have a start date and, if they are time-limited, may also 
have an expiration date specified in them. You shall have to set up your system clock correctly; 
otherwise, the license validation may fail. 

If you plan to use VZMC and/or VZCC to manage your Hardware Node(s) and VPSs (which is 
normally the case), you should additionally have valid VZMC and/or VZCC license serial 
numbers to enter them the first time you launch Virtuozzo Management Console or log in to 
Virtuozzo Control Center. However, a VZCC license is uploaded to the Hardware Node and 
allows you to manage your Node and VPSs from any computer by means of a standard browser, 
whereas a VZMC license is installed on a separate workstation (it can be the Node itself) where 
Virtuozzo Management Console is to be run. 

Thus, before installing Virtuozzo 3.5.1, make sure you have the mandatory licenses to run: 

 Windows Server 2003 (English, German, French, Spanish, Traditional Chinese, Simplified 
Chinese, or Japanese Standard or Enterprise Edition) and 

 Virtuozzo 3.5.1 itself 

and two additional licenses if you wish to use: 

 Virtuozzo Management Console and 
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 Virtuozzo Control Center 

for managing your Nodes and Virtual Private Servers. 
 

Hardware Node Availability 
Considerations 

Hardware Node availability is more critical than the availability of a typical server. Since it runs 
multiple Virtual Private Servers providing a number of critical services, Hardware Node outage 
might be very costly. Hardware Node outage can be as disastrous as the simultaneous outage of 
a number of servers running critical services. 

In order to increase Hardware Node availability and security, we suggest you follow the 
recommendations below: 

 Use RAID storage for critical VPS private areas. Do prefer hardware RAID, but software 
mirroring RAID might suit too as a last resort. 

 Do not run software on the Hardware Node itself. Create special Virtual Private Servers 
where you can host necessary services such as FTP, IIS, and so on. Virtuozzo does not need 
any standard Windows Server 2003 services to be run on the Node. Therefore, we 
recommend that you disable all the services on the Node except for the Virtuozzo services. 

 Use firewalls to make the Hardware Node accept connections from a pre-defined set of IP 
addresses only. 

 Do not create users on the Hardware Node itself. You can create as many users as you need 
in any Virtual Private Server. Remember: compromising the Hardware Node means 
compromising all Virtual Private Servers as well. 

 Do not remove any of the components installed on the Hardware Node. Removing an 
installed component (for example, Internet Information Server), even if you do not use it, 
might cause Virtuozzo to malfunction. 
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Virtual Private Server (or VPS) is functionally identical to an isolated standalone server, having 
its own IP addresses, processes, files, Active Directory domain users, its own configuration 
files, its own applications, Dynamic Link Libraries (DLLs), system libraries, registry, and so on. 
Virtual Private Servers share the same Hardware Node and the same OS kernel. However, they 
are isolated from each other. A Virtual Private Server is a kind of ‘sandbox’ for processes and 
users. 

Virtual Private Servers behave just like isolated stand-alone servers: 

 Each VPS has its own processes, users, files and provides full administrative access; 
 Each VPS has its own IP addresses, port numbers, filtering and routing rules; 
 Each VPS can have its own configuration for the system and application software, as well 

as its own versions of system libraries. It is possible to install or customize software 
packages inside a VPS independently from other VPSs or the host system. Multiple 
distributions of an application can be run on one and the same Windows computer. 
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Creating New VPS 
This section guides you through the process of creating and configuring a Virtual Private 
Server. We assume that you have successfully installed Virtuozzo and the Windows Server 
2003 OS template and created the Service VPS. If you have not, please turn to the Virtuozzo 
3.5.1 for Windows Installation Guide first. 
 

C H A P T E R  3  

Operations on Virtual Private Servers 
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Before You Begin 
Before you start creating a Virtual Private Server, you should: 

 Check that the Hardware Node is visible on your network. You should be able to connect 
to/from other hosts. Otherwise, your VPSs will not be accessible from other computers. 

 Check that you have at least one IP address per a VPS and the addresses belong to the same 
network as the Hardware Node or routing to the Virtual Private Servers has been set up via 
the Hardware Node. 

Note: You can use private addresses for the Hardware Node itself. 
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Choosing VPS ID 
Every Virtual Private Server has a numeric ID, also known as VPS ID, associated with it. The 
ID is a 32-bit integer number beginning with zero and unique for a given Hardware Node. When 
choosing an ID for your VPS, please follow the simple guidelines below: 

 ID 0 is used for the Hardware Node itself. You cannot and should not try to create a VPS 
with ID 0. 

 This version of Virtuozzo uses ID 1 for the Service VPS. 
 Virtuozzo reserves the IDs ranging from 0 to 100. Though Virtuozzo 3.5.1 uses only IDs 0 

and 1 from them, the next version might use additional Virtual Private Servers IDs for 
internal needs. To facilitate upgrading, please do not create VPSs with IDs below 101. 

The only strict requirement for a VPS ID is to be unique for a particular Hardware Node. 
However, if you are going to have several computers running Virtuozzo, we recommend 
assigning different VPS ID ranges to them. For example, on Hardware Node 1 you create VPSs 
within the range of IDs from 101 to 1000; on Hardware Node 2 you use the range from 1001 to 
2000, and so on. This approach makes it easier to remember on which Hardware Node a VPS 
has been created, and eliminates the possibility of VPS ID conflicts when a Virtual Private 
Server migrates from one Hardware Node to another. 

Another approach to assigning VPS IDs is to follow some pattern of VPS IP addresses. Thus, 
for example, if you have a subnet with the 10.0.x.x address range, you may want to assign the 
17015 ID to the VPS with the 10.0.17.15 IP address, the 39108 ID to the VPS with the 
10.0.39.108 IP address, and so on. This makes it much easier to run a number of Virtuozzo 
utilities eliminating the necessity to check up the VPS IP address by its ID and similar tasks. 
You can also think of your own patterns for assigning VPS IDs depending on the configuration 
of your network and your specific needs. 

Before you decide on a new VPS ID, you may want to make sure that no VPS with this ID has 
yet been created on the Hardware Node. It is enough to click on the name of your Hardware 
Node in the left pane, and then on the Virtual Private Servers item. The VZMC right pane will 
display a list of existing VPSs on the Node: 
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Figure 5: VZMC - Viewing Existing VPSs 

You can see that currently the Service VPS with ID 1 and regular VPSs 101 and 102 exist on 
the Hardware Node. 

WARNING! When deciding on a VPS ID, do not use the ID of any VPS that was ever present 
in the system unless you are sure that no data belonging to the old VPS remains on the Node. 
The fact is that the administrator of the newly-created VPS might have access to these data in 
this case, i.e. to the backups of the old VPS, its logs, statistics, etc. 
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Creating VPS 
VZMC uses one wizard to create and initially configure a Virtual Private Server. You can 
launch the Create New Virtual Private Servers wizard by selecting the Virtual Private Servers item 
under the corresponding Hardware Node name in the VZMC left pane and choosing the Create 
Virtual Private Server option on the Action menu: 

 

Figure 6: VZMC - Choosing Sample Configuration File 

The main VPS parameters, including the templates and resource management parameters, can 
be retrieved on the basis of the VPS configuration sample indicated in the very first option 
(detailed information on VPS configuration samples is provided in the Managing VPS Resources 
Configurations section (on page 105)) and the cluster settings, if the given Hardware Node 
belongs to a cluster of Nodes. To know more about clusters, turn to the Managing Node Clusters 
section of the Managing Hardware Nodes chapter. In particular, the Assign Virtual Private Server 
ID automatically... checkbox, if selected, tells VZMC to retrieve a VPS ID(s) from the cluster 
database. 
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The Hostname group of options on the first page of the wizard shown above might help you 
make use of your DNS server. If your DNS server has records for the IP addresses that will be 
assigned to the newly-created VPSs, select the Assign hostname automatically radio button. The 
hostnames will be assigned on the basis of DNS records found. Selecting the Hostname radio 
button allows you to manually set a hostname for the Virtual Private Server. In case of creating 
several VPSs at once, you should use the $VPSID placeholder which is automatically replaced 
with the ID of the VPS being created. For example, if you are creating Virtual Private Servers in 
the range from 101 to 110 and enter MyVPS$VPSID into the Hostname field, your VPSs will 
have the following hostnames: MyVPS101, MyVPS102, ..., MyVPS110. 

You should set the Administrator password for the VPS being created on the first page of 
the wizard by typing the desired password in the Password and Confirm password fields. You 
will need this password in future to connect to the VPS by means of Virtuozzo Power Panels 
(VZPP) or by using the standard Microsoft Terminal Services Client/Windows Remote Desktop 
Connection applications. If you are creating several Virtual Private Servers, all VPSs will be 
given the same Administrator password. However, you can change the password for each 
Virtual Private Server at a later time (see page 71). 
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Pressing the Next button displays the window where you should specify VPS network settings: 

 

Figure 7: VZMC - Specifying Network Settings 

On this screen, you should use the provided Add, Delete, and Edit icons for the corresponding 
operations on VPS IP addresses, their subnet masks, and DNS servers: 

 Each VPS is bound to have at least one IP address assigned to it, so you cannot leave the IP 
Addresses field blank. In the Subnet mask field, you should additionally specify a subnet 
mask to define to what subnetwork the VPS being created will belong. We strongly 
recommend that you specify the same subnet for all Virtual Private Servers on all your 
Nodes. In this case you will not have to manually change the VPS IP address(es) every time 
you migrate a VPS to another Node. 

Note: Make sure that the IP address you wish to assign to the Virtual Private Server differs 
from that assigned to your Hardware Node and the Service VPS. 
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 You may indicate one or more DNS servers that this VPS is supposed to use in the DNS 
servers field or leave it blank. 

In case there are several network interface cards installed on the Hardware Node, Virtuozzo 
allows you to specify the preferred network adapter for the Virtual Private Server by clearing 
the Use system default checkbox, selecting the corresponding network adapter, and clicking on 
the Enable button. This network adapter will be used to connect the VPS to the network, i.e. to 
handle the whole network traffic for this VPS. By default, all network adapters on the Node are 
used to control the network flows of the Virtual Private Server. Detailed information on how to 
manage network interface cards on the Node is provided in the Changing Network Adapter for 
VPS section (on page 198). 

The Obtain network settings automatically radio button becomes available only in case your 
Hardware Node belongs to a cluster of Nodes. This option allows you to automatically select 
and assign an IP address to your VPS from the range of IP addresses specified in the cluster. 
Detailed information on clusters is provided in the Managing Node Clusters section. 

You can click on the Finish button on this step of the wizard and create the VPS with the 
configuration parameters specified in the configuration sample you chose on the first step of the 
wizard. If you do not rely on any configuration sample, press the Next button instead of Finish. 
In this case you will have to go through a number of steps of the wizard and set all the 
parameters of the new VPS separately. However, you can click Finish on every of the following 
steps of the wizard to start creating the VPS. All the pages of the wizard are self-explanatory, so 
there is no need in dwelling upon them here in detail. You have the possibility to choose the 
application templates to be added to the VPSs, to set the path to the VPS private area, to 
configure Quality of Service parameters, to specify whether the VPS is to be started on the 
Hardware Node boot, to enable the Quality of Service packet scheduler and network browsing 
for the VPS, and to allow the offline management for the VPS for it to be directly managed by 
its Administrator from any browser at the VPS IP address. Besides, you can save all the defined 
parameters as a configuration sample file to be used in future for creating new Virtual Private 
Servers on its basis. The information on Quality of Service parameters and VPS samples is 
provided in the Managing Resources chapter (on page 95). Please consult it to gather more 
understanding of these topics. 

Creating a new Virtual Private Server may take some time. You can see the progress in the 
Actions pane. 

Note: Any created Virtual Private Server has the time zone settings similar to those set on the 
Hardware Node at the moment of the Virtuozzo installation. You can change the default time 
zone for a VPS as you would do it on a stand-alone computer (e.g. by logging in to the 
corresponding VPS via RDP, opening Control Panel, clicking Date and Time, and changing your 
time zone on the Time Zone tab of the displayed window). 

After you have created, for example, a VPS with ID 101, you can see it in the right pane of the 
VZMC window: 
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Figure 8: VZMC - Viewing Created VPS 

You can also use the vzctl create command to create a new VPS. Detailed information on 
this command is provided in the Reference chapter. 
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Starting, Stopping, and Querying 
Status of VPS 

When a Virtual Private Server is created, it may be started up and shut down like an ordinary 
computer. In VZMC, you can see the status of all the Virtual Private Servers of the given 
Hardware Node simply by selecting the Virtual Private Servers item under the corresponding 
Node. 

There are two kinds of Virtual Private Servers in the Virtual Private Servers table. You may 
change the properties of and control those that are marked with grey monitor icons. The Virtual 
Private Servers marked with pink monitor icons provide critical services for Virtuozzo (for 
example, the Service VPS). You cannot change the properties of or stop such Virtual Private 
Servers. 

To start or stop one or more Virtual Private Servers, right-click it (them) in the Virtual Private 
Servers table in the right pane and choose Start/Stop on the context menu: 

 

Figure 9: VZMC - Starting VPS 

You can use CTRL+Click to select or deselect an entry, SHIFT+Click to select a range of 
Virtual Private Servers, CTRL+A to select all Virtual Private Servers. Then press the Start or 
Stop button on the toolbar or select Start or Stop on the Action menu. 
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When a VPS is being started or stopped, all the typical operations are performed that happen 
during the startup and shutdown of the Windows operating system on a standalone computer. 
Therefore, starting or stopping a considerable number of Virtual Private Servers may take a 
rather long run. The progress is displayed in the Actions pane. 

In the command line, you can perform all the aforementioned operations by using the vzctl 
utility. Detailed information on this utility is provided in the Reference chapter. 

Note: Before stopping a VPS, make sure that there are no users connected to the VPS by means 
of Microsoft Terminal Services Client or Remote Desktop Protocol. To this effect, open Virtual 
Private Server Manager of the corresponding VPS, select Monitor --> QoS, and check that the 
Number of TS sessions parameter value is equal to 0. 
 

Accessing VPS 
There are a number of ways for you to access a VPS as you would normally access a standalone 
computer: 

 Launching the standard Microsoft Terminal Services Client (MS TSC) application. 
 Launching the standard Windows Remote Desktop Connection application. 
 Accessing the files inside the VPS by the Windows file sharing protocol. 
 Using the Citrix MetaFrame XP application (http://www.citrix.com). 

In all these cases, the access is ensured by using the IP address or hostname of the VPS and the 
administrator's or other users' credentials entered when creating and maintaining the given VPS. 

Note: Please do not install and run Microsoft Terminal Server and Citrix MetaFrame XP inside 
Virtual Private Servers. You are able to open terminal sessions with VPSs and use Citrix ICA 
clients to access VPSs thanks to the MS Terminal Server and Citrix MetaFrame XP applications 
installed on the Host OS, respectively. Terminal Server and Citrix MetaFrame XP installed 
inside a VPS are completely irrelevant and may interfere with normal VPS operation. 
 

Terminal Services Client 
Microsoft Terminal Services Client (MS TSC) is a standard Windows application to be used 
when connecting to any Virtuozzo-based VPS: 

1 Launch MS TSC in the host operating system or on another computer on the network by 
selecting Programs -->Terminal Services Client --> Terminal Services Client on the Windows 
Start menu; 

2 Enter the hostname or the IP address of the VPS in the Server field; 

3 Press Connect. 
4 A new window is launched with an invitation to provide the user name and password for 

logging in to the Virtual Private Server. Type Administrator as the user name and the 
Administrator's password into the corresponding fields and press OK. 
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After the logon, it is possible to change passwords, to create new users, and do all related tasks 
in the standard way inside the VPS. 
 

Remote Desktop Connection 
Remote Desktop Connection is a standard Windows application to be used when connecting to 
any Virtuozzo-based VPS by means of the Remote Desktop Protocol (RDP). The easiest way to 
connect to a VPS is right-clicking it in the list of VPSs and selecting Connect via Remote 
Desktop on the context menu. Naturally, the VPS must be running for this option to become 
available. 

You may connect to the VPS from the Remote Desktop Connection (RDC) application itself: 

1 Launch RDC in the host operating system by selecting Programs --> Accessories --> 
Communications --> Remote Desktop Connection on the Windows Start menu; 

2 Enter the hostname or the IP address of the VPS in the Computer field; 

3 Press Connect. 
4 A new window is launched with an invitation to provide the user name and password for 

logging in to the Virtual Private Server. Type Administrator as the user name and the 
Administrator's password into the corresponding fields and press OK. 

After the logon, it is possible to change passwords, to create new users and do all related tasks 
in the standard way inside the VPS. 

In case of connecting to a VPS as a non-Administrator user, you should make sure that: 

1 The user whose credentials you wish to use to log in to the VPS is created inside this VPS; 

2 The Remote Desktop Users group allowing the VPS users to remotely log in to Virtual 
Private Servers via RDP exists inside the VPS; 

3 The user belongs to the Remote Desktop Users group. 

Note: The default Windows Server 2003 installation permits you to have only 2 (two) RDP/MS 
TSC sessions per Hardware Node opened at the same time. It means that if there are two 
RDP/MS TSC sessions opened simultaneously for any VPSs, you will not be able to establish 
an RDP/MS TSC connection to the Hardware Node itself. If you wish to be able to open more 
RDP/MS TSC sessions at once, you should install additional TSAL (Terminal Service Access 
License) licenses on the Hardware Node. 
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Windows File Sharing 
To access VPS share folders via standard Windows clients, you should type their IP address or 
hostname preceded by two back slashes in the Windows command line or in the address line of 
Windows Explorer on the host operating system or on another computer on the network. You 
may optionally specify the name of the VPS itself to see what shares are available. For example: 
\\vps103\c$ 
\\192.168.20.103 

If an authentication window is displayed, enter the appropriate user name and password for the 
given VPS. There must be an administrative account built in the VPS that you should know or 
you might have already created a number of other users inside the VPS. 
 

Citrix MetaFrame XP 
Citrix MetaFrame XP is a remote access/application publishing product built on the Citrix 
Systems' thin client protocol and used to connect to any Virtuozzo-based VPS. To start using 
Citrix to access your VPSs on the given Hardware Node, you should: 

1 Install and enable the Terminal Services component on the Node; 

2 Install and configure the Citrix MetaFrame XP application on the Node. 

After you have successfully completed the aforementioned operations on your Hardware Node, 
you can use a Citrix ICA Client on the Host OS or on any other computer on the network to 
connect to any of your Virtual Private Servers on this Node by means of the Citrix MetaFrame 
XP application. 

For example, if you have the Program Neighbourhood Client installed on your computer, you 
can select Programs --> ICA Client --> Citrix Program Neighbourhood on the Windows Start menu 
to launch the Citrix ICA Client software. In the opened window, you should then double-click 
the Add ICA Connection icon to invoke the wizard that will help you create a new ICA 
connection to be used to access your Virtual Private Server. 

Note: Detailed information on how to install, license, configure, and operate your Citrix 
MetaFrame XP application is provided in the documentation available on the Citrix web site at 
http://www.citrix.com/support. 
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Listing VPSs 
Very often you may want to get an overview of the Virtual Private Servers existing on the given 
Hardware Node and to get additional information about them - their IP addresses, hostnames, 
status, etc. In VZMC, you may display a list of all VPSs by clicking the Virtual Private Servers 
item: 

 

Figure 10: VZMC - Listing VPSs 

You can see that currently the Service VPS with ID 1 and regular VPSs 101 and 102 exist on 
the Hardware Node. 

To facilitate working with Virtual Private Servers, you can sort them by different parameters: 
their ID, type, hostname, status, IP address, etc. Just click the column with the appropriate name 
to put VPSs in the desired order. 

You may also get a list of all VPSs present on the Hardware Node by using the vzlist 
command line utility. A full list of the vzlist command line switches, output, and sorting 
options is available in the vzlist subsection of the Reference chapter. 
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Backing Up and Restoring VPSs 
A regular backing up of the existing Virtual Private Servers is essential for any Hardware Node 
reliability. It is highly recommended to set up a dedicated Node for running the backing-up 
utilities and storing the VPS backups (further on, the Backup Node). In a more general case, any 
Hardware Node can be assigned an additional role of the Backup Node. 

Any Virtual Private Server is defined by its private area and configuration file. Virtuozzo allows 
you to back up all these components. Each backup file may be of one of the following 2 types: 

 a full backup containing the whole VPS private area and its configuration file; 
 an incremental backup containing only the files changed since the full backup or the 

previous incremental backup. 

An incremental backup may prove very useful because it records only the changes since the last 
VPS backup and therefore is much less in size and takes much less time than the full backup. 
However, after several consecutive incremental backups it is recommended to create a full 
backup de nouveau and start the incremental backups chain from scratch. 

If an incremental backup is performed, and the corresponding full backup cannot be found, a 
full backup is automatically performed. 

Note: You can use any Hardware Node as a Backup Node irrespective of a Virtuozzo version 
installed on this Node. So, you can back up a VPS from the Node running the Virtuozzo 32-bit 
version and store it on the Node running the Virtuozzo 64-bit version and vice versa. 
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Backups Overview 
VZMC deals with three kinds of Nodes - the Source Nodes (the Nodes where VPSs are hosted 
during their backing up); the Backup Nodes (the Nodes where VPS backups are stored); and the 
Destination Nodes (the Nodes where VPS backups are restored). 

 

Figure 11: Backup Overview 

These Nodes are singled out by their functionality only. In reality, one and the same Hardware 
Node may perform two or even three functions. Usually, the Source and Destination Node are 
represented by one and the same HN, because you will likely want the VPSs you back up to be 
restored to their original Node. However, setting up a dedicated Backup Node is recommended. 

You should make sure that all the three Nodes are registered in VZMC before starting to work 
with them. 

VZMC lets you perform the following backup-related functions: 

 Assign the default Backup Node for the given Source Node; 
 Set the default backup folder for storing VPS backups on the Backup Node; 
 Back up a single VPS from the Source Node to the Backup Node; 
 Back up a number of VPSs or the whole Hardware Node (i.e. all the VPSs on the given 

Node) to the Backup Node; 
 Restore a single VPS from the Backup Node to the Destination Node; 
 Restore separate files from the VPS backup on the Backup Node to the Destination Node; 
 Restore a number of VPSs or the whole Hardware Node from the Backup Node; 
 Directly manage the Backup Nodes; 
 Search the backup of a given VPS from the Source Node across all the Backup Nodes. 
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Assigning Default Backup Node 
When you are backing up Virtual Private Servers from a Source Node, you shall always specify 
on what Node the resulting backups should be placed, i.e. the Backup Node. The Default Backup 
Node window allows you to assign the default Backup Node for the given Source Node, i.e. for 
the Node for which the window has been invoked. To display this window, right-click the 
respective Source Node and choose Backup --> Set Default Backup Node on the context menu. 

The window presents a list of Nodes registered in VZMC together with their IP addresses. If the 
default Backup Node already exists for the given Source Node, it is selected in the table. You 
should select the Node you wish to be the default Backup Node for the given Source Node and 
press OK. The assignment of the default Backup Node brings about the following effects: 

 When backing up Virtual Private Servers from the corresponding Source Node, you will be 
automatically suggested to place the backups onto the default Backup Node. This facilitates 
keeping track of those places where various backups are stored. 

 When a VPS administrator backs up their Virtual Private Server by means of Virtuozzo 
Power Panels (VZPP) or Virtuozzo Control Center (VZCC), the corresponding backup is 
automatically placed on the default Backup Node. 

There are no restrictions as to what Hardware Node may be the default Backup Node; it may 
even be the Source Node itself. In the latter case, the VPS backups will be placed on the same 
Node where the corresponding Virtual Private Servers are hosted. The only thing you have to 
ensure is that the default Backup Node has sufficient disk space for housing multiple backups. 
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Setting Default Backup Location 
VZMC allows you to change the backup folder on the Backup Node defined during the 
Virtuozzo installation and used to store all VPS backups. The VPS backups to be stored in this 
folder can be created in one of the following ways: 

 By means of VZMC and VZCC/VZPP if there is no default Backup Node or the given 
Hardware Node is to serve as one. In the latter case, this directory will be used to store the 
VPS backups from all Hardware Nodes registered in VZMC. 

 By using the vzexport Virtuozzo backup utility (see the Reference chapter for the 
description of this utility), or 

 By using the vzbackup Virtuozzo utility (see the Reference chapter for detailed 
information on this utility). 

To set another backup folder to be used as the default one for storing VPS backups, you should 
right-click the corresponding Hardware Node in the left pane of the VZMC main window and 
select Backup --> Set Default Backup Location on the context menu. The following window is 
displayed: 

 

Figure 12: VZMC - Setting Default Backup Location 

In this window, you should choose one of the following options: 

 Select the Backup to local Hardware Node radio button to specify a backup folder on one of 
the Backup Node local disk drives. To set a new backup folder, you should type its full path 
on the Node in the Path field or click on the ... button and select the desired folder in the 
displayed window. 

 Select the Backup to network share radio button to specify a backup folder on a network 
share, i.e. on a Backup Node network drive. To this effect, you should enter the full path to 
the folder on the network drive in the Path field. If the network drive where your backup 
folder is to be located is password-protected, you should specify the user name and 
password to access this share in the User and Password fields, respectively. 

After you have specified a new folder for storing VPS backups, click OK for the changes to take 
effect. 

Note: While defining the backup folder, make sure that the disk drive where this folder is to be 
located has sufficient disk space for housing multiple VPS backups. 
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Backing Up Single VPS 
To back up a Virtual Private Server from the Source Node to the Backup Node, do the 
following: 

1 Expand the Source Node item in the left pane of the VZMC main window and click the 
Virtual Private Servers item to open the Virtual Private Server manager window. 

2 Select the Virtual Private Server you wish to back up. You may use the CTRL and SHIFT 
keys for selecting a number of VPSs. 

3 Click the right mouse button and select Backup --> Back Up Virtual Private Server on the 
context menu. 
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The Back Up Virtual Private Server wizard opens: 

 

Figure 13: VZMC - Backing Up VPSs Wizard 

In this wizard you should: 

 Select the Backup Node. This Node is the place where the VPS backups will be stored. The 
only requirement for this Node is that it should be registered in VZMC; it may even be the 
Source Node itself. Often, it will be a dedicated Backup Node. 

 In the next window, specify the backup type. It may be full or incremental. Detailed 
information on backup types is provided in the Backing Up and Restoring Virtual Private 
Servers section (on page 45). If you are backing up a single VPS, and no backup of this VPS 
has been found on the Backup Node, this step is omitted, and a full backup is automatically 
created. 

 On the Review Virtual Private Server Backup Settings page: 
 Stop the VPS(s) for the time necessary for their backing up or leave them running. 

Selecting the Stop Virtual Private Server before backup option forces the VPS(s) to be 
stopped. In this case, if a client tries to access the VPSs during their downtime, a 
temporary "busy" page is shown. If this checkbox is cleared, the VPSs are backed up 
while they are running, which is better, on the one hand, but does not guarantee the 
VPSs consistency, on the other. 

 Do not stop the VPSs backup even if any errors appear (the Don't stop on errors 
checkbox is selected) or break the backup process should any malfunction occur (the 
checkbox is cleared). 
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Backing Up Group of VPSs 
To back up several or all VPSs from a single Source Node, right-click the Virtual Private Servers 
item under the corresponding Source Node and select Tasks --> Back up Virtual Private Servers 
on the pop-up menu. The Back Up Virtual Private Servers wizard is displayed. In this wizard you 
should: 

 Select the Virtual Private Servers from the Source Node you wish to back up. By default, all 
the VPSs are selected, but you may exclude certain VPSs from the backup. 

 On the next page of the wizard, select the Backup Node. This Node is the place where the 
VPS backups will be stored. The only requirement for this Node is that it should be 
registered in VZMC; otherwise it will not be displayed on this page. It may even be the 
Source Node itself. Often, it will be a dedicated Backup Node. 

 On the Review page: 
 Stop the VPS(s) for the time necessary for their backing up or leave them running. 

Selecting the Stop Virtual Private Server before backup option forces the VPS(s) to be 
stopped. In this case, if a client tries to access the VPSs during their downtime, a 
temporary "busy" page is shown. If this checkbox is cleared, the VPSs are backed up 
while they are running, which is better, on the one hand, but does not guarantee the 
VPSs consistency, on the other. 

 Do not stop the VPSs backup even if any errors appear (the Don't stop on errors 
checkbox is selected) or break the backup process should any malfunction occur (the 
checkbox is cleared). 

 Force a full backup for all the VPSs (the Force full backup checkbox on the Review page 
is selected), or allow an incremental backup for those VPSs whose full backups are 
already present on the Backup Node (the checkbox is cleared). 

Another way of backing up a number of VPSs from the given Source Node is the following: 

1 Expand the Source Node item in the left pane of the VZMC main window and click the 
Virtual Private Servers item to open the Virtual Private Servers manager window. 

2 Select the Virtual Private Servers you wish to back up. Use the CTRL and SHIFT keys for 
selecting a number of VPSs. 

3 Click the right mouse button and select Back up Virtual Private Servers on the context menu. 

The aforementioned Back Up Virtual Private Servers wizard is opened directly at the second 
page, because the first page (Choose Virtual Private Servers to Back Up) becomes unnecessary. 
 

Browsing Backup Contents 
VZMC allows you to browse the directory structure of any VPS backup as if this backup had 
already been restored and restore only the needed files and folders. To view the backed up files 
and folders of a VPS backup, you should do the following: 

1 Choose the VPS Backups item in the VZMC right pane, right-click the VPS backup whose 
contents you wish to browse, and select Properties on the context menu. 
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2 In the displayed window, select the corresponding backup in the Available backups table and 
click on the Show Backup Contents button: 

 

Figure 14: VZMC - Browsing Backup Contents 

3 Double-click the VPS disk drive to see its contents. The contents of any file/folder inside a 
backup is presented in the table providing the following information: 

Column Name Description 
Path The path to the file/folder inside the Virtual Private Server. 

Size The size of the file. 

Modified The date and time of the last modification of the file/folder. 

If you wish to restore any files and/or folders from the backup to the actual VPS, you should 
select them by ticking the corresponding checkboxes in front of these files/folders and click 
on the Restore Selected Items button. Detailed information on how to restore separate 
files/folders is provided in the Restoring VPS Files subsection (on page 55). 
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Restoring Single VPS 
To restore a Virtual Private Server from its backup, do the following: 

1 Expand the Source Node item in the left pane of the VZMC main window and click the 
Virtual Private Servers item to open the Virtual Private Servers manager window. 

2 Select the Virtual Private Server the backup of which you wish to restore from the Backup 
Node. 

3 Click the right mouse button and select Backup --> Restore Virtual Private Server on the 
context menu. 
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The Restore Virtual Private Server wizard opens: 

 

Figure 15: VZMC - Restoring VPSs Wizard 

In this wizard you should: 

 Select the Backup Node. This Node is the place where the VPS backup is stored. The Last 
Backup Date column in the list of Backup Nodes shows the date and time of the last backup 
(if any) of the selected VPS on the corresponding Node. 

 Select the backup from which the VPS is to be restored. Any VPS may have any number of 
its backups made at different dates and of different types. As a rule, you choose the most 
recent backup, unless you have reasons to restore an intermediary one. 

Note: During this operation, the Destination Node is supposed to be the same as the Source 
Node. For instructions on how to restore a VPS to a Destination Node other than the Source 
Node, see Managing Backup Node. 
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Restoring VPS Files 
Virtuozzo allows you to browse the directory structure of any VPS backup as if this backup had 
already been restored and restore only the needed files and folders. To this effect, you should do 
the following: 

1 Expand the Source Node item in the left pane of the VZMC main window and click the 
Virtual Private Servers item to open the Virtual Private Servers manager window. 

2 Right-click the Virtual Private Server the files/folders of which you wish to restore and 
select Backup --> Selectively Restore Virtual Private Server's Files on the context menu to 
open the Restore Virtual Private Server Files wizard. 
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On the first step of the wizard, you should: 

 Select the Backup Node. This Node is the place where the VPS backup is stored. The Last 
Backup Date column in the list of Backup Nodes shows the date and time of the last backup 
(if any) of the selected VPS on the corresponding Node. 

 Select the VPS backup from which the VPS files/folders are to be restored. 

The second step of the wizard allows you to review and explore the contents of all the backed 
up drives that were present inside your Virtual Private Server at the moment of the backup 
creation: 

 

Figure 16: VZMC - Choosing Files For Restoring 

All drives shown in the Choose Files to Restore window have a tree view of the files and folders 
that you have backed up. So, you can use this tree view in the same way as you use Windows 
Explorer to open and find folders and files on your computer. To enqueue this or that file/folder 
for being restored, you should select its checkbox. While selecting files and folders, please keep 
in mind the following: 

 You can select the checkbox in front of the corresponding drive to restore all the files 
and folders from the drive. 

 You can use the Select All/Deselect All buttons in the right corner of the Choose Files to 
Restore screen to select/deselect all the VPS files and folders at once, respectively. 
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The last screen enables you to review the parameters you have entered on the previous steps of 
the wizard. If you are satisfied with the parameters set, click Finish to start restoring the selected 
VPS files/folders to the Destination Node. Otherwise, click Back and change the corresponding 
parameters. 
 

Restoring Group of VPSs 
To restore several Virtual Private Servers of a single Source Node from their backups on the 
Backup Node, right-click the Virtual Private Servers item under the corresponding Source Node, 
and select Tasks --> Restore Virtual Private Servers on the context menu. The Restore Virtual 
Private Servers wizard is displayed. In this wizard you should: 

 Select the Backup Node. This Node is the place where the backups of the Source Node 
VPSs are stored. The Backup Availability column in the list of Backup Nodes shows whether 
backups have been found on the corresponding Node. 

 Select the Virtual Private Servers you wish to restore from the Backup Node. By default, all 
the backups of the VPSs originally belonging to the Source Node are selected, but you may 
exclude certain VPSs from this list, as well as include in it any other backups found on this 
Backup Node (i.e. the backups of those VPSs not belonging to the Source Node). To include 
these other backups, you should first make them visible by selecting the Show all available 
backups checkbox. 

Note: During this operation, all the VPSs will be restored to the Source Node, i.e. to the Node 
for which you have invoked the wizard, irrespective of whether the backed up Virtual Private 
Servers originally belonged to this Source Node or to any other Node. 
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Managing Backup Node 
Any Hardware Node may perform the functions of the Backup Node, i.e. store the backups of 
any VPSs of any Hardware Nodes. To see a list of VPS backups stored on a Hardware Node, 
expand its name in the left pane of the VZMC main window and select the VPS Backups item: 

 

Figure 17: VZMC - Listing Backups 

The table in the right pane presents the following information about the VPS backups stored on 
the current Backup Node: 

Column Name Description 
VPS ID The ID of the backed up Virtual Private Server. 

Source Node The Node where the VPS was hosted during its backing up. 

Last Backup Date The date and time when the last backing up of the VPS took place. 

Number of Backups The number of VPS backups on the Node. 

The backup manager window allows you to perform the following operations: 

 Restore a single VPS from its backup. You should right-click the needed VPS backup and 
select Restore Virtual Private Server on the context menu to start the Restore Virtual Private 
Server wizard. In this wizard, you should: 
 Select the Destination Node, i.e. the place whither the VPS will be restored. By default, 

the VPS Source Node is selected. Only the Nodes registered in VZMC are shown. 

 Select the backup from which the VPS is to be restored. Any VPS may have any number 
of its backups made at different dates and of different types. As a rule, you choose the 
most recent backup, unless you have reasons to restore an intermediary one. 
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 Restore one or several files and/or folders from a particular VPS backup. You should right-
click the VPS backup whose files/folders you wish to restore and select Selectively Restore 
Virtual Private Server's Files on the context menu to start the Restore Virtual Private Server 
Files wizard. In this wizard you should: 
 Select the Destination Node, i.e. the place whither the VPS files/folders will be restored. 

By default, the VPS Source Node is selected. Only the Nodes registered in VZMC are 
shown. 

 Select the VPS backup from which the VPS files/folders are to be restored. 

 Choose the files/folders to be restored by selecting their checkboxes. 

Right-clicking on a VPS backup in this table and selecting Properties on the context menu 
brings about the Virtual Private Server Backups dialog where you can view extensive information 
about the current VPS backup, including all its full and incremental backups, as well as delete 
any of these backups, show their contents (i.e. the VPS drives, files, and folders), or restore the 
VPS or any of its files/folders in the manner depicted above. 
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Searching for VPS Backups 
If you do not remember the place where you are storing the backup of a particular VPS 
(identified by its ID or its IP address or its hostname or by the date of its creation), you can 
search for the backup across all the Hardware Nodes (performing the function of Backup Nodes 
in this case) registered in VZMC. 

To search for a backup, do the following: 

1 Right-click the Virtual Private Servers item under the corresponding Source Node, and select 
Backup --> Search for Backups on the pop-up menu to open the Find Virtual Private Server 
Backups dialog: 

 

Figure 18: VZMC - Searching for Backups 

2 On the upper left drop-down menu, choose the VPS parameter by which you wish to search 
for the corresponding VPS backup. 

3 Enter the value of the parameter in the text field on the right. All the VPSs with the 
corresponding parameter including the specified value as its part will be found. E.g., if you 
enter "100" as the value for VPS ID, the backups of VPSs 100, 1000, 1001, 1002, 2100, 
3100, and so on, will be searched for. 

4 Check those Nodes where you want to search for the backups. 

5 Press the Search button. 

The Search results table presents the following information about the found backups: 

Column Name Description 
VPS ID The ID of the VPS whose backup has been found. 

Source Node The Node where the VPS was hosted during its backing up. 
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Creation date The date and time when the backup was created. 

Type The backup type. An incremental backup represents only those changes that the 
VPS has undergone since its last full or incremental backup. Therefore, an 
incremental backup is usually much less in size than a full backup. 

Backup Node The Backup Node - the Node where the backup has been found. 

Double-clicking on a VPS backup in this table brings about the Virtual Private Server Backups 
dialog where you can view extensive information about the current VPS backup, including all 
its full and incremental backups, as well as delete any of these backups or restore them in the 
manner depicted above. 
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Searching for VPS 
Usually there are a great number of Virtual Private Servers on your Hardware Node(s). To 
quickly find the necessary VPS, go to the Virtual Private Servers item, right-click it, and choose 
Task -> Search for Virtual Private Server. The Find Virtual Private Servers window opens: 

 

Figure 19: VZMC - Finding VPS 

This dialog window provides you with a list of VPSs across one or several Hardware Nodes 
united by a common parameter value. This can be the VPS ID, name, type, status, or IP address 
assigned to the VPS. 

You should indicate the parameter by which you wish to search for VPSs on the upper left drop-
down menu, and then the value of the parameter. If you choose to search for VPSs by their state 
(status) or ID you will be presented with a list of predefined values of these parameters. It is 
connected with the fact that there is a fixed number of VPS statuses, and VPS IDs can be only 
of the integer type. By searching for VPSs by their name or IP address, you can enter any string 
in the corresponding field. In this case the search results will display all the VPSs whose 
name/IP address contain the specified string, even if only as a part. 

You should also select the Hardware Node(s) where you wish to search for VPSs with the 
specified characteristics. VPSs from different Nodes matching the search criterion will be 
displayed in one and the same search result table. After you have selected the Hardware 
Node(s), click the Search button. The table will be populated at the bottom of the window. 
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The VPSs in the Search Results table corresponding to the specified search criterion may also 
be sorted by a number of parameters, among which are their ID, name, the Hardware Node they 
belong to, their IP address, etc. To sort the VPSs by a parameter, click the corresponding 
column name. Another click will reverse the sorting order. 

From the Search Results table, you may also open the VPS manager window by double-clicking 
the corresponding Virtual Private Server. 
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Changing VPS ID 
You can change the ID of a VPS with the help of the Move Virtual Private Server wizard. To 
invoke the wizard, select the Virtual Private Servers item under the corresponding Hardware 
Node, right-click the Virtual Private Server you wish to change the ID of, and select Tasks -> 
Move Virtual Private Server on the context menu: 

 

Figure 20: VZMC - Specifying IP Address 

In this window, you should specify a new ID for the corresponding VPS. Note that the old ID 
for this Virtual Private Server will be lost and all VPS private data will be transferred to the 
C:\vz\private\<new_VPS_ID> directory, where <new_VPS_ID> denotes the new ID 
assigned to the VPS. 

On the next screen, you should specify the path to the VPS private area. You can leave the path 
offered in the Old path field by default (C:\vz\Private\<VPS_ID>) or select the Override 
default path to ... checkbox and type the desired path in the Path to VPS private area field. 

Pressing Next will display the Review Virtual Private Server Movement Settings window. The 
window enables you to review the settings made by you on the previous step. Click the Finish 
button to begin the moving process. This process may take some time, so be sure to wait for it to 
complete. 
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In the command line, you can use the vzmlocal utility to change the ID of a Virtual Private 
Server. Detailed information on the vzmlocal utility can be found in the Reference chapter. 

Note: In the current version of Virtuozzo, you can change IDs of stopped Virtual Private 
Servers only. 
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Copying VPS Within Hardware Node 
You can create a complete copy of a particular VPS (in respect of all the VPS data and QoS 
parameters), or a VPS clone. This saves your time because you do not have to think of setting 
up the VPS configuration parameters and the like. Moreover, you can create a number of VPS 
clones at a sitting. 

In order to create a VPS clone, click Virtual Private Servers under the name of the corresponding 
Hardware Node, and as soon as a list of VPSs appears, right-click the Virtual Private Server you 
are going to clone. Select Tasks on the context menu and proceed with the Clone Virtual Private 
Server option. The Clone Virtual Private Server wizard will guide you thru the process of cloning 
the VPS. 

First, you will need to specify the number of VPS clones to create and the starting VPS ID. The 
Assign Virtual Private Server ID automatically checkbox lets Virtual Private Servers IDs be 
automatically taken from the ID pool on the Master Node and becomes available only in case 
the Hardware Node where the VPS resides belongs to a cluster (detailed information on clusters 
and ID pools is provided in the Managing Node Cluster section (on page 124)): 

 

Figure 21: VZMC - Cloning VPS 

The number of clones depends on the capacity of the Hardware Node. This taken into account, it 
is safe to create up to 100 VPS clones at one time. The default is 1. 



 

 Operations on Virtual Private Servers 67 
 

Similarly to creating new VPSs, the Clone Virtual Private Server wizard allows the simultaneous 
creation of several VPS clones with IDs in a continuous series only. The default starting VPS 
ID, which is automatically offered, is the first unoccupied ID starting from 101. For example, if 
you already have VPSs with IDs from 101 thru 105 and 107, the ID of 106 will be offered by 
default. And if you are creating only one VPS clone, you may safely accept this number. Or you 
can specify any other number, and the system will check up if the ID is unoccupied. However, if 
you are going to create a number of VPS clones, it is recommended to decide on an unoccupied 
ID series in advance. 

After you press the Next button, the Assign IP addresses to Virtual Private Servers window is 
displayed where you should assign IP address(es) for the cloned VPS(s). Set the radio button to 
one of the following options: 

 Assigning IP addresses starting from. You should specify an unoccupied IP address to 
assign to the cloned VPS and a subnet mask to define to what subnetwork the new VPS will 
belong. If you are cloning a number of Virtual Private Servers, the rest of the VPSs will get 
the nearest unoccupied IP addresses immediately following the specified one. All the cloned 
VPSs will have the same subnet mask and, therefore, belong to the same subnetwork. While 
defining a subnet mask for your VPS(s), we strongly recommend that you specify the same 
subnet mask as is set for the VPS you are making a clone of. Detailed information on VPS 
IP addresses and subnet masks is provided in the Network Virtualization subsection (on page 
19). 

 Set IP addresses manually. You should select the VPS clones one by one by clicking on 
them and press the corresponding Add IP address buttons. Type the IP address and subnet 
mask in the fields provided. You can define a separate subnet mask for every IP address to 
make the cloned VPSs belong to one or several subnetworks. We strongly recommend that 
you specify the same subnet mask as is set for the VPS you are making a clone of for all 
Virtual Private Servers to be cloned. Detailed information on VPS IP addresses and subnet 
masks is provided in the Network Virtualization subsection (on page 19). 

The last window lets you review the parameters you have entered on the previous steps. Click 
Finish to start the copying process. 

In the command line, the vzmlocal utility is used to copy a VPS within the given Hardware 
Node. Detailed information on the vzmlocal command line switches and options is provided 
in the Reference chapter. 

Note: You can clone both running and stopped Virtual Private Servers. 
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Migrating VPS 
Migrating VPSs is possible if Virtuozzo for Windows is installed on two or more Hardware 
Nodes, so you are able to move a Virtual Private Server to another Node. Migration may be 
necessary if a Hardware Node is undergoing a planned maintenance or in certain other cases. In 
the latter case, there will be a short downtime in the VPS operation. 

You can move both stopped and running Virtual Private Servers. Migrating a stopped VPS 
includes copying all VPS private files and registry from one Node to another and does not differ 
from copying a number of files from one computer to another over the network. In its turn, the 
migration procedure of a running VPS is a bit more complicated and may be described as 
follows: 

1 After initiating the migration process, a snapshot of all VPS private files and registry is 
made, i.e. all VPS private files and registry are remembered in the state they were at the 
beginning of the migration. 

2 The files and registry are copied to the Destination Node. During this time, the VPS on the 
Source Node continues running. 

3 The VPS on the Source Node is stopped. 

4 The VPS private files and registry copied to the Destination Node are compared with those 
on the Source Node and, if any files and registry keys were changed during the 2nd 
migration step, they are copied to the Destination Node again and rewrite the outdated 
versions. 

5 The VPS on the Destination Node is started. 
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There is a short downtime needed to stop the VPS on the Source Node, copy the VPS files and 
registry changes to the Destination Node, and start the VPS on the Destination Node. However, 
this time is very short and does not usually exceed one minute. 

To migrate one or more Virtual Private Servers to another Hardware Node with Virtuozzo for 
Windows using VZMC, select these Virtual Private Servers from the list in the right pane after 
selecting the Virtual Private Servers item in the left pane. Then right-click the selection and point 
to Tasks -> Migrate to Another Hardware Node on the context menu. Note that the target 
Hardware Node must be already registered in VZMC; otherwise, the migration option will not 
be available. A migration dialog appears, for example: 

 

Figure 22: VZMC - Migrating VPSs 

Review the three checkboxes at the bottom of the window and check up the needed ones. The 
Force migration checkbox, when selected, forces the VPS migration even if the templates 
necessary for the VPS correct operation are not installed on the Destination Node. However, it 
will be impossible to start such a VPS after the migration in case of the absence of the needed 
templates. Select the target Hardware Node where you want to migrate the selected Virtual 
Private Server(s) and press the Migrate button. 

You can also use the vzmigrate utililty to migrate a VPS by means of the command line. 
Detailed information on the vzmigrate utility can be found in the Reference chapter. 

Note: You cannot migrate Virtual Private Servers residing on a Hardware Node running the 
Virtuozzo 32-bit version to Hardware Nodes running the Virtuozzo 64-bit version and vice 
versa. 
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Deleting VPS 
VZMC allows you to delete Virtual Private Servers that are not needed anymore. The VPSs that 
can be deleted are marked with grey monitor icons (user VPSs). To delete one or more user 
Virtual Private Servers, select it (them) in the Virtual Private Servers table in the right pane of 
the VZMC main window. You can use CTRL+Click to select or deselect an entry, 
SHIFT+Click to select a range of Virtual Private Servers, CTRL+A to select all Virtual Private 
Servers. Then right-click the selected VPS(s) and choose Delete. You can also press the Delete 
button on the toolbar or select Delete on the Action menu: 

 

Figure 23: VZMC - Deleting VPS 

Deleting a considerable number of Virtual Private Servers may take a rather long run. The 
progress is displayed in the Actions pane.  

In the command line, you can delete a Virtual Private Server with the vzctl destroy 
command. Detailed information on this command is provided in the Reference chapter. 

Note: Destroying a VPS means that the private area of the VPS is deleted from the 
C:\vz\private directory on the Host OS and all the VPS private files are irrevocably erased 
from the Node without being moved to the Recycle Bin. 
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Changing Administrator Password 
While creating a new Virtual Private Server, you should have specified the Administrator 
password to log in to the VPS as the Administrator user thru VZPP, RDP, or MS TSC. 
This Administrator user differs from the Administrator user of the Hardware Node 
and has full control over the given VPS only. 

To change the specified Administrator password for a VPS, select the Virtual Private 
Servers item under the Hardware Node name, right-click the corresponding VPS in the table, 
and select Properties on the context menu. After the VPS Properties dialog is displayed, click the 
Advanced tab: 

 

Figure 24: VZMC - Setting Administrator Password 

Click the Set Password button. After this, type the Administrator password in the provided 
fields. 

Alternatively, you can open a separate console for the VPS (VPS Manager) and set the 
password for the Administrator user as is described in the Managing Users and Groups 
section (on page 73). 
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Operations Inside VPS 
VZMC allows you to manage VPS users and groups and perform different operations on the 
files/folders located inside your VPS by means of Virtual Private Server Manager. VPS 
Manager can be accessed by selecting the Virtual Private Servers item under the Hardware Node 
name and double-clicking on the corresponding VPS in the right part of VZMC. 

Note: You can also perform all operations described in this section by establishing an RDP/TSC 
connection to the VPS and working inside this VPS as on a stand-alone Windows 2003 server. 
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Managing Users and Groups 
Virtuozzo Management Console does not allow you to manage users or groups of the Host OS 
not to compromise the security of the Hardware Node. However, you can manage users and 
groups inside regular Virtual Private Servers with the help of Virtual Private Server Manager. 
All users and groups are adjustable. You can also add new users and groups. 

To manage groups or users inside a Virtual Private Server, open the main tree for this Virtual 
Private Server and select either the Groups or Users items in the Users and Groups folder, 
respectively. 

 

Figure 25: VZMC - Managing Users and Groups 

To open the group properties dialog, double-click on the group name in the table of groups or 
select Properties on the context menu. To add a new user to the group, click the Add button. To 
remove a user from the group, select the user name and press the Remove button. 

To add a new group, click the New Group button on the toolbar (note that this button appears 
only if you are currently working with VPS groups). Then enter the group name and press OK. 

To delete a group, select its name in the table of groups and press the Delete button on the 
toolbar or select the Delete item on the context menu. 

To add a new user, open the list of users and click the New user button at the top toolbar. Enter 
the user login (user name). This is the only mandatory parameter. You may also set the user 
description and password and add the user to one or more groups (see the Member Of tab). Then 
press OK. 

To edit an existing user, double-click on the user name in the table of users or use the Properties 
item on the context menu. The user properties dialog is analogous to the New User dialog. 
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To change the password for a user, right-click the user in the table of users, select Set Password 
on the context menu, then enter the password in the fields provided. 

To delete a user, select its name in the table of users and click the Delete button at the top 
toolbar or select the Delete option on the context menu. 

Note: In the current version of Virtuozzo, you cannot create Active Directory domain user 
accounts inside your VPS by means of VZMC. However, you can log in to the VPS which acts 
as a domain controller via RDP and create a domain user like you would do it on any other 
stand-alone Windows 2003 server. 
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Managing Files 
You cannot manage files/folders directly on the Hardware Node by means of VZMC, but you 
can do it inside each and every Virtual Private Server by means of the Virtual Private Server 
Manager window. To open the VPS manager window, select the Virtual Private Server item in 
the left pane of the VZMC main window and double-click the corresponding VPS. After you 
expand the File Manager item in the VPS main tree, you will see a list of disk drives available 
inside your VPS: 

 

Figure 26: VZMC - File Manager 

The principles of working with the VPS file manager are standard. You can move thru the 
hierarchy of VPS drives and folders by double-clicking their names or selecting the necessary 
drives and folders in the left pane. Use the menu items, toolbar buttons, table view, and context 
menus to perform the following tasks: 

 View the contents of simple text files; 
 View the principal information about a file/folder available inside the given VPS; 
 Upload any number of files or whole folders from your local computer (the computer where 

VZMC is installed) to any folder of the given VPS; 
 Download any number of files from the given VPS to your local computer; 
 Create new folders within the drives of the VPS; 
 Copy files to another drive/folder of the given VPS; 
 Move files to another drive/folder of the given VPS; 
 Delete VPS files/folders; 
 Rename VPS files/folders. 

VZMC provides a user-intuitive interface for performing all these tasks. 



 

 Operations on Virtual Private Servers 76 
 

While managing files and folders inside your Virtual Private Server, you may accidentally 
delete one or several system files necessary for the error-free functioning of the VPS or even get 
your VPS in a non-operational state. In this case Virtuozzo allows you to restore the VPS 
provided you have a backup of this VPS. Detailed information on how to back up and restore 
your Virtual Private Servers is provided in the Backing Up and Restoring VPSs section (on page 
45). 

Note: In the current version of Virtuozzo, you cannot compress files and folders as well as 
encrypt them inside your Virtual Private Servers. 
 



 

 Operations on Virtual Private Servers 77 
 

Uploading Files to Virtual Private Server 

The VPS Manager window allows you to upload any number of files or whole folders from the 
local computer (the computer where VZMC is installed) to any folder on any VPS disk drive. In 
the Virtual Private Server main tree, right-click the File Manager item and select Tasks -> Upload 
Local File. The Upload Files Wizard opens: 

 

Figure 27: VZMC - Uploading Files to VPS 

It is a three-step wizard. On the first step of the wizard, you should define Virtual Private 
Servers and the path where the files will be uploaded. Press the Add button to open the Select 
Virtual Private Servers Identifiers window where you should consecutively select a Hardware 
Node and/or a Virtual Private Server from this Node and add it to the VPS upload list. Repeat 
this sequence for every VPS where you wish to upload files and then click OK. After that, you 
should enter the path where your files are to be uploaded or browse for this path inside the 
remote VPS. Press Next when you are finished. 

In the second window of the Upload Files wizard, you should specify the local files or folders 
you wish to upload to the Virtual Private Server(s) that you specified on the previous step. Press 
the Add button and select a file or a group of files from a single directory for uploading. You 
can also upload the whole folder by pressing the Add Directory button. If you need to upload 
files from various local folders, press the Add button the required number of times. After you 
have added all the files and folders to be uploaded, click Next. 
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The next window lets you review all the information provided on the previous steps of the 
wizard. Make sure that the settings are correct. To change the settings, click the Back button and 
make the necessary corrections. After you click Next, the uploading process begins. The 
operation progress is graphically displayed in the window of the Upload Files wizard. You can 
see how each of the selected files is being consecutively uploaded to the selected Virtual Private 
Server(s). Please wait for the operation to finish. 

After the uploading process is finished, you will get informed of the results of the operation. 
The table in the displayed window lets you view the results regarding every file uploaded to the 
selected Virtual Private Server(s). Press Finish to exit the wizard. 
 

Copying and Moving Files 

Virtual Private Server Manager enables you to copy and move files/folders within the 
corresponding Virtual Private Server. 

To copy/move any file/folder, you should perform the following operations: 

1 Click on the File Manager item in the VPS main tree. 

2 Select the file you wish to copy/move (you can use CTRL+Click to select or deselect the 
file, SHIFT+Click to select a range of files, CTRL+A to select all files). 

3 Right-click it and choose either the Copy to Folder or Move to Folder item depending on the 
operation you wish to perform. 

After that, the Copy File/Move File window opens. This window lets you define the following 
options for the copy or move file operations presented in the table below: 

Option Description 
You are about to 
copy/move the following 
files 

This field is read-only. It just enumerates those files/folders that 
you have selected before opening the given window. These 
files/folders will be copied or moved to the destination folder you 
specify. 

Destination path You should either type the path to the folder where you want the 
specified files/folders to be copied or moved, or press the ... button 
and select the destination folder in the dialog window that appears. 

Overwrite existing files Check this box to overwrite the files/folders in the destination 
folder if they happen to have the same name as the files/folders 
being copied/moved. If you leave this box unchecked, the program 
will fail to copy/move the files/folders with an already existing 
name. 

After you have set the parameters, press OK to copy or move the file(s). Pressing the Cancel 
button will just close the window regardless of its contents. 
 

Downloading Files to Local Computer 

VZMC allows you to download any file or folder located on any Virtual Private Server disk 
drive to the computer where VZMC is installed. To this effect, do the following: 

1 Expand the File Manager item in the VPS main tree. 
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2 Select the file/folder you wish to download to your local computer (you can use 
CTRL+Click to select or deselect the file/folder, SHIFT+Click to select a range of 
files/folders, CTRL+A to select all files/folders); 

3 Right-click it and choose Tasks --> Copy To Local Computer on the context menu. 

4 In the displayed window, specify the folder where you wish to download the selected 
file/folder. 

5 Click OK. 
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A template is a set of original application files, repackaged for mounting over Virtuozzo File 
System. Virtuozzo templates allow you to share resources among lots of VPSs, thus enabling 
huge savings in terms of disk space and memory. 

Note: Detailed information on Virtuozzo templates is provided in the Understanding Templates 
subsection (on page 24). 

You may perform the following operations with templates: 

 Create your own application templates; 
 Upload new templates to the Hardware Node; 
 List the templates currently installed on the Hardware Node; 
 Install templates on and remove them from the Hardware Node; 
 Add templates to any number of VPSs; 
 Remove templates from the Hardware Node. 

All these operations are described below in this chapter. 

In This Chapter 
Creating Application Template ............................................................................................. 81 
Uploading and Installing New Virtuozzo Templates on Hardware Node............................. 89 
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Creating Application Template 
You may wish to use special software inside your Virtual Private Server(s) to perform a specific 
task or function, such as word-processing, creating spreadsheets, generating graphics, sending 
and receiving electronic mail, etc. However, installing an application inside every VPS where 
you wish to use it may be a time-consuming operation and require many megabytes of disk 
space inside each VPS. At the same time, adding an application to your VPSs by using the 
technology of Virtuozzo templates helps you avoid these problems: 

 Thanks to the fact that the real application files are written to the HN hard disk only once, 
gigabytes of disk space are saved that would be lost if the application were installed 
separately into each and every VPS. 

 The application is loaded only once into the Node memory, so memory savings are also 
tangible. 

Virtuozzo 3.5.1 provides you with a special wizard for creating Virtuozzo application templates. 
The Virtuozzo Template Creation Wizard will guide you through the process, gather all the 
necessary information, and make an application template for you. In order to invoke the wizard, 
select Programs --> SWsoft --> Virtuozzo --> Virtuozzo Template Creation Wizard on the Windows 
Start menu. 

After you have launched the wizard, you will be presented with the Welcome to Virtuozzo 
Template Creation Wizard window where you should select a variant of the template creation: 

 

Figure 28: VZMC - Choosing Creation Variant 

In this window, you can choose one of the following: 
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 Select the From manually selected data checkbox to manually specify the files and registry 
settings out of which you wish to create your application template. In this case you will be 
able to choose and edit any available files and registry keys for making the template. 

 Select the From application checkbox to create your application template on the basis of the 
corresponding application installed in a special temporary VPS. As distinct from the first 
variant, only the files and registry settings that will result from the application installation 
inside the temporary VPS will be included in the template. 

Both ways of the template creation are described below in this section in detail. 
 

Creating Template From Manually Added Data 
After you have selected the From manually selected data checkbox and clicked Next in the 
Welcome to Virtuozzo Template Creation Wizard window, you will be presented with the Specify 
VPS Settings window: 

 

Figure 29: VZMC - Specifying VPS ID and Template Name 

In this window, you should provide information in the following fields: 

 VPS id number: specify the ID of the Virtual Private Server where the application files and 
registry entries are stored, which will be used for the template creation. If they are stored on 
the Hardware Node itself, you should specify 0 as the value of this field. 

Note: Make sure the Virtual Private Server where the application files and registry entries 
are located is running; otherwise, you will be warned with a message informing you that the 
corresponding VPS is currently stopped. 
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 Template name: choose a name for the application template. You can type any alphanumeric 
identifier that you consider reasonable for the template and that will be used to refer to this 
application template. When you are ready, press the Next button. 

In the Configure Application template inside VPS window, you should specify what application 
files and registry entries are to be added to the application template: 

 

Figure 30: VZMC - Adding Files and Registry Entries 

In this window, you can do the following: 

 Press the Add files button to open the Template configuration window where you can choose 
the application files out of which the application template will be created. You may select 
any number of files with any extensions (.exe, .vbs, .txt, etc.). After you have chosen 
the needed files, click on the Save button in the Template configuration window to confirm 
your selection. 

 Press the Add reg_keys button to open the Template configuration window where you can 
select those registry entries that will be added to the application template. After you have 
chosen the needed entries, click on the Save button in the Template configuration window to 
confirm your selection. 

After you have selected the necessary files and registry entries and pressed the Next button, the 
Create Template window is shown: 
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Figure 31: Creating Application Template - Creating Template 

In this window, you can use the Edit registry and Edit files buttons to view and edit the registry 
entries and files that you have selected on the previous step of the wizard and that will be used 
for making the application template. After you have pressed the Next button, the application 
creation process is started. 

After a while, the The application template creation completed window is displayed notifying 
you that your application template has been successfully made. Click Finish to exit the wizard. 
The template is placed to the X:\vz\Templates\__cache directory on the Hardware 
Node where X denotes the disk drive set for storing Virtuozzo program files. However, before 
starting to use the newly created template, you should install it on the Node by means of the 
vzpkgdeploy utility. Please consult the vzpkgdeploy subsection of the Reference chapter (on 
page 251) to learn how to deploy and install your application templates on the Node. 
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Creating Template From Application Data 
If you have selected the From application checkbox and clicked Next in the Welcome to Virtuozzo 
Template Creation Wizard window, the following window is displayed: 

 

Figure 32: Creating Application Template - Defining VPS Settings 

In the Specify VPS Settings window, you are asked to set the parameters for a Virtual Private 
Server to be used for creating your application template. The fields you should fill in are 
explained below: 

 In the VPS ID field, specify the ID of the Virtual Private Server where the application 
template is to be created. The VPS with the ID specified is automatically created by the 
wizard for the period necessary for making the application template and deleted after the 
template has been successfully created and copied to the Hardware Node. Make sure that the 
VPS with the ID specified in the VPS ID field does not exist on your Node. Otherwise, you 
will be warned with a message asking you to choose another VPS ID. 

 In the VPS IP address field, enter the IP address (it should be unique within your network) to 
be assigned to the Virtual Private Server where the application template is to be created. 
You should specify a valid IP address to be able to connect to your VPS via RDP at a later 
time. 

 Indicate a DNS server that this Virtual Private Server is supposed to use in the DNS server 
field or select the Use DNS server of Hardware Node checkbox under the DNS server field to 
set the same DNS server as is used for the Hardware Node. 



 

 Managing Templates 86 
 

 In the VPS disk space limit field, type the amount of disk space the Virtual Private Server 
will be guaranteed to receive, in megabytes. Make sure that the size of the files you wish to 
use for creating the application template does not exceed the size of the specified disk space. 
Otherwise, a warning will be displayed notifying you that the allocated disk space is not 
enough for copying the application files. 

Pressing the Next button displays the window where you should specify the path to the 
application files and the name of the template: 

 

Figure 33: Creating Application Template - Specifying Template Parameters 

 In the Application files folder field, you should enter the path to the directory where the 
application files are stored that will be used for creating the application template. You can 
also use the Browse button to the right of the Application files folder field to point to the 
desired directory. The directory may contain any number of files with any extensions 
(.exe, .vbs, .txt, etc.). The files specified in this filed will be copied to and manually 
installed inside the created temporary VPS at a later time. 

 In the Template name field, you should choose a name for the application template. You can 
type any alphanumeric identifier that you consider reasonable for the template and that will 
be used to refer to this application template. 

 In the Template description field, you can additionally provide brief information on the 
application template. 

When you are ready with specifying the necessary template parameters, press the Next button to 
create the Virtual Private Server whose ID you have specified in the Specify VPS Settings 
window and where the application template is to be created. 
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After the VPS has been created and started, the Connect to VPS window is displayed. In this 
window, you are supposed to click Next to establish an RDP connection to the Virtual Private 
Server. This is needed to copy the source application files from the Hardware Node to the VPS 
where the application template will be created; later on, these source application files will be 
manually installed inside this VPS and the application template will be created on the basis of 
the installed files. After an RDP connection window is opened, minimize it and proceed with 
the wizard. 

Note: Please do not close the RDP connection window manually. 

On the Prepare to Install screen displayed after clicking Next in the previous window, just press 
the Next button to open the Create Template window. Now you should switch to the minimized 
RDP connection window and manually install your source application files that have been 
copied inside the Virtual Private Server. The source application files are located in the root 
directory of your hard drive (e.g. C:\My_application.exe). You can also customize the 
installed application to meet your demands; the files and registry settings of this installed and 
customized application will be used to create the template. Then switch back to the Create 
Template window and press Next. 

Note: After you click Next in the Create Template window, you will be notified that your RDP 
connection to the temporary VPS was closed. Just click OK in the displayed message window. 

The last screen of the wizard helps you make the final preparations for creating the application 
template: 

 

Figure 34: Creating Application Template - Creating Template 
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In this window, you can use the Edit registry and Edit files buttons to view and edit the registry 
entries and files of the installed application that the wizard will use for making the application 
template. After you have pressed the Next button, the application creation process is started. 

After a while, the Application Template Creation Completed window is displayed notifying you 
that your application template has been successfully made. Click Finish to exit the wizard. The 
template is placed to the X:\vz\Templates\__cache directory on the Hardware Node 
where X denotes the disk drive set for storing Virtuozzo program files. However, before starting 
to use the newly created template, you should install it on the Node by means of the 
vzpkgdeploy utility. Please consult the vzpkgdeploy subsection of the Reference chapter (on 
page 251) to learn how to deploy and install your application templates on the Node. 
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Uploading and Installing New 
Virtuozzo Templates on Hardware 
Node 

In case you have one or more new Virtuozzo templates that you would like to upload and install 
on your Hardware Node(s), you should first have these files accessible from the computer where 
VZMC is installed (e.g. insert the CD-ROM with the template(s) into the computer CD-ROM 
drive or copy the templates to the computer hard disk) and then launch the Upload and Install 
New Virtuozzo Templates wizard. 

Note: In Virtuozzo 3.5.1, you can upload and install only application templates. 

To invoke the wizard, right-click on the Templates item under any Hardware Node registered in 
VZMC and select the Upload and Install New Virtuozzo Template option. The Choose Virtuozzo 
Templates to Distribute window opens: 

 

Figure 35: VZMC - Choosing Templates for Uploading 

In this window, you will be asked to choose Virtuozzo template files you wish to deploy to your 
Hardware Node(s). To this effect, press the Add button and provide the path to the Virtuozzo 
templates you would like to install to a Hardware Node; then press Next. 
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The next screen will prompt you to define target Hardware Nodes where you wish to install new 
Virtuozzo templates. VZMC may upload and install the specified template(s) to any registered 
Hardware Node. By default, the current Hardware Node is selected. Select all the Nodes where 
you want the template(s) to be installed and press Next. In case of a large number of Nodes, it is 
reasonable to make use of the Select All or Deselect All buttons. 

The last page of the wizard allows you to review Virtuozzo templates deploying settings: 

 

Figure 36: VZMC - Reviewing Virtuozzo Templates Distribution Settings 

It summarizes the information provided by you on the previous steps, namely, what Virtuozzo 
templates to install and where to install them. If you are satisfied with the settings, press the 
Finish button. This will launch the upload and installation process. Otherwise, press Back to 
make the necessary changes to the information entered. 

You can also install application templates by using the vzpkgdeploy utility. Please consult 
the Reference chapter for complete information on the vzpkgdeploy utility and its options. 
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Listing Templates 
You may want to list the templates installed on the Hardware Node. They may be already used 
or not used by certain VPSs. To list templates in VZMC, it is sufficient to choose consecutively 
the Templates  Application Templates or OS Templates options under the name of the 
corresponding Node to see a list of the application or OS templates installed on the Node. For 
example: 

 

Figure 37: VZMC - Listing Templates 

To see the templates used by a particular VPS, double-click the needed Virtual Private Server in 
the VPS list in the right pane to open this VPS management window, and then again choose 
Templates  Application Templates or OS Templates in the left pane of the new window. 

In the command line, you can use either the vzpkgls or the vzlist utility to list the 
templates installed on the Hardware Node and applied to your Virtual Private Servers. Detailed 
information on these utilities can be found in the Reference chapter. 
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Adding Application Templates to 
VPSs 

After you have installed a number of application templates on the Hardware Node, you may add 
them to any number of Virtual Private Servers. To successfully add a template to a VPS, this 
VPS should be running. 

In VZMC, you can do it by performing the following operations: 

1 Expand the Templates --> Application Templates item under the name of the Hardware Node 
where the needed templates are installed: 

 

Figure 38: VZMC - Adding Templates to VPSs 

2 Select all the necessary templates holding down the CTRL or SHIFT keys where necessary; 

3 Right-click the selection and choose the Install Into Virtual Private Servers option; 

4 Follow the instructions of the wizard. 

If you are adding a template to only one VPS, you can as well do the following: 

1 Open the list of Virtual Private Servers in the VZMC main window by selecting the Virtual 
Private Servers item in the Hardware Node tree; 

2 Double-click the name of the VPS where you want to add a template; 
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3 Right-click on the Templates item in the main tree of the opened Virtual Private Server 
Manager, and select the Add Virtuozzo Application Template option on the context menu: 

 

Figure 39: VZMC - Installing Templates in VPS Manager 

4 Follow the instructions of the wizard. 

In the command line, the vzpkgadd utility is used to add application templates to existing 
VPSs. Detailed information on the vzpkgadd utility is provided in the Reference chapter. 

Notes: 1. You can as well do without templates and install virtually any application directly 
inside any VPS by using the Microsoft Terminal Services Client or Remote Desktop 
Connection, but this approach limits the scalability of the system. 

2. If you are running the 64-bit version of Virtuozzo, you should use only 64-bit application 
templates to add them to your Virtual Private Servers. 
 

Removing Virtuozzo Template From 
Hardware Node 

Virtuozzo 3.5.1 allows you to remove those OS and application templates that are not needed 
any more. To this effect, you should perform the following operations: 

1 Open the Templates folder under the corresponding Hardware Node name in the VZMC 
main tree. 

2 Click on either the Application Templates or OS Templates item to display a list of all 
application or OS templates installed on the Node, respectively. 



 

 Managing Templates 94 
 

3 Right-click on the template you wish to delete in the right pane and select the Delete option 
on the context menu: 

 

Figure 40: VZMC - Removing Template From Hardware Node 

If you have several versions of an application template, you can delete this or that version by 
doing the following: 

1 Open the Templates folder under the corresponding Hardware Node name in the VZMC 
main tree. 

2 Click on either the Application Templates or OS Templates item to display a list of all 
application or OS templates installed on the Node, respectively. 

3 Right-click on the needed template version in the right pane and select the Delete option on 
the context menu. 
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The main goal of resource control in Virtuozzo is to provide Service Level Management or 
Quality of Service (QoS) for Virtual Private Servers. Correctly configured resource control 
settings prevent serious impacts resulting from the resource over-usage (accidental or malicious) 
of any Virtual Private Server on the other Virtual Private Servers. Using resource control 
parameters for Quality of Service management also allows to enforce fairness of resource usage 
among Virtual Private Servers and better service quality for preferred VPSs, if necessary. 

In the current version of Virtuozzo, you can manage the following resources: 

 Disk space; 
 Processor time; 
 A set of memory-related parameters; 
 A set of network parameters. 

In This Chapter 
Managing VPS Disk Space Quota ........................................................................................ 95 
Managing VPS CPU Usage .................................................................................................. 98 
Managing VPS System Resources........................................................................................ 100 
Managing Network Resources .............................................................................................. 101 
Managing VPS Resources Configurations............................................................................ 105 

 
 

Managing VPS Disk Space Quota 
Virtuozzo allows you to control the amount of disk space a Virtual Private Server can use. The 
disk space quota imposed on the VPS is actually the size of its virtual hard disk, i.e. the size of 
the root.efd file in the  C:\vz\private\<VPS_ID> directory of the Host operating 
system. 

The following subsections explain how to define the disk space quota parameter for your Virtual 
Private Servers and to check its status. 
 

Setting Up Disk Space Quota 
In VZMC, you can set up the disk space quota parameter by performing the following 
operations: 

1 Click Virtual Private Servers in the VZMC left pane, then right-click the needed VPS in the 
right pane, and choose Properties. 

2 Click the QoS tab and expand Disk Quota parameters. 

C H A P T E R  5  

Managing Resources 
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3 Double-click the Disk space parameter to display the QoS counter properties window: 

 

Figure 41: VZMC - Setting Disk Space Quota 

In this window, you can change the value of disk space that can be used by the current 
Virtual Private Server. The value should be taken from the value range specified in the 
Allowed range field. Otherwise, the  symbol will be displayed opposite the Allowed range 
field. Mind that this value does not include the operating system files and the files of 
applications added to the VPS by means of application templates. As there are only stubs of 
these files inside the VPS, they do not occupy any space. So, there is no need to assign too 
much disk space (no more than 100-200 Mb) to individual VPSs. 

4 Press OK. 

It is possible to change the disk space quota parameter for a running Virtual Private Server. In 
this case the changes will take effect immediately. 

You can also use the vzctl set command with the diskspace option or the vzquota 
utility to set up a new disk space quota for a VPS. Detailed information on the vzctl and 
vzquota utilities is provided in the Reference chapter. 
 

Checking Disk Quota Status 
As the Hardware Node system administrator, you can check the quota status for any Virtual 
Private Server. 

To check the quota status for a VPS in VZMC, you should: 

1 Open the needed Virtual Private Server manager window by double-clicking on the 
corresponding Virtual Private Server line in the right pane of the VZMC window; 

2 Expand the Monitor item and select the Quotas and Usage folder. 
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You can see the disk space statistics for the current VPS in the right pane of the window: 

 

Figure 42: VZMC - Viewing VPS Disk Space Statistics 
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Managing VPS CPU Usage 
The current section explains the CPU resource parameter that you can configure and monitor for 
each Virtual Private Server. 

The CPU resource parameter in Virtuozzo-based systems is controlled by the Virtuozzo 
hierarchical scheduler and measured in CPU units. CPU units represent a positive integer 
number that defines how much CPU time one Virtual Private Server will receive in comparison 
with the other VPSs on the Hardware Node in case all the CPUs of the Node are fully used. For 
example, if VPSs 101 and 103 are set to receive 1000 CPU units each and VPS 102 - 2000 CPU 
units, VPS 102 will get twice as much CPU time as VPSs 101 or 103 in case all the CPUs of the 
Node are completely loaded. 

Note: Processes belonging to any Virtual Private Server are scheduled for execution on all the 
CPUs of the Hardware Node. Consequently, VPSs are not bound to only one CPU, and any 
application inside each VPS can use all the free CPU power of the Node. 

By default, the Hardware Node (VPS 0) receives 5000 CPU units and each VPS on the Node 
gets 1000 CPU units. In the current version of Virtuozzo, you cannot modify what default CPU 
value is to be used for the Hardware Node and any of its VPSs. However, you can change the 
current value of the CPU resource parameter for a particular Virtual Private Server (but not for 
the Node itself) by means of VZMC. To this effect, you should perform the following 
operations: 

1 Click Virtual Private Servers in the VZMC left pane, then right-click the needed VPS in the 
right pane, and choose Properties. 
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2 Click the QoS tab and expand CPU parameters: 

 

Figure 43: VZMC - Managing CPU Usage 

3 Double-click the CPU Units parameter and enter the right value for the given VPS in the 
Value field of the QoS counter Properties window. You can specify any value in the range 
from 50 to 50000 CPU units. In case the value defined for the CPU resource parameter is set 
out of the allowed range, you will see the  symbol opposite the Allowed range field. It 
means that the entered value will be of no effect and rounded up or down by Virtuozzo to 
the minimal or maximal allowed value, respectively. For example, if you specify 30 CPU 
units in the Value field units, the entered value will be rounded up to 50 CPU units. 

Note: Specifying 0 as the value of the CPU parameter will reset the current CPU value for 
the given VPS to the default one (i.e. to 1000 CPU units). 

4 Press OK. 

It is possible to change the CPU resource parameter for both stopped and running Virtual 
Private Servers. In the latter case, the changes will take effect immediately. 

You can also use the vzctl set command with the --cpuunits option to set up the CPU 
Units parameter. Please consult the Reference chapter for complete information on this 
command. 
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Managing VPS System Resources 
The resources a Virtual Private Server may allocate are defined by the system resource control 
parameters. The table below provides the description of these parameters: 

Parameter Description Typical value 
number of 
processes 

The maximal number of processes the VPS may 
simultaneously create. It is important to properly estimate 
the maximal number of processes when configuring the 
resource control system. 

 

  30 - 80 

number of TS 
sessions 

The number of terminal sessions. This parameter is usually 
used to limit the number of simultaneous terminal 
sessions. An incorrect configuration of this parameter can 
affect the application functioning in the given Virtual 
Private Server. 

 

  2 - 4 

VPS memory The size of private (or potentially private) memory 
allocated by the VPS, in Mb. The memory that is always 
shared among different applications is not included in this 
resource parameter. 

 

  100 - 500 

To view and/or change any of these parameters for a particular Virtual Private Server in VZMC, 
do the following: 

1 Click Virtual Private Servers in the VZMC left pane, right-click the needed VPS in the right 
pane, and choose Properties. 
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2 Click the QoS tab and expand the Primary UBC parameters group: 

 

Figure 44: VZMC - Managing System Parameters 

3 Double-click the necessary parameter, and, if necessary, enter the right value for the given 
VPS in the Value field of the QoS counter Properties window. 

4 Press OK. 

To manage system parameters by means of the command line, the vzctl set command is 
used. Detailed information on this command can be found in the Reference chapter. 
 

Managing Network Resources 
The given section provides information on how you can enable the Quality of Service scheduler 
and browsing for your Virtual Private Servers. 
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Enabling QoS Scheduler for VPS 
Quality of Service (QoS) in MS Windows 2003 Server is a collection of components that enable 
differentiation and preferential treatment for subsets of data transmitted over the network. QoS 
provides different applications with a means which can be used to define the quality of network 
resources (e.g. bandwidth) to be allocated for this or that application. For example, you can use 
Quality of Service to differentiate between data transmitted by critical applications (e.g. Plesk) 
and excessive data (e.g. multimedia applications) and allow preferential treatment for the critical 
applications. 

Note: The concept of Quality of Service in MS Windows 2003 ensuring quality data 
transmission for QoS-enabled applications on a network differs from that of Virtuozzo Quality 
of Service, which is used to provide a fair share of the main system resources (disk space, CPU 
time, etc.) among Virtual Private Servers. 

Windows 2003 QoS is comprised of a number of components. One of the main components 
playing a central role in the provisioning of quality of service is the Quality of Service packet 
scheduler. The QoS packet scheduler is the traffic control module that can be used to regulate 
how much traffic an application inside your VPS is allowed, thus enforcing the QoS parameters 
originally set for a particular application. 

By default, the QoS scheduler is disabled for all Virtual Private Servers residing on the 
Hardware Node. To enable it for a particular VPS, you should perform the following operations: 

1 In VZMC, select the Virtual Private Servers item under the Hardware Node name. 

2 Right-click the corresponding Virtual Private Server in the right part of VZMC and choose 
Properties on the context menu. 
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3 In the displayed window, go to the Advanced tab and select the Enable QoS packet scheduler 
checkbox: 

 

Figure 45: Enabling QoS Scheduler for VPS 

4 Click OK. 

Note: In case you have enabled the QoS packet scheduler for a running Virtual Private Server, 
you should restart this VPS for the changes to take effect. 

After you have enabled the QoS packet scheduler, you can manage your VPS as a normal stand-
alone Windows 2003 server in respect of setting and working with all Windows 2003 Quality of 
Service components. From this moment on, it depends entirely upon the VPS administrator to 
define which applications will be QoS-enabled and use all the benefits of Microsoft Windows 
Quality of Service. 

Note: Additional information on the QoS packet scheduler is provided in the Managing 
Bandwidth section of the Windows 2003 Help system that can be invoked by selecting Help and 
Support on the Windows Start menu. 

You can also use the vzctl set command with the --psched on option to enable the 
Quality of Service packet scheduler for a Virtual Private Server. Detailed information on the --
psched option is provided in the Reference chapter. 
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Enabling Network Browsing for VPS 
The network browsing allows you to view and access all the network servers and file sharing 
resources available on your Windows 2003 network. However, to start using the network 
browsing feature inside a Virtual Private Server, which is disabled by default, you should first 
enable it for this VPS. To enable the network browsing for a particular VPS, you should 
perform the following operations: 

1 In VZMC, select the Virtual Private Servers item under the Hardware Node name. 

2 Right-click the corresponding Virtual Private Server in the right part of VZMC and choose 
Properties on the context menu. 

3 In the displayed window, go to the Advanced tab and select the Enable broadcasts checkbox: 

 

Figure 46: VZMC - Enabling Network Browsing 

4 Click OK. 

Now you can go to My Network Places --> Entire Network --> Microsoft Windows Network inside 
your Virtual Private Server, view what network resources are available for the VPS, and use 
these resources in accordance with the rights assigned to the VPS on the network. 

Note: You can open My Network Places by clicking Start --> Programs --> Accessories --> 
Windows Explorer and selecting the My Network Places item in the left part of the displayed 
window. 
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Managing VPS Resources 
Configurations 

Virtuozzo allows you to create new VPSs on the basis of the configuration sample files shipped 
with Virtuozzo 3.5.1. Currently, five configuration sample files are provided: 

 basic – to be used for creating standard VPSs; 

 MSDE – to be used for creating VPSs that are to run Microsoft SQL Server Desktop 
Engines; 

 Oracle – to be used for creating VPSs that are to run Oracle database servers; 

 Plesk – to be used for creating VPSs that are to run SWsoft Plesk 7.0 and above for 
Windows; 

 SharePoint – to be used for creating VPSs that are to run SharePoint Portal Server 
2003. 

If the provided configurations do not satisfy your demands, you can create your own VPS 
configuration files by using VZMC. After that, you can copy them to any number of Hardware 
Nodes, if necessary. Below in this section, the process of VPS configuration file creating and 
copying is described. 
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Creating VPS Configuration Sample File 
If you are not satisfied with the VPS configuration sample files shipped with Virtuozzo 3.5.1, 
you can create your own ones. VZMC provides a special wizard for creating VPS configuration 
sample files. The Create Sample Configuration wizard will guide you through the process and 
gather all the necessary information. In order to invoke the wizard, click the name of the 
Hardware Node where you wish to create the sample file and, in the right pane, click the Create 
Sample Virtual Private Server Configuration link under the Wizards item. 

The Create Sample Configuration wizard opens: 

 

Figure 47: VZMC - Entering Sample Configuration Name and Description 

In this window, you should choose a name for the sample file. You can type any alphanumeric 
identifier you consider reasonable for this file and that will be used to refer to the VPS sample 
configuration. Besides, you can enter any relevant comment on the file; it will be displayed 
within the list of VPS sample configurations. Click Next. 

After that, you will be asked to choose a variant of the VPS configuration sample file creation: 
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Figure 48: VZMC - Choosing VPS Configuration Sample 

You can choose between two options: 

 You can set the VPS sample configuration manually. Select this checkbox if there are no 
sample VPS configurations that can be used as the basis for the new one. In this case, you 
should define all QoS parameters one by one.  

 You can use one of VPS configuration samples that are shipped with Virtuozzo 3.5.1 or 
have been already created by you. You may make use of this option if your new 
configuration sample differs from the existing one only slightly and can be created by 
adjusting some of its parameters. The information on the sample files shipped with 
Virtuozzo is provided in the Managing VPS Resources Configuration section (on page 105). 
All the available configuration samples are listed in the table below the Use one of Virtual 
Private Server configuration samples option. Just click on the needed sample and proceed 
with adjusting it. 

Next, you will be asked to define the QoS parameters: 
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Figure 49: VZMC - Defining QoS parameters 

In this window, you can adjust the following QoS parameters: 

 CPU usage (see page 98); 
 disk space quota (see page 95), and 
 a number of system resource control parameters (see page 100). 

To this effect, expand the corresponding group and double-click the parameter you wish to 
adjust. After you have set the necessary parameters, click Next. 

On the next step, you are to define the OS template that will be used as the basis for creating 
Virtual Private Servers. OS templates are used to create new Virtual Private Servers. In 
Virtuozzo 3.5.1, you can use only the Windows Server 2003 OS template to create a VPS. If 
you do not want the VPS sample to predefine any specific OS template, select none in the 
Name column. Click Next to proceed after the selection. 

On the next step, you can choose application templates to add to Virtual Private Servers which 
will be created from this sample configuration. All application templates available on your 
Hardware Node are listed in the table of the Select Application Templates window. Typical 
examples of application templates are msde, openssh, etc. After selecting the necessary 
application templates, click Next. 

Note: This window will be displayed only if you have chosen the OS template on the previous 
page of the wizard the VPS template will be based on. 
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Finally, you will be offered to configure the automatic boot mode. Select the Yes checkbox if 
you want the VPSs based on the configuration sample being created to start automatically on the 
Hardware Node boot. To start the VPSs manually, select No. 

The last screen summarizes all the data you have provided on the previous steps. If you are 
satisfied with the entered information, click Finish to start creating the VPS sample 
configuration file. Otherwise, you can return to the previous steps by clicking the Back button 
and change the corresponding parameters. 

Now, you can use the new VPS sample configuration file to create VPSs on its basis. It will be 
displayed on the first screen of the Create Virtual Private Servers wizard together with the 
configuration files shipped with Virtuozzo 3.5.1. 
 

Copying VPS Configuration Sample File 
VZMC provides you with the opportunity to quickly disseminate one or more sample VPS files 
over several Hardware Nodes, or simply copy it/them to another Node. This is particularly 
useful when you have created a custom configuration file on one of the Nodes and wish to use it 
on the other Nodes as well. 

To copy a sample VPS file, you should perform the following operations: 

1 Select the VPS Sample Configuration item in the Hardware Node main tree. 

2 Right-click the sample configuration file and choose Tasks -> Copy to Another Hardware 
Node: 

 

Figure 50: VZMC - Copying VPS Configuration Sample File 

3 In the displayed window: 
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 Select the Hardware Node(s) where you want to copy the files (you might use the Select 
All and Deselect All buttons to this effect). 

 Select the action that will be performed in case a configuration sample file with the same 
name already exists on the destination Node. 

4 Press the Copy button. In the Copying Status column, you may view the result of the 
operation. 

5 If the copy operation has completed successfully, press Close to close the window. If not, 
press the Details button to learn more about the error that occurred during the operation 
process. This is the only case when this button becomes active. 

The VPS sample configuration files are stored in the X:\Program 
Files\SWSoft\Virtuozzo\Configs folder on each Hardware Node. 

If you take default Virtuozzo sample configuration files, modify them, and copy to another 
Node preserving the default names, chances are that files with the same names already exist on 
the destination Node. To resolve this conflict, you are supposed to choose at the bottom of the 
window one of the three corresponding options, which best fits your needs. 
 

Saving and Uploading Configuration Sample to/from Local Computer 
VZMC allows you to upload a new sample file to your Node from and save any of the existing 
configuration sample files to your local computer. 

In case you have one or more new configuration sample files that you would like to upload to 
your Hardware Node(s), you should first have these files accessible from the computer where 
VZMC is installed (e.g. insert the CD-ROM with the VPS sample file(s) into the computer CD-
ROM drive or copy the sample file(s) to the computer hard disk). After that, you should do the 
following to upload your new sample file(s) to the Node: 

1 Right-click the VPS Sample Configurations item under the Hardware Node name in the 
VZMC left pane and select Tasks --> Upload VPS Sample from Local Computer on the context 
menu. 

2 In the displayed window, provide the right path to the configuration file you wish to upload 
and click Open. 
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3 You will be presented with the following window: 

 

Figure 51: VZMC - Uploading Sample File 

In this window, you can perform the following operations: 

 Change the original name of the configuration sample file by typing a new one in the 
VPS sample configuration name field. This name will be used to refer to this sample file 
in the VPS configuration sample files listing. 

 Provide the description of the sample file in the Description field. This description will 
be displayed to the right of the sample file in the VPS configuration sample files listing. 

 Press the Upload button in the right part of the window to upload the sample file to the 
Node. 

After the configuration sample file has been successfully uploaded, you can find it in the 
X:\Program Files\SWSoft\Virtuozzo\Configs folder on your Hardware Node. 

You can also save any of the configuration sample files available on your Node to a computer 
where VZMC is installed. To this effect, you should perform the following operations: 

1 In the VZMC left pane, select the VPS Sample Configurations item under the corresponding 
Hardware Node name in the VZMC left pane; 

2 In the VZMC right pane, right-click the configuration sample file you wish to download and 
select Tasks --> Save to Local Computer on the context menu; 

3 In the displayed window, provide the path to the location on the computer hard disk where 
you wish to save the sample file; 

4 Click Save. 
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The current chapter centers on all those operations you can perform on your Hardware Nodes. 
You will learn how to manage your Virtuozzo licenses, to update Virtuozzo software and the 
Windows Server 2003 operating system on your Node, to unite your Nodes into a cluster, to 
view and configure a number of Virtuozzo-related parameters. 

In This Chapter 
Managing Virtuozzo Licenses............................................................................................... 112 
Updating Hardware Node Software ...................................................................................... 118 
Managing Node Cluster ........................................................................................................ 124 
 
 

Managing Virtuozzo Licenses 
The given chapter provides information on managing Virtuozzo licenses. In particular, you will 
know how to view the current license status, to generate a new license request in case your 
license has expired, and to load a new license to your Hardware Node. 
 

C H A P T E R  6  

Managing Hardware Nodes 
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Generating License Request 
The Virtuozzo license can be obtained from SWsoft by sending a license request to your SWsoft 
sales contact (e.g. sales@swsoft.com). A license request is a file generated with the help of the 
License Request Generation wizard. To launch the wizard, select the corresponding Hardware 
Node name and follow the Request New Virtuozzo License link under the Wizards group on the 
HN dashboard. The wizard will prompt you for all the necessary information. On the first step, 
you should provide your personal information: 

 

Figure 52: VZMC - Entering Personal Information 

In this window, you should enter your company name in the Owner field as all Virtuozzo 
licenses have an “owner” field in them. This field is purely informational and can help track the 
license history if needed. Besides, you should provide your user name and valid e-mail address 
in the User name and E-mail field, respectively. 

The next screen asks you for the number of Virtual Private Servers you are planning to have: 
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Figure 53: VZMC - Specifying Number of VPSs 

Please note that you should specify a non-zero number; otherwise, the error message will be 
displayed asking you to enter the number again. 

Note: The number of Virtual Private Servers entered relates to regular user VPSs only; the 
Service VPS is not included in this number. 

The next screen will prompt you for the license expiration date. You can choose between two 
possibilities: 

 Unlimited. Never expires. Select this radio button if you need a permanent license. 
 Time-limited evaluation license. It may be suitable for you if you are going to evaluate 

Virtuozzo over a period of time. In this case you should enter the date when the license 
expires in the Expires on field under the radio button. 

Then you will be asked to enter the number of processors you are planning to use on your 
Hardware Node: 
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Figure 54: VZMC - Entering Number of CPUs 

By default, VZMC displays the number of CPUs currently available on the Node. However, if 
you are going to install additional processors, then please enter the total CPU number after the 
upgrades in the Number of CPU(s) field. 

The next screen will prompt you for the location where the license request file will be stored. It 
can be any directory on your Hardware Node. You can keep the directory offered by default or 
select the desired one by clicking the ... button to the right of the License file path field. 

Finally, you will be presented with the screen summarizing all the parameters you have 
provided on the previous steps. If you are satisfied with the entered information, click Finish to 
complete the license generation process. Otherwise, you can return to the previous steps by 
clicking the Back button and change the corresponding parameters. 

After the wizard exits, you can find the license request as the vzLicReq.txt file in the 
directory you have specified in the wizard. You should send this file to sales@swsoft.com (or 
your personal SWsoft contact). 

You can also generate a Virtuozzo license request and send it to SWsoft by using Virtuozzo 
Control Center (VZCC). Detailed information on managing Virtuozzo licenses in VZCC is 
provided in the Managing Virtuozzo Licenses section of the Managing Hardware Node chapter in 
the Virtuozzo Control Center Guide. 
 

Uploading License to Hardware Node 
After SWsoft provides you with the corresponding license file named vzlicense, you can 
upload and install it on the Hardware Node in one of the following ways: 

1 By using Virtuozzo Management Console (VZMC): 
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 Copy the license file to the computer where VZMC is installed. 

 In VZMC, click on the corresponding Hardware Node name and follow the Manage 
Virtuozzo License link at the HN dashboard. 

 On the License tab of the Hardware Node Properties window, click on the Upload New 
License button. 

 Specify the location of the vzlicense file and press the Open button to upload the 
new license to the Hardware Node. 

2 By using Virtuozzo Control Center (VZCC): 

 In VZCC, follow the Hardware Node link on the VZCC main menu and click the License 
Management link to display the License Management page. 

 On the License Management page, click the Install New License link to open the Install 
New License page. 

 Open the license file by using any text editor and copy its content to the clipboard. 

 Place the cursor to the License field of the Install page and paste the copied license text. 

 Press the Submit button. 

You can also use the vzlicload utility to load your Virtuozzo license to the Hardware Node. 
Detailed information on this utility is provided in the Reference chapter. 
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Viewing Current License 
In order to check the current status of the license installed on a Hardware Node, click on the 
corresponding Hardware Node name and follow the Manage Virtuozzo License link at the HN 
dashboard: 

 

Figure 55: VZMC - Viewing Current Virtuozzo License 

On the License tab of the Hardware Node Properties window, you can view the full information 
about the Hardware Node license. Pay attention to the license status that can be one of the 
following: 

ACTIVE The license file is valid and has been successfully loaded into the Virtuozzo 
management service. 

VALID The license file contains a valid license for this Hardware Node; however, no license is 
loaded into the Virtuozzo management service. 

INVALID The license file is invalid (for example, because of the Hardware Node ID mismatch) 
or corrupted. 

EXPIRED The license file matches the Hardware Node ID but has expired and, therefore, could 
not be loaded into the Virtuozzo management service. 

GRACED The license file has been successfully loaded into the Virtuozzo management service; 
however, it has expired and is currently on the grace period (i.e. it is active till the end 
of the grace period) 

UNKNOWN No Virtuozzo support has been detected on the Hardware Node. 
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You can also use the vzlicview utility to find out the status of your Virtuozzo system in 
respect of the license loaded. Detailed information on this utility is provided in the Reference 
chapter. 
 

Virtuozzo License Expiration 
As soon as the license period expires, the Hardware Node will continue working for a grace 
period, and then finally Virtuozzo will stop functioning. The grace period is measured in 
seconds, you can see its value in the license properties. During this period, you can generate a 
license request, send it to SWsoft, receive a new license, and upload it to your Node. 

If the license expires in less than a week, you will be warned with the Virtuozzo License Expires 
Soon window every time you launch VZMC. Pressing Details in this window will take you to 
the Hardware Node Properties screen where you will be able to view the details of the currently 
loaded license as well as to request a new license from SWsoft and to upload it by clicking the 
corresponding buttons. Detailed information on how to generate license requests is provided in 
the Generating License Request section (on page 113). 
 

Updating Hardware Node Software 
This section provides information on how you can update the Virtuozzo software and Windows 
Server 2003 installed on your Hardware Node. 
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Updating Virtuozzo Software 
Virtuozzo for Windows is constantly developing: there appear new versions of the Virtuozzo 
core and of existing Virtuozzo utilities, new functionality is implemented, new templates and 
utilities are added from time to time. As these changes grow in number, new Virtuozzo updates 
are released. 

Virtuozzo is provided with a special module - Virtuozzo Update Service (VUS) - helping you 
deploy Virtuozzo updates to your Hardware Node. By default, the Virtuozzo installation 
configures VUS in such a way as for the latter to be able to automatically check the Virtuozzo 
updating center (accessible at http://vzwinupdate.swsoft.com) for the latest Virtuozzo updates 
and to download them to your Node. After new updates have been successfully downloaded to 
the Hardware Node, the green ( ) icon is shown in the system tray of your display. To install 
the downloaded updates, double-click the icon to launch the Virtuozzo for Windows Update 
Wizard. You will be presented with the Welcome to the Virtuozzo Update Wizard screen. 

 

Figure 56: Running Virtuozzo Update Wizard 

In this window, you can do the following: 

 If your Hardware Node does not use a proxy server, i.e. it is directly connected to the 
Internet, just click Next on to start updating your Virtuozzo software. 

 Otherwise, click on the Proxy Settings button on the Welcome to the Virtuozzo Update Wizard 
screen to display the Enter Proxy Settings window: 
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Figure 57: Installing Virtuozzo - Specifying Proxy Parameters 

This window allows you to do one of the following: 

 Select the Do not use proxy server radio button if your Hardware Node does not use a 
proxy server, i.e. it is directly connected to the Internet. This option is selected by 
default. 

 Select the Load Internet Explorer proxy settings radio button to use your Internet 
Explorer proxy settings to connect to the Virtuozzo updating center. 

 Select the Specify a proxy server radio button to use a proxy server differing from the 
one specified in your Internet Explorer proxy settings to connect to the Virtuozzo 
updating center. In this case you should specify the IP address and the port of the proxy 
server you are going to use to connect to the Internet in the Address and Port fields, 
respectively. 

 If your proxy server is password-protected (i.e. you use a special user name and 
password to log in to the proxy server), you should also select the Proxy server requires 
authentication checkbox and specify the corresponding credentials in the Proxy user 
name and Proxy password fields. 
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After you click Next in the Welcome to the Virtuozzo Updates Wizard window, you will be 
presented with a list of Virtuozzo updates currently available for your Hardware Node: 

 

Figure 58: List of Virtuozzo Updates 

Select the corresponding updates and click Next to install them on the Hardware Node. 

You may want to modify the default Virtuozzo update settings to meet your requirements. To 
this effect, right-click the  icon and choose Settings on the context menu. The Virtuozzo 
Update Settings window is displayed: 
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Figure 59: Defining Virtuozzo Update Settings 

In this window, you can modify the Virtuozzo update settings in the following way: 

 If the Keep my Virtuozzo installation up to date ... checkbox is selected, the following options 
are available: 
 Automatically download and install updates. Select this radio button if you wish 

Virtuozzo updates to be automatically downloaded and installed on your Hardware 
Node on the schedule you specify in the fields provided under the Check settings group. 

 Automatically download updates and notify user before installation. Select this radio 
button if you wish Virtuozzo Update Service to automatically download the updates in 
the background of your system on the schedule you specify in the fields provided under 
the Check settings group. By default, this radio button is selected. We recommend that 
you leave this option checked, which will always keep you informed of new Virtuozzo 
updates. 

While using this option, please keep in mind the following: 

a If there are no updates for your Virtuozzo installation, the grey ( ) icon is shown in the 
system tray of your display. 

b After the download of new updates is complete, the icon changes its color from grey to 
green, and when you place the mouse on the icon, the following message is displayed: 
New Virtuozzo updates are available. When you double-click the icon, 
the Virtuozzo for Windows Updates Wizard is invoked that helps you install the 
downloaded updates in a few simple steps described above. 

 Notify user before installing or downloading updates. Select this radio button if you wish 
VUS to check the Virtuozzo updating center for available updates on the schedule you 
specify in the fields provided under the Check settings group and to inform you in case 
it finds any updates for your Node. After you choose this option, the grey ( ) icon will 
be displayed in the system tray notifying you each time new Virtuozzo updates are ready 
to be downloaded from the Virtuozzo updating center. In this case the icon changes its 
color from grey to green, and when you place the mouse on the icon, the following 
message is displayed: New Virtuozzo updates are available. After you 
double-click the icon, the Virtuozzo for Windows Updates Setup Wizard is invoked that 
helps you download and install the corresponding Virtuozzo updates in a few simple 
steps described above. 

Note: If you do not want the  icon to be displayed in the system tray, right-click it and 
select Exit on the context menu. In this case the icon will automatically appear again as soon 
as new Virtuozzo updates are ready to be downloaded or/and installed on your Hardware 
Node. 
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 You can also disable the automatic update of the Virtuozzo software by clearing the Keep 
my Virtuozzo installation up to date ... checkbox in the Virtuozzo Update Settings window and 
update your Virtuozzo software manually with the help of the Virtuozzo for Windows Update 
Wizard. To invoke the wizard, select Programs --> SWsoft --> Virtuozzo --> Virtuozzo Update 
Wizard on the Windows Start menu. This is the same wizard that is launched when the 
automatic update is enabled and you double-click the  icon in the system tray to 
download or/and install new Virtuozzo updates (please see the information above to learn 
how to work with the wizard). It is highly recommended to regularly run this wizard to 
ensure that you always use the latest Virtuozzo version. 

Note: Make sure that you always run the latest Virtuozzo version. Along with getting new 
Virtuozzo functionality, this will allow you to have the latest Windows Server 2003 updates 
installed on your Hardware Node. More information on Windows Server 2003 updates is 
provided in the Updating Windows Server 2003 subsection (on page 123). 
 

Updating Windows Server 2003 
Any standard Windows Server 2003 installation supports the Automatic Updates feature, which 
allows Windows Server 2003 to periodically check the Windows Update Web site for available 
updates, download these updates, and install them on your computer. To be compatible with this 
feature, the Virtuozzo installation configures the Windows Automatic Updates feature in such a 
way as to be able to automatically connect to the Virtuozzo updating center instead of the 
Windows Update site and download Windows updates from this center. 

All Windows updates in the Virtuozzo updating center are checked for their compatibility with 
Virtuozzo software and can be fearlessly installed on your Node. However, to be consistent with 
new Windows updates, Virtuozzo may (and usually does) undergo some slight changes. It 
means that only those Windows updates can be downloaded and installed on your computer that 
are compatible with your current version of Virtuozzo. To be sure you have the latest Windows 
updates, you should update your Virtuozzo software at regular intervals. Detailed information 
on Virtuozzo updates is provided in the Updating Virtuozzo Software subsection (on page 119). 

Thus, the Windows Server 2003 update procedure might look as follows. 

 The latest Virtuozzo updates are downloaded and installed on your Hardware Node, which 
may be done by manually running the Virtuozzo Update wizard or enabling the automatic 
update of Virtuozzo software (for more information see the previous section); 

 The Windows Automatic Update service connects to the Virtuozzo updating center and 
downloads the corresponding Windows update to the Node; 

 After you have confirmed the installation, the Windows update is installed on your 
Hardware Node. 

Note: 1. You do not have to update operating systems installed in Virtual Private Servers 
residing on your Hardware Node. They are automatically updated during the Host OS update. 

2. Please do not try to update Windows Server 2003 manually by clicking Start --> Windows 
Update, connecting to the Windows Update Web site, downloading new updates from this site, 
and installing them on your Node. It may cause Virtuozzo to malfunction. 
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Managing Node Cluster 
Organizing Hardware Nodes into a cluster is used to ensure a unified space of VPS IDs and 
VPS IP addresses throughout all the Nodes in the cluster. A cluster has the following advantages 
in comparison with standalone Nodes: 

 You do not have to bother anymore about the Virtual Private Server IDs when migrating 
VPSs between Nodes. 

 You do not have to manually assign IDs and IP addresses when creating VPSs. 
 You can easily check if there are any identical IDs or IP addresses assigned to Virtual 

Private Servers of different Nodes. 

Each cluster shall have one Master Node, where the database of VPS IDs and IP addresses is 
stored, and any number of Client (Slave) Nodes constituting the cluster. 
 

Creating Cluster 
To create a cluster of Nodes, you should right-click the Node you wish to be the Master one and 
select Tasks --> Create Virtuozzo Cluster on the context menu. 

The newly-created Virtuozzo cluster will be displayed in the left pane of the VZMC window on 
the same level as standalone Nodes. The name of the cluster will be put in parentheses and 
coincide with the name of its Master Node. Click on the cluster name to view a list of Nodes 
registered in it together with vital statistics on them in the right pane. The information will be 
presented as follows: 

Field Name Description 
Name The name of the Hardware Node. 

Address The IP address of the Service VPS. 

Connected with 
Master 

Indicates whether the corresponding Node is connected to the Master Node, i.e. it can 
exchange data with the Master Node. The Node may happen to be the Master Node 
itself. 

License The status of the Virtuozzo license. 

Agent The version of the vzagent software. 

OS The operating system installed on the Hardware Node. 

Memory The amount of the physical memory installed on the Node. 

Free Memory The current amount of free physical memory on the Node. 

Connected Whether the given Node is connected to VZMC. 

You may want to destroy a cluster. To this effect, select Tasks --> Destroy Virtuozzo Cluster on 
the context menu. 

Note: After you destroy a cluster, all configured resource pools containing in the cluster will 
also be deleted. 
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Adding Nodes to Cluster 
The Nodes that are added to an existing cluster automatically become Client (Slave) Nodes, as 
any cluster can have only one Master Node for storing a centralized database of VPS IDs and IP 
addresses. The easiest way to add new Nodes to a cluster is the following: 

1 Right-click the name of the cluster where you wish to add new Nodes and select Add 
Hardware Node to Cluster on the context menu. 

2 In the Add Client Hardware Node Into Cluster window, select those Nodes that you wish to 
add. In case of a large number of Nodes, it is reasonable to use the Select All and Deselect All 
buttons. The Register New button lets you invoke the Register Hardware Node wizard right 
from this window and then add the newly-registered Node to the cluster. 

3 Press the OK button. 

If you wish to add a particular Node to an existing cluster, you may also perform the following 
steps: 

1 Right-click the name of the Node that you wish to add to a cluster and select Tasks --> 
Register Node in Cluster on the context menu. 

2 In the Add Client Hardware Node Into Cluster window, select a Node in the table having 
"Master node" as its cluster status. If no Master Nodes are shown, it means that there are no 
clusters registered in VZMC. In this case you should close the Add Client Hardware Node 
Into Cluster dialog window and create a cluster first. 

3 Press the Register button. 
 

Configuring IP Addresses Pool 
After you have registered all the needed Hardware Nodes in a cluster, it is time to configure the 
IP Addresses and IDs pool for Virtual Private Servers hosted on the Nodes of the given cluster. 
One of the purposes of organizing Hardware Nodes into clusters is to ensure a unified space of 
VPS IP addresses throughout all the Nodes in the cluster. The database of the IP addresses to be 
assigned to the VPSs belonging to all the Nodes of the cluster is stored on the Master Node. 

To configure the pool of IP addresses, do the following: 

1 Right-click the corresponding cluster name and select Configure IP Addresses Pool on the 
context menu. 

2 On the Pool Configuration tab of the IP Addresses Pool Configuration window, view and 
configure one or more of continuous ranges of IP addresses comprising the pool. Every 
range may be characterized by the starting IP address, the ending IP address, and the 
number of IP addresses within the range. Obviously, it is enough to know any two of these 
three parameters to deduce the third one. This information on all the defined ranges is 
presented in the table. To configure the pool as desired, use the buttons to the right of the 
table: 

Button Description 

Add Range Displays a window where you can define a new range for the IP addresses pool of the 
current cluster. 

Delete Deletes the IP addresses range selected in the table. 
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Edit Displays a window where you can edit the parameters of the range selected in the 
table. 

Exclude Range 
Displays a window where you can exclude a certain continuous subrange of IP 
addresses from the range selected in the table. As a rule, this brings about the 
appearance of two new ranges instead of the selected one. 

 
 

Configuring Virtual Private Server IDs Pool 
Another purpose of organizing Hardware Nodes into clusters is to ensure a unified space of VPS 
IDs throughout all the Nodes in the cluster. This would allow to avoid, for example, migration 
problems. The database of the IDs to be assigned to the VPSs belonging to all the Nodes of the 
cluster is stored on the Master Node. 

To configure the pool of Virtual Private Server IDs, do the following: 

1 Right-click the corresponding cluster name and select Configure VPSIDs Pool on the context 
menu. 

2 On the Pool Configuration tab of the Virtual Private Server IDs Pool Configuration at Node 
window, view and configure one or more of continuous ranges of IDs comprising the pool. 
Every range may be characterized by the starting ID, the ending ID, and the number of IDs 
within the range. Obviously, it is enough to know any two of these three parameters to 
deduce the third one. This information on all the defined ranges is presented in the table. To 
configure the pool as desired, use the buttons to the right of the table: 

Button Description 

Add Range Displays a window where you can define a new range for the VPS ID pool of the 
current cluster. 

Delete Deletes the ID range selected in the table. 

Edit Displays a window where you can edit the parameters of the range selected in the 
table. 

Exclude Range 
Displays a window where you can exclude a certain continuous subrange of VPS IDs 
from the range selected in the table. As a rule, this brings about the appearance of two 
new ranges instead of the selected one. 
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Specifying Cluster Network Settings 
VZMC allows you to define DNS servers for all Virtual Private Servers residing on Hardware 
Nodes that constitute a cluster. It can be of great use, for example, while creating a new Virtual 
Private Server. In this case the DNS servers field will be automatically filled in with the 
corresponding values from your cluster. 

To set the aforementioned parameters, perform the following operations: 

1 Right-click the cluster name and select Network Configuration on the context menu. The 
Virtuozzo Cluster Network Setting window appears: 

 

Figure 60: VZMC - Setting DNS Servers 

2 Use the Add, Remove, and Properties buttons to the right of the DNS servers and Search 
domains fields to set, remove a DNS server or search domain, or change their properties, 
respectively. 

3 After you have made the necessary changes, click OK. 

Note: In the current version of Virtuozzo, you can specify DNS servers only. 
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Checking for Conflicts Among Nodes 
There may happen situations when the consistency of really assigned VPS IDs and IP addresses 
across all the Nodes in the cluster is broken, i.e. when they do not correspond to the database 
configuration stored on the Master Node. 

The most common kind of such conflicts happens when a newly-created VPS receives an ID or 
an IP address that have not been included in the corresponding pool. These conflicts are not 
very dangerous, but they may create problems in the future, so it is better to resolve them once 
they have been identified. 

More serious conflicts are represented by one and the same IDs or IP addresses assigned to 
separate Virtual Private Servers. This situation may lead to immediate problems with VPSs 
functioning, so you should get rid of identical IDs or IP addresses at once. 

To check for conflicts in the given cluster, right-click the cluster name in the left pane of the 
VZMC window and select Check for Conflicts on the pop-up menu. The Virtual Private Server 
Conflicts Resolution window is displayed. 

This window identifies the conflicts described above and allows you to solve them. Depending 
on whether there are VPS ID conflicts or IP addresses conflicts, or both, the corresponding tabs 
are available in the window. 

Whatever the tab, a table in the upper part of the window lists all the found conflicts on separate 
lines. The yellow icon denotes that the conflict is not that serious, and the red icon - that the 
conflict calls for an immediate resolution. 

In this window, you can perform the following tasks: 

 To sort all the conflicts in the table by a certain column, click on the heading of the column. 
A second click on the same heading reverses the sorting order. 

 To view the detailed description of a conflict and its default resolution, select the 
corresponding line in the table. The description will be provided in a text area under the 
table. 

 To resolve the desired conflicts, select the corresponding checkboxes in the table and press 
the Resolve button. To facilitate the selection, you may use the three buttons to the right of 
the table: 
 Pressing the Select All button marks all the checkboxes; 

 Pressing the Deselect All button clears all the checkboxes; 

 Pressing the Default Resolution button marks those checkboxes that allow for the default 
resolution of the corresponding conflicts. 
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Monitoring Resources 
You can exploit the Monitor feature of VZMC for monitoring resources. This feature provides 
either the whole Hardware Node resources monitoring or the monitoring of resources 
consumption by a single VPS, depending on whether you use the VZMC main window or a 
particular VPS manager window. To open the latter, it is enough to double-click the necessary 
Virtual Private Server in the VPS table in the right pane of the VZMC main window. The 
principles of working with these two kinds of monitors are essentially the same (only the set of 
the parameters that can be displayed is slightly different); therefore, they can be described 
together. 

To access the VZMC Monitor feature, you may either select the Monitor item in the left pane of 
the window you are working with, or open a separate Monitor console by clicking the Monitor 
Hardware Node button in the VZMC main window toolbar and register the necessary Hardware 
Node(s) and/or Virtual Private Server(s). In general, it does not make any difference whether a 
separate Monitor console is opened for a Hardware Node or for one of the VPSs. As soon as the 
Monitor console is opened, you can add Hardware Node(s) and/or VPS(s). Moreover, several 
Monitor consoles can be opened for several Hardware Nodes and VPSs in each console. 

The windows in the Monitor console are identical to those in the Monitor item, so you may 
choose either. To simplify things, we speak only of the Monitor item in all the instructions below 
in this section. 
 

C H A P T E R  7  

Logs and Monitors 
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Using Charts Representation 
The charts section of VZMC lets you display quite a number of charts for monitoring various 
kinds of resources on a single grid. It offers means for better visualization of charts, like 
assigning colors and line styles to all the elements of the grid and charts or choosing a peculiar 
representation scale for each chart. You can save and load a set of counters you would usually 
monitor thus avoiding the necessity of adding the counters one by one each time you start 
VZMC. And, last but not least, there is a possibility to replay the charts for any specified period 
of time by using logs. 

The sequence of your actions may be the following: 

1 To display the chart, expand the Monitor item in the window you are working with (either 
the VZMC main window or a VPS manager window), and click Charts to see the monitor 
grid in the right pane. 

2 Right-click in any place of the grid and select Add Counters, or press the Add Counters 
button on the Charts toolbar. 

3 In the Add Monitoring Counters dialog window, select the set of counters from which you 
want to add one(s) by selecting the desired group on the Counter type drop-down menu. 

4 Select the needed counter(s) and click Add. You may use the Ctrl and Shift keys to add a 
number of counters from a group. When you select a certain counter with your mouse, the 
counter description is provided in the lower part of the Add Monitoring Counters dialog 
window. For example: 

 

Figure 61: VZMC - Adding Monitoring Counters 

5 Click Close after you have added all the desired counters. 



 

 Logs and Monitors 131 
 

Now that you have a number of counters on the grid, you can see a red line indicating the 
current moment of time moving from left to right as time passes and new values of monitored 
parameters appear on the grid. Now it’s time to customize your view and learn the other 
opportunities. You may want to perform the following tasks: 

 Adjust the periodicity of refreshing the information on the grid; 

 Adjust the representation scale for each counter; 

 Adjust colors and line styles for the visual elements; 

 Highlight a certain counter; 

 Save the current configuration of counters to be able to open it at any moment of time; 

 Use the grid to replay some past real-time information about a set of parameters. 
 

Adjusting Periodicity of Refreshing Information 

To set the time interval at which the information is refreshed for all the charts, do the following: 

1 Right-click on the Monitor item in the Hardware Node or Virtual Private Server main tree 
and choose Properties; 

2 In the Monitor Properties window, select the Charts line: 

 

Figure 62: VZMC - Editing Monitor Update Interval 

3 Press the Set Refresh Interval button in the right corner of the Monitor Properties window; 

4 Enter the new time interval (in seconds) and press OK. 
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Adjusting Representation Scale 

The value of any counter on the grid may vary from 0 to 100. These numbers are marked on the 
left of the grid. But the “weight” of these numbers is different for each counter. It is difficult to 
use one and the same scale, for example, for memory usage which may amount to hundreds of 
thousands of KBs and for CPU usage in percent. You can adjust the scale for each parameter 
separately for their better visualization on the grid: 

1 Click on the name of the corresponding counter in the table of displayed counters below the 
grid: 

 

Figure 63: VZMC - Adjusting Charts Scale 

2 Select the necessary scale on the Scale drop-down menu on top of the grid and click Apply. 
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Adjusting Colors and Styles 

You can define the way this or that counter is displayed on the grid: 

1 Right-click on the name of the corresponding counter in the table of displayed counters 
below the grid and choose Properties: 

 

Figure 64: VZMC - Adjusting Charts View 

2 In the corresponding boxes, adjust the color of the counter line, its width and style as 
desired; 

3 Click the General tab and adjust the view of the grid elements. The options on that tab are 
self-explaining. 

4 Click OK. 
 

Highlighting Counter 

In case there are many counters being simultaneously displayed on the grid, it might be difficult 
to quickly single out the needed one. VZMC provides a means for highlighting any one of the 
counters at a time: 

1 Click on the name of the corresponding counter in the table of displayed counters below the 
grid; 

2 Press the Highlight Counter button on the toolbar. 
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The selected counter will be highlighted on the grid with a broad white line. 
 

Saving Counters Configuration 

You can save the information about the current set of counters in the VZMC configuration file 
to call this information the next time it is needed sparing the labor of adding the counters one by 
one again. Only one set of counters can thus be saved. Just press the Save Counters button on 
the toolbar after all the desired counters have been added. When you alter the counters 
configuration (for example, when you restart VZMC, all the counters are erased) and wish to 
restore the saved configuration, press the Load Counters button. The saved set of counters will 
be loaded from the configuration file. 
 

Replaying Information From Logs 

The function of replaying the resources consumption information over a specified time span in 
the past is ensured by the background logging of all the parameters in Virtuozzo. The default 
periodicity of refreshing the resources consumption information in the logs is set to be 1 (one) 
hour. You may have the logs collect the resources consumption information more frequently by 
"accelerating" the necessary logs with the help of the Log Setup item under the Monitor item. For 
example: 

1 Click Log Setup under the Monitor item. 

2 In the provided table, double-click the necessary log group, or right-click it and select 
Change Logging Period on the context menu. 
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3 In the Change Logging Period window, set the update period for the given group of logs and 
the time they are to be stopped. Besides, you can specify the time when the logging period 
will be set to the default value (1 hour) again by selecting the corresponding radio button: 

 

Figure 65: VZMC - Accelerating Logs 

4 Press OK to close the window. 

The replaying proper of logs is performed using the same grid of the Charts function as for real-
time monitoring. The counters are also displayed and configured in the same way as for real-
time monitoring. The principal difference is that when replaying the counters, the information 
for the charts is taken from the logs (both the default logs and the logs accelerated in the Log 
Setup section are used), and not from real-time monitoring. 

To switch to the charts replaying mode: 

1 Click Charts under the Monitor item  

2 On the Logged Counters tab, press the Add Counters button on the toolbar to display the Add 
Logged Counters window.  

3 On the Data tab of the Add Logged Counters window, press the Add button to add any of the 
available counters in the same way as they are added for real-time monitoring. 

4 After adding the desired counters, adjust the style of their visualization with the help of the 
corresponding options on the Data tab. 
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5 Go to the Time tab of the Add Logged Counters window, define the update period, and the 
time span for which you wish to view the logs for the specified counters: 

 

Figure 66: VZMC - Replaying Logs 

Please pay attention to the Maximum number of log points field, which indicates how many log 
entries will be shown on the chart. The maximal number is 100. If you have asked for a greater 
number of entries (this happens in the cases when the update period is too small, or the time 
span is too large, or both), the update period is automatically lengthened for the time span to 
contain only 100 entries. This is done to relieve the traffic between the Hardware Node and 
VZMC. 
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Using Table Representation 
Besides charts, it is possible to monitor many of the Hardware Node or VPS parameters in real 
time as a list of lines each of which reflects the name and the value of a parameter, as well as the 
attributes specific for this or that kind of parameters. In such a way, you can view the Network 
Rates and Processes groups for a particular Hardware Node, and the Network Rates, Processes, 
Quality of Service (QoS), and Quotas and Usage groups for a particular Virtual Private Server. 
Choose any of these groups either in the VZMC main window or in a VPS manager window to 
see the real-time information about the selected parameters in the form of a table. For example, 
if you choose Network Rates under a HN tree, you will see the following window: 

 

Figure 67: VZMC - Monitoring Traffic Parameters 

The Traffic accounting table shows the values for the incoming and outgoing traffic rate in bytes 
per second and packets per second for all the network interfaces present on the Hardware Node. 
You could view this information as a chart as well. 

You can change the time period with which the information is to be refreshed by doing the 
following: 

1 Right-click on the Monitor item in the Hardware Node or Virtual Private Server main tree 
and choose Properties; 

2 In the Monitor Properties window, select the line corresponding to the group of parameters 
for which you wish to change the update period; 

3 Press the Set Refresh Interval button on top; 

4 Enter the new time interval (in seconds) and press OK. 
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Viewing Network Traffic Summary 
VZMC allows you to view the information on all incoming and outgoing traffic for your 
Hardware Node or any of the Virtual Private Servers residing on it over a specified time period 
in the past. In order to view the traffic, perform the following operations: 

1 Expand the Monitor item in the main tree under either the Hardware Node name or the 
Virtual Private Server name and click Traffic Summary. 

 

Figure 68: VZMC - Viewing Network Traffic Summary 

2 Specify the time period for which you would like to view the logs. 

3 Click Download to display a list of log entries in the right pane of the window. 
 

Viewing System and Virtuozzo Logs 
VZMC allows you to view the logs which are maintained on the corresponding Hardware Node 
both for the Hardware Node itself and for a particular Virtual Private Server. The following log 
types are available for a particular Hardware Node in the VZMC main window: 

Log type Description 
Virtuozzo Full Virtuozzo chronicles, i.e., system messages. 

Events All VPS-related events (start, stop, migrate, etc.). 

Alerts Resource management system messages generated in case a VPS is coming very close to 
the QoS limits specified for it. 
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Operations Asynchronous tasks performed with any VPS of the Hardware Node. 

For Virtual Private Servers, only the Events, Alerts, and Operations logs are available in the 
corresponding VPS manager window. 

In order to view the logs, do the following: 

1 Open the Logs folder in the main tree under either the Hardware Node name or the Virtual 
Private Server name and click on the needed log type. 

2 Specify the time period for which you would like to view the logs. 

3 Click Download to display a list of log entries in the right pane of the window. 
 

Subscribing for VZMC Alerts 
VZMC allows you to configure and subscribe for e-mail notifications about resource-overusage 
system alerts. The subscription for this kind of alerts consists in specifying the e-mail address to 
send notification to. However, prior to subscribing for alerts, you should provide your e-mail 
relay server IP address to send e-mail notifications thru. To this effect, you should do the 
following: 

1 In VZMC, click on the Manage Alert Subscription link on the Hardware Node dashboard to 
display the Manage Alert Templates window; 

2 On the Configuration tab of the Manage Alert Templates window, enter an IP address to be 
used as the mail relay server in the E-mail relay IP address field; 

3 Click OK. 

Setting the e-mail relay server IP address is the only required operation that you have to perform 
before subscribing to alerts. However, there is a number of additional tasks that you may also 
wish to complete to configure the VZMC alert system to meet your demands: 

 Creating your own alert template to specify how your e-mail notifications will look and 
what information they will contain. By default, VZMC uses a pre-configured notification 
template. This template includes special placeholders representing special symbols that will 
be substituted for in the actual message by the actual VPS identifier, parameter name, etc. A 
list of the main placeholders is given below: 
 $VEID: the Virtual Private Server numeric identifier; 

 $ID: the name of the QoS parameter (in the actual message, it will be “diskspace”, etc.); 

 $CURTYPE: the alert type (at the alert generation moment). The “yellow” alert means 
that the barrier value of 90% has been reached, the “red” alert – that the value lies in the 
range from 95% to 100%, and the "black" alert - that the limit value has been hit; 

 $TIMERANGE: the alert time (the server time); 

 $CURVALUE: the current value of the parameter (at the alert generation moment); 

 $MAXVALUE: the maximal value of the parameter during the time when alerts were 
collected; 

 $SOFT: the parameter value barrier; 

 $HARD: the parameter value limit. 
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 Changing the alert policy, i.e. specifying in what way your alerts will be sent. By default, 
only one alert is sent per subscription and you have to resubscribe to an alert each time after 
its receiving. 

The aforementioned operations can be performed in the Manage Alert Templates window used to 
set your e-mail relay server IP address as well: 

 If you are not satisfied with the default alert template, go to the Templates tab of the Manage 
Alert Templates window and click on the Add Alert Template button to the right of the Alert 
template name field to see the Alert Template window. In the displayed window, fill in the 
provided fields with your own text using any of the above placeholders and press OK. 

 If you wish to change the default alert policy, you should go to the Configuration tab of the 
Manage Alert Templates window and choose one of the following options: 
 Stop sending. In this case after having received an alert, you have to resubscribe to it 

again. This option is selected by default. 

 Keep sending. In this case you will get alerts on a permanent basis without having to 
resubscribe to them each time after their receiving. 

 Collect alerts before sending for. In this case alerts will be permanently collected by 
VZAgent to a special database. This database will be periodically, i.e. with the period 
specified in the field opposite the option name, checked and if there were any alerts 
gathered during the set time, the corresponding notification will be sent to your e-mail 
address. The alert checking time is measured in seconds and can be set either by using 
the spin button or entering the needed period by hand. 

After you have chosen the right option, click OK to save the settings. 

Now that you have set the e-mail relay server IP address and, if necessary, changed the default 
alert template and/or default alert policy, you can subscribe for an alert: 

1 Click on the Subscribe to Alert link on the Hardware Node dashboard. 

2 Select the needed template on the Alert template name menu. 

3 Type the needed e-mail address in the To textbox. 

4 Press the Subscribe button. 
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Monitoring Hardware Node by Using 
vzwdog 

Along with monitoring the Hardware Node resources by means of VZMC, Virtuozzo allows 
you to keep track of the current state of your Hardware Node by using the vzwdog component. 
You can also use this component in the case of your Hardware Node crash to find out the 
reasons for which this crash happened. 

The vzwdog component is automatically installed on your Node during the Virtuozzo 
installation and includes two main parts: 

 vzwdog.sys - a special Virtuozzo driver and 
 vzwdogsrv.exe - a special Virtuozzo service. 

vzwdog.sys is periodically called on the Hardware Node to collect information on a number 
of the Hardware Node resources. The gathered data are then kept in a temporary storage. In the 
current version of Virtuozzo, the following resources are processed by vzwdog.sys: 

 kernel memory; 
 processes currently running on the Node; 
 Virtual Address Control Blocks (VACBs). 

The period with which vzwdog.sys collects information on these resources is set to 10 
seconds by default. However, you can change this period by editing the Hardware Node registry 
in the following way: 

1 On the Hardware Node, select Start --> Run and execute the regedit command to open 
Registry Editor. 

2 Locate the 
HKLM\SYSTEM\CurrentControlSet\Services\VzWdog\Parameters\ key. 

3 In the right pane of the Registry Editor window, double-click the QueryPeriod entry to 
open it for editing. 

4 In the displayed window, enter the right time period, in seconds, and click OK. 
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The vzwdogsrv.exe service is used to process information collected by the vzwdog.sys 
driver. During its runtime, vzwdogsrv.exe reads data from the vzwdog.sys temporary 
storage and saves them to HTML files on the Hardware Node. By default, the generated HTML 
files are stored in several subfolders within the C:\vz\log\wdog folder on the Node. 
Information collected by vzwdogsrv.exe and stored in HTML files on the Node is presented 
in the way like the following: 
    Event log started at 09/30/05 15:56:07 
 
+ 15:56:07 kernel memory nonpaged=62086 paged=129201 
* 15:56:07 processes: 28 
* 15:56:07 cache VACBs: 938 free, 420 used 
... 

In the top right corner of the displayed window, you can see the date and time when the current 
HTML file was created and the first log entry was added to the file. The remainder of the 
HTML file is filled with the entries containing brief information on the Hardware Node 
resources consumption. To get detailed information on any of the displayed resources, you 
should click on a symbol preceding the corresponding resource: 

 +: click on this symbol to expand the corresponding string and display detailed information 
on the given HN resource in the same browser window; 

 *: click on this symbol to open a new window where detailed information on the given HN 
resource is presented. 

Information on the resources consumption displayed on clicking either + or * is given for the 
time specified beyond the corresponding symbol. 

To check information contained in the generated HTML files, you can use one of the following 
ways: 

 Access the corresponding HTML files directly on the Hardware Node and double-click on 
them to display their contents. As has been mentioned above, the HTML files generated by 
vzwdogsrv.exe and containing information on the Hardware Node resources 
consumption are stored in several subfolders within the C:\vz\log\wdog folder on the 
Node. So, you can explore these subfolders and check the existing HTML files to know 
your Hardware Node state. 

 Display the contents of the generated HTML files by making an HTTP request to 
vzwdogsrv.exe. In this case the vzwdogsrv.exe service acts as an HTTP server 
obtaining the collected data from HTML files on the Node and sending them to either a 
local or a remote computer on your HTTP request. To generate a proper HTTP request, you 
should type http://Hardware_Node_IP_Address:8049 in the address line of 
your Web browser, where Hardware_Node_IP_Address is the IP address or hostname 
of the corresponding Node and 8049 denotes the port number used to connect to the Node. 
For example, if  you wish to check the current state of the Hardware Node with the IP 
address of 233.212.123.123, you should type 

http://233.212.123.123:8049 

in the address line of your browser and press ENTER. 

Note: To receive the latest information on your HN resources consumption, you should 
refresh your Web browser window. For example, if you are using the Internet Explorer 
browser, you can do it by pressing the F5 key on your keyboard or clicking the Refresh 
button on the Internet Explorer toolbar. 

 



 

 Logs and Monitors 143 
 

Configuring vzwdog Parameters 
The vzwdogsrv.exe service has a number of parameters which can be modified by editing 
the HKLM\SYSTEM\CurrentControlSet\Services\VzWdogSrv\Parameters\ 
key of the Hardware Node registry. A list of available parameters is presented in the table 
below: 

Parameter Name Description 
LogRoot Specifies the path to the root folder where a number of subfolders are 

located. These subfolders keep the HTML files generated by 
vzwdogsrv.exe and containing information on the Hardware Node 
state. By default, the C:\vz\log\wdog folder on the Node is used. 

LogDirs Sets the number of subfolders for storing HTML files that can be created in 
the root folder specified as the value of the LogRoot option. A new 
subfolder is created every time after the Hardware Node reboot and can be 
identified by its name reflecting the date and time of the HN start (e.g. 
2005Sep23_193839). By default, no more than 3 subfolders can 
simultaneously exist on the Node. In case 3 subfolders are already present 
on the Hardware Node and the Node is rebooted once more, the oldest 
subfolder is removed and a new one is created instead of it. 

FileSize Sets the upper limit for the HTML file size, in kilobytes. By default, the 
size of an HTML file is limited by 16 Kb. In case the specified limit has 
been exceeded, a new HTML file is created. 

LogFiles Defines the number of HTML files that can be created in each of the 
subfolders located in the root folder. By default, only 2 HTML files can be 
present in any subfolder at a time. In case the size of the collected data 
exceeds the size of two HTML files (i.e. exceeds 32 Kb), the oldest HTML 
file is deleted and a new one is created instead of it. 

LogLevel Defines the level of detail used when collecting data on the Hardware Node 
state. You can choose any level in the range from 0 (the lowest level of 
detail) to 3 (the highest level of detail); by default, level 2 is set. 

To modify any of the aforementioned parameters, you should locate the 
HKLM\SYSTEM\CurrentControlSet\Services\VzWdogSrv\Parameters\ key, 
double-click the corresponding parameter entry in the right pane of Registry Editor, enter the 
right value, and click OK. 
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Monitoring Top Resources 
Consumption 

VZMC provides you with the ability to view the Virtual Private Servers with the top resources 
usage. You may use this option to avoid or solve the problem of the Hardware Node 
overcommitment or simply monitor the load on the VPSs residing on your Node. To see a list of 
the top resource demanding VPSs, expand the Monitor item under the corresponding Hardware 
Node name and click the Resource Consuming VPSs folder in the VZMC left pane. 

Note: The statistics on a certain resource utilization shown in the right VZMC pane is an 
averaged usage data for a given timeframe. 

You can currently view the statistics on: 

 CPU time: displays the CPU time usage of your Virtual Private Servers against the entire 
CPU usage on the Hardware Node, in percents; 

 Physical memory: shows the statistics results against the total Hardware Node physical 
memory resource, in megabytes or kilobytes (depending on the amount of physical memory 
used); 

 Disk space: allows you to view the disk space utilization against the total Hardware Node 
resource value, in megabytes or kilobytes (depending on the amount of physical memory 
used); 

 Incoming traffic: reflects the incoming traffic statistics against the total amount of incoming 
traffic consumed by all the VPSs on the Node, in megabytes or kilobytes (depending on the 
amount of incoming traffic); 

 Outgoing traffic: lists the outgoing traffic statistics results against the overall outgoing 
traffic consumed by all the VPSs on the Node, in megabytes or kilobytes (depending on the 
amount of outgoing traffic). 
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Top CPU Resource Consuming VPSs 
You may run the need to view the most CPU time consuming Virtual Private Servers on your 
Hardware Node, which can help you avoid the Node overcommit and the consequent VPSs 
operation impairments. To view the CPU usage of all Virtual Private Servers on your Node, you 
should expand the Monitor item under the corresponding Hardware Node name and select the 
Resource Consuming VPSs item in the VZMC left pane and then click on the CPU tab in the 
VZMC right pane: 

 

Figure 69: VZMC - Top CPU Resource Consuming VPSs 

The statistics results are presented in the form of the Top CPU usage by VPS diagram where the 
X-axis denotes the IDs of the Virtual Private Servers for which the CPU resource usage 
statistics has been collected and the Y-axis represents the averaged CPU time, in percents, 
consumed by the given VPS for the selected timespan. 

The View Properties group above the diagram allows you to define the following parameters to 
govern the statistics results: 

 The time interval for which the CPU usage statistics is to be displayed. You can select one 
of the predefined values (day, month, year) on the drop-down menu or specify the 
needed period in the From and To fields. 

 The number of the Virtual Private Servers characterized by the top consumption of the CPU 
time. You can set the number of VPSs to be monitored in the Show top field either by using 
the spin button or entering the needed value by hand. 
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Top Physical Memory Consuming VPSs 
You might need to view the Virtual Private Servers using extensively the physical memory 
(RAM) of your Hardware Node. This can help you avoid the Node overcommit and the 
consequent VPSs operation impairments. To view the physical memory consumption by all 
VPSs on your Node, you should expand the Monitor folder under the corresponding Hardware 
Node name and select the Resource Consuming VPSs item in the VZMC left pane and then click 
on the Physical memory tab in the VZMC right pan: 

 

Figure 70: VZMC - Top Physical Memory Consuming VPSs 

The statistics results are presented in the form of the Top physical memory usage by VPS 
diagram where the X-axis denotes the IDs of the Virtual Private Servers for which the physical 
memory usage statistics has been collected and the Y-axis shows the averaged amount of 
physical memory, in megabytes or kilobytes, consumed by the given VPS for the selected 
timespan. 

The View Properties group above the diagram allows you to define the following parameters to 
govern the statistics results: 

 The time interval for which the physical memory usage statistics is to be displayed. You can 
select one of the predefined values (day, month, year) on the drop-down menu or specify 
the needed period in the From and To fields. 

 The number of the Virtual Private Servers characterized by the top consumption of physical 
memory. You can set the number of VPSs to be monitored in the Show top field either by 
using the spin button or entering the needed value by hand. 
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Top Disk Space Consuming VPSs 
You might need to view the Virtual Private Servers occupying the most of your Hardware Node 
disk space. This can help you avoid the Node overcommit and the consequent VPSs operation 
impairments. To monitor the disk space usage on your Node, you should expand the Monitor 
folder under the corresponding Hardware Node and select the Resource Consuming VPSs item 
in the VZMC left pane and then click on the Disk space tab in the VZMC right pane: 

 

Figure 71: VZMC - Top Disk Space Consuming VPSs 

The statistics results are presented in the form of the Top disk space usage by VPS diagram 
where the X-axis denotes the IDs of the Virtual Private Servers for which the disk space usage 
statistics has been collected and the Y-axis shows the averaged amount of disk space, in 
megabytes or kilobytes, consumed by the given VPS for the selected timespan. 

The View Properties group above the diagram allows you to define the following parameters to 
govern the statistics results: 

 The time interval for which the disk space usage statistics is to be displayed. You can select 
one of the predefined values (day, month, year) on the drop-down menu or specify the 
needed period in the From and To fields. 

 The number of the Virtual Private Servers characterized by the top consumption of disk 
space. You can set the number of VPSs to be monitored in the Show top field either by using 
the spin button or entering the needed value by hand. 
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Top Incoming Traffic Receiving VPSs 
You might need to view the most incoming-traffic active Virtual Private Servers on your 
Hardware Node. This can help you monitor the traffic used by all the VPSs on your Node. To 
view the VPSs incoming traffic on the Node, you should expand the Monitor folder under the 
corresponding Hardware Node name and select the Resource Consuming VPSs item in the 
VZMC left pane and then click on the Incoming traffic tab in the VZMC right pane: 

 

Figure 72: VZMC - Top Incoming Traffic Receiving VPSs 

The statistics results are presented in the form of the Top incoming traffic usage by VPS diagram 
where the X-axis denotes the IDs of the Virtual Private Servers for which the incoming traffic 
statistics has been collected and the Y-axis shows the averaged amount of incoming traffic, in 
megabytes or kilobytes, for the given VPS for the selected timespan. 

The View Properties group above the diagram allows you to define the following parameters to 
govern the statistics results: 

 The time interval for which the incoming traffic statistics is to be displayed. You can select 
one of the predefined values (day, month, year) on the drop-down menu or specify the 
needed period in the From and To fields. 

 The number of the Virtual Private Servers characterized by the top consumption of 
incoming traffic. You can set the number of VPSs to be monitored in the Show top field 
either by using the spin button or entering the needed value by hand. 
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Top Outgoing Traffic Consuming VPSs 
There might arise the need for you to view the most outgoing-traffic active Virtual Private 
Servers on your Hardware Node. This can help you monitor the traffic used by all the VPSs on 
your Node. To view the VPSs outgoing traffic on the Node, you should expand the Monitor 
folder under the corresponding Hardware Node name and select the Resource Consuming VPSs 
item in the VZMC left pane and then click on the Outgoing traffic tab in the VZMC right pane: 

 

Figure 73: VZMC - Top Outgoing Traffic Consuming VPSs 

The statistics results are presented in the form of the Top outgoing traffic usage by VPS diagram 
where the X-axis denotes the IDs of the Virtual Private Servers for which the outgoing traffic 
statistics has been collected and the Y-axis shows the averaged amount of outgoing traffic, in 
megabytes or kilobytes, for the given VPS for the selected timespan. 

The View Properties group above the diagram allows you to define the following parameters to 
govern the statistics results: 

 The time interval for which the outgoing traffic statistics is to be displayed. You can select 
one of the predefined values (day, month, year) on the drop-down menu or specify the 
needed period in the From and To fields. 

 The number of the Virtual Private Servers characterized by the top consumption of outgoing 
traffic. You can set the number of VPSs to be monitored in the Show top field either by 
using the spin button or entering the needed value by hand. 
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This chapter provides information on what services and processes are, the influence they have 
on the operation and performance of your system, and the tasks they perform in the system. 

You will learn how to use VZMC in order to manage services and processes in Virtuozzo. In 
particular, you will get to know how you can monitor active processes in your system, start, 
stop, or restart services and processes. 

In This Chapter 
What Are Services and Processes ......................................................................................... 151 
Main Operations on Services and Processes ......................................................................... 152 
Managing Services and Processes......................................................................................... 152 
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What Are Services and Processes 
Instances of any programs currently running in the system are referred to as processes. A 
process can be regarded as the virtual address space and the control information necessary for 
the execution of a program. A typical example of a process is the Notepad program (or any 
other program) running on your Hardware Node or inside your VPS(s). Along with common 
processes, there are a great number of processes that provide an interface for other processes to 
call. These are called services. In many cases, services act as the brains behind many crucial 
system processes; they typically spend most of their time waiting for an event to occur or for a 
period when they are scheduled to perform some task. Many services provide the possibility for 
other computers on the network to connect to the given one via various network protocols. 

Virtuozzo has a set of services at its disposal that perform certain tasks on the Hardware Node 
or inside Virtual Private Servers. A number of services are launched during the Hardware Node 
startup (for example, Virtuozzo KSAL Service or Virtuozzo Management 
Service), which is explained by the fact that Virtuozzo requires a specific set of running 
services to provide virtualization capabilities for the Node. These services are necessary for the 
proper functioning of your system (they are also called critical services). 

When working with services, you should keep in mind the following. During the lifetime of a 
service, it uses many system resources. It uses the CPUs in the system to run its instructions and 
the system's physical memory to hold itself and its data. It opens and uses files within the 
filesystems and may directly or indirectly use certain physical devices in the system. Therefore, 
in order not to damage your system performance you should run only those services that are 
really needed at the moment. 

Besides, you should always remember that running services in the Host OS is much more 
dangerous than running them in Virtual Private Servers. In case violators get access to one of 
the VPSs thru any running service, they will be able to damage only the VPS where this service 
is running, but not the other VPSs on your Hardware Node. The Hardware Node itself will also 
remain unhurt. And if the service were running on the Hardware Node, it would have damaged 
both the Hardware Node and all the VPSs residing on it. Thus, you should make sure that you 
run only those services on the Hardware Node that are really necessary for its proper 
functioning. Please launch all additional services you need at the moment inside separate VPSs. 
It will significantly improve your system safety. 

Note: In VZMC, you can view all available services/processes by selecting Services/Monitor --> 
Processes in the left pane below the Hardware Node name or the Virtual Private Server name. 
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Main Operations on Services and 
Processes 

The ability to monitor and control processes and services in your Virtuozzo system is essential 
because of the profound influence they have on the operation and performance of your whole 
system. The more you know about what each process or service is up to, the easier it will be to 
pinpoint and solve problems when they creep in. 

The most common tasks associated with managing services in the Host operating system of the 
Hardware Node or inside a Virtual Private Server are starting, stopping, and restarting a service. 
For example, you might need to start a service in order to use certain server-based applications, 
or you might need to stop or pause a service in order to perform testing or to troubleshoot a 
problem. All these operations can be performed by means of VZMC. 

As for processes, the main operations you can perform on them are monitoring the processes 
currently running on your Hardware Node or inside your Virtual Private Server(s) and making 
some control operations on them. 
 

Managing Services and Processes 
Virtuozzo Management Console allows you to manage (monitor and partially configure) the 
services and processes present in the Host operating system of the Hardware Node or in a 
Virtual Private Server. By using VZMC, you can start, stop, or restart a service. Below in this 
chapter detailed information on all those tasks that can be performed by means of VZMC is 
given. 
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Managing Processes 
In VZMC, you can view those processes that are currently running on your Hardware Node 
and/or inside your Virtual Private Server(s). To display the processes, click the Hardware Node 
name where you wish to monitor processes and then select Monitor -> Processes. The list of the 
Host OS or VPS OS processes should appear in the right pane: 

 

Figure 74: VZMC - Monitoring Active Processes 

The column names and their description are presented in the table below: 

Column name Description 
pid The identifier the process belongs to. 

%cpu The CPU time in percents used by the process. 

pri The kernel scheduling priority for the process. The higher value stands 
for higher process priority. 

rss Number of pages guaranteed to remain in the physical memory (not to 
be dumped to the page file). 

time The total CPU time the process has used, it is displayed in the 
hh/mm/ss format. 

user The user who has launched the process. 

command The command that invoked the process. 

To view the processes inside a Virtual Private Server, double-click on its name and select 
Monitor -> Processes. 

You can send different signals to processes by right-clicking a process and selecting the 
corresponding signal on the context menu. 
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Managing Services 
Virtuozzo Management Console allows you to monitor the services present in the Host 
operating system of the Hardware Node or in that of a Virtual Private Server. Click on the 
Services folder item in the tree below the Hardware Node name or the Virtual Private Server 
name. A list of the Host OS or VPS OS services should appear in the right pane: 

 

Figure 75: VZMC - Viewing Services 

Running services are indicated with bright icons. Stopped services have shaded icons. The 
Status column of the table duplicates this information in the text form. 

You can manage all services available on the Node or in a VPS in the same way you do it on a 
usual standalone server running Windows Server 2003, i.e. start, stop, or restart services, define 
their startup type (automatic, manual, disabled), view their dependencies, etc. To this effect, 
select the corresponding service in the table and either use the buttons on the toolbar or right-
click the service and select Properties on the context menu. 

Note: It is not necessary to use VZMC to manage the Node or VPS services. You can as well 
use the standard Services Microsoft Management Console (MMC) snap-in. To this effect, run 
the services.msc command either on the Hardware Node or in the VPS remote desktop 
connection window, respectively. 
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This chapter contains instructions for experienced administrators on the way to customize 
Virtuozzo Control Center and Virtuozzo Power Panels by changing the VZCC/VZPP layout and 
appearance and modifying certain VZCC/VZPP settings. 

In This Chapter 
Overview............................................................................................................................... 156 
Common Tasks ..................................................................................................................... 157 
VZCC/VZPP Architecture .................................................................................................... 162 
Customizing Individual Pages............................................................................................... 164 
Customizing VZCC/VZPP Menu ......................................................................................... 169 
Customizing VZCC/VZPP Layout ....................................................................................... 171 
Adding Skins to VZCC/VZPP .............................................................................................. 172 
Configuring VPS Offline Management ................................................................................ 174 
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Overview 
The Hardware Node administrator may customize VZCC and VZPP by altering their layout and 
appearance (e.g. including additional links on the menu) as well as by modifying certain 
VZCC/VZPP settings. This chapter begins with the step-by-step descriptions of the most 
common tasks you are likely to perform: 

 adding your own links to the VZCC/VZPP menu (on page 157); 
 setting automatic logout time (on page 159); 
 setting the maximal number of allowed VPS backups (on page 161). 

If you are looking for other ways to customize VZCC/VZPP, you are recommended to read on 
and peruse the VZCC/VZPP Architecture section (on page 162) as well as the consequent sections 
devoted to the following tasks: 

 modifying an existing VZCC/VZPP page (by the example of the VZPP services page) (on 
page 164); 

 adding a new VZCC/VZPP page (by the example of adding a new dashboard to the VZPP 
menu) (on page 166); 

 customizing the VZCC/VZPP menu (on page 169); 
 customizing the VZCC/VZPP general layouts (on page 171); 
 changing VZCC/VZPP graphical skins (on page 172). 

When customizing VZCC/VZPP, you are supposed to work with XML and XSL files located 
either inside the Service VPS or on the Hardware Node itself. To access the Service VPS, you 
can use one of the following ways: 

1 Log in to the Service VPS via Remote Desktop Protocol (RDP) with the Administrator 
account. You should make sure that you have specified the Administrator password for 
the Service VPS; if not, turn to the Changing Administrator Password section (on page 71) 
for instructions on how to do it. Then use any text editor like Notepad for modifying the 
necessary files. 

2 Log in to the Hardware Node where the Service VPS is hosted and go to the 
C:\vz\root\1 directory, which is the main directory for the Service VPS. Then, again, 
any text editor can be used for modifying the files. 

3 Use the VZMC file manager for modifying the necessary text files inside the Service VPS, 
i.e. download the corresponding files to your local computer, edit them, and upload the files 
again to the Service VPS. 

Finally, the Configuring VPS Offline Management section of the current chapter contains 
instructions on how you can manage your offline services and to enable/disable access to a 
particular Virtual Private Server by using VZPP. 
 



 

 Customizing VZCC/VZPP 157 
 

Common Tasks 

Adding VZCC/VZPP Links 
Adding your own links to the VZCC or VZPP menus is performed by editing the C:\Program 
Files\SWSoft\vzcp\etc\cc\menu.xml and C:\Program 
Files\SWSoft\vzcp\etc\pp\menu.xml files inside the Service VPS, respectively. Let 
us assume that you wish to provide VZPP with a link to the page on the provider's website 
where the VPS administrator is able to buy additional resources for their VPS. Open the 
C:\Program Files\SWSoft\vzcp\etc\pp\menu.xml file with the help of 
Notepad or any other editor. 

Note: To add a new link to the VZCC menu, you should open the  C:\Program 
Files\SWSoft\vzcp\etc\cc\menu.xml file inside the Service VPS and edit it in the 
same way as is described below for VZPP. 

As you see, there are four <submenu> elements in this file. Each <submenu> element is 
opened with the <submenu list_of_attributes> tag and closed with the 
</submenu> tag. In the browser, each <submenu> element corresponds to one of the four 
groups of links on the VZPP menu. Let us add a link to the first group of links called VPS 
Management: 

1 In the C:\Program Files\SWSoft\vzcp\etc\pp\menu.xml file, locate the 
<submenu> element having name="VPS Management" as one of its attributes. 
Between the <submenu> opening tag and the </submenu> closing tag, there are a 
number of <item> elements, also having their corresponding opening and closing tags. 
Each <item> element corresponds to a link on the VZPP menu. 

2 Create a copy of one of the <item> elements (i.e. all the text between the <item> 
opening tag and the </item> closing tag, including the tags proper) and place it just before 
the </submenu> closing tag. This will be a basis for your link. 

3 Edit this <item> element in the following way: 

 Enter the path to the page where the VPS administrator can buy more resources for their 
VPS as the value of the href attribute. 

 Enter the ID of the icon file to be shown to the left of the link as the value of the icon 
attribute. The file should be located in the C:\Program 
Files\SWSoft\vzcp\static\vz\skins\<skin_name>\icons directory 
inside the Service VPS and have the following name pattern: <id>_16.gif. 

Note: There are a number of subfolders in the C:\Program 
Files\SWSoft\vzcp\static\vz\skins\ folder. One subfolder corresponds to one 
VZPP skin defining such VZPP elements as its general layout, icons and images, the color 
palette, etc. Therefore, to allow your new icon to be displayed in VZPP when using any of 
the existing skins, you should add the icon file to each subfolder. 

 Between the <title> and </title> tags, enter the text to be shown as the new link 
in the browser. 
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 Remove the remaining attributes of the <item> element and the existing <screen> 
elements. 

In the end, your new <item> element may look like below: 
<item href="http://www.domain.com/res.cfm" icon="res_16" 
target="_blank"> 
  <title>Buy resources</title> 
</item> 

Note: The target="_blank" attribute tells the browser to open the link in a new browser 
window. Omitting this attribute will open the link in the same browser window. 

The newly created link will be available for all VPS administrators having access to the 
<submenu> element where your new <item> element is included. However, you may wish 
to restrict access to the link. The cred attribute in the <item> element allows you to prevent 
the link from being displayed on the VZPP menu. To this effect, you should enter a random ID 
as the value of the cred attribute and make sure that this ID is not specified in the 
C:\vz\private\1\root\Program Files\SWSoft\vzcp\etc\vzcpcon.conf 
file on the Hardware Node as one of the existing XML elements included in the <access> 
pattern element. 

To make the link available on the VZPP menu again, you can choose one of the following ways: 

 Remove the cred attribute from the <item> element in the C:\Program 
Files\SWSoft\vzcp\etc\pp\menu.xml file inside the Service VPS; 

 Specify the cred attribute in the C:\vz\private\1\root\Program 
Files\SWSoft\vzcp\etc\vzcpcon.conf file inside the Service VPS as an XML 
element (for example, <buy_resources/>. The name of the element should coincide 
with the ID of the cred attribute in the C:\Program 
Files\SWSoft\vzcp\etc\pp\menu.xml file, and the element itself should be 
placed after the following pattern elements: 

<auth> 
  <type>VEUser</type> 
  <user>administrator</user> 
    <creds> 
      <cred> 
      <id>vzcp</id> 
        <cred> 
        <id>vps</id> 
          <cred> 
          <id>management</id> 

In this case the Administrator user will gain access to the created link, i.e. this link will be 
displayed on the VZPP menu under the VPS Management group when the Administrator 
user is logged in to the Virtual Private Server. 
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Note: If you are creating a new VZCC link, you should look for the 
<type>SVEUser</type> string instead of <type>VEUser</type> in the 
C:\vz\private\1\root\Program Files\SWSoft\vzcp\etc\vzcpcon.conf 
file and place the corresponding XML element between the subsequent <management> 
opening tag and the </management> closing tag. 

While working with the cred attribute, you should also keep in mind the following: 

a After you have defined a new element in the C:\vz\private\1\root\Program 
Files\SWSoft\vzcp\etc\vzcpcon.conf file inside the Service VPS, you 
should restart the vzcp service by executing the vzctl exec 1 sc stop vzcpd 
and vzctl exec 1 sc start vzcpd commands on the Hardware Node and log 
out of and log in to VZPP afresh for the new settings to take effect. 

b Do not use spaces in the value of the cred attribute. 

To learn more about the VZCC/VZPP menu customization, turn to the Customizing VZCC/VZPP 
Menu subsection (on page 169). 

Note: Detailed information on other attributes that can be used with the <item> elements is 
provided in the Customizing VZCC/VZPP Menu section (on page 169). 
 

Setting Auto Logout Time 
If a VZCC/VZPP user has been inactive for a certain time after logging in to VZCC/VZPP, the 
system automatically logs them out, and the continuation of working with VZCC/VZPP is 
possible only after logging in anew. You may customize the period of inactivity before an 
automatic logging out by editing the vzagent.conf file located in the C:\Program 
Files\SWSoft\VZAgent\etc\ folder on the Hardware Node. Open the file for editing 
and find the following fragment of code inside the file: 
<ticketm> 
         <configuration> 
                 <ticket_expiration>10800</ticket_expiration> 
         </configuration> 
</ticketm> 

The value of the <ticket_expiration> element denotes this period of inactivity in 
seconds (3 hours in the example above). Edit this value as required and save the file. After you 
have appropriately edited the file, restart vzagent by opening the Services snap-in on the 
Hardware Node, right-clicking the VZAop service in the displayed window, and choosing 
Restart on the context menu. 

A simpler way of editing the vzagent configuration is by using VZMC: 

1 Right-click the Hardware Node name in the VZMC left pane and select Tasks --> Manage 
VZAgent Configuration on the context menu. 

2 In the VZAgent Configuration window, expand the ticketm key and select the 
configuration subkey. 
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3 Double-click the ticket_expiration parameter in the right pane: 

 

Figure 76: VZMC - Setting VZCP Auto Logout Time 

4 In the Edit Parameter window, enter the value you want in the Parameter value field. 

5 Press OK. 

The change will take effect immediately. In VZMC, you need to edit the value only once, and 
you do not need to restart vzagent manually. 

Note: The ticket_expiration parameter set in the C:\Program 
Files\SWSoft\VZAgent\etc\vzagent.conf file defines the logout time for both 
VZCC and VZPP. 
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Setting Maximal Backups Number 
Service VPS users and VPS administrators may be able to back up their Virtual Private Servers 
by means of VZCC and VZPP, respectively. VPS backups are stored on the Hardware Node and 
may take up a vast amount of disk space. That is why the Hardware Node administrator may 
wish to limit the number of VPS backups Service VPS users and VPS administrators are 
allowed to create. This number can be customized by editing the vzagent configuration file 
on the Hardware Node (C:\Program 
Files\SWSoft\VZAgent\etc\vzagent.conf). Open this file for editing and find the 
following fragment of code inside the file: 
<backm> 
         <configuration> 
                 a number of lines... 
                 <pe_backups_limit>1</pe_backups_limit> 
                 a number of lines... 
         </configuration> 
</backm> 

The value of the <pe_backups_limit> element denotes this number of backups (1 is the 
default value). Edit this value as required and save the file. After you have appropriately edited 
both files, restart vzagent by executing the following command on the Hardware Node: 
C:\Documents and Settings\Administrator>vzctl exec 1 sc stop vzcpd 
... 
Command 'exec' is successfully finished 
C:\Documents and Settings\Administrator>vzctl exec 1 sc start vzcpd 
... 
Command 'exec' is successfully finished 

A simpler way of editing the vzagent configuration is by using VZMC: 

1 Right-click the Hardware Node name in the VZMC left pane and select Tasks --> Manage 
VZAgent Configuration on the context menu. 

2 In the VZAgent Configuration window, expand the backm key and select the 
configuration subkey. 

3 Double-click the pe_backups_limit parameter in the right pane. 

4 In the Edit Parameter window, enter the value you want in the Parameter value field. 

5 Press OK. 

The change will take effect immediately. In VZMC, you need to edit the value only once, and 
you do not need to restart vzagent manually. 

Note: The limits set on the number of VPS backups by editing the vzagent configuration files 
concern only VPS administrators and Service VPS users. There are no restrictions for a 
Hardware Node administrator (i.e. for the vzagent0 user), who is allowed to create as many 
VPS backups as s/he wants to. 
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VZCC/VZPP Architecture 
The way VZCC/VZPP pages are organized and presented in a browser is determined by the 
corresponding XSL tables installed inside the Service VPS. It means that the layout and 
appearance of VZCC/VZPP pages are not hard-coded anywhere but may be customized as 
needed by editing these XSL files to create an individual look and feel for your VZCC/VZPP. 
Thus, the following things may be done: 

 Customizing individual VZCC/VZPP pages, including dashboards; 
 Customizing the VZCC/VZPP menu; 
 Customizing the VZCC/VZPP general layout; 
 Creating skins for VZCC/VZPP (whole sets of CSS and image files as well as some other 

parameters) and switching among various skins. 

All these tasks will be explained and covered in the following sections. In a general case, it is 
enough to possess an adequate HTML knowledge to customize the pages. However, it is also 
very desirable to know the basics of XML syntax. An expertise in the XSL language will give 
you the complete control over the VZCC/VZPP presentation. 
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Before reading on, it is important to understand in what way the XSL stylesheets take part in the 
process of making up HTML pages displayed in the VPS administrator's browser. The scheme 
below illustrates the actions performed inside the Service VPS between receiving a request from 
the browser and sending back the resulting HTML page to it: 

 

Figure 77: VZCC/VZPP Transformations 

Now each action is treated in more detail: 

1 The administrator follows, say, the 
http://<Service_VPS_IP_address:TCP_port>/cp/pwd link in his browser 
(or enters this link in the browser address line, for that matter). This page is used to change 
the root password in the current VPS. The administrator may use the IP address not of the 
Service VPS, but of a particular VPS s/he is managing. It is not of much importance here, 
since any such request is anyway redirected to the Service VPS. 

2 The vzcpcon process inside the Service VPS handles the HTTP request from the browser 
and converts it to an XML request (the contents of the HTTP request presented in the XML 
format). 

3 The vzcpcon process converts the created XML request to another XML format suitable 
for parsing by vzagent. To perform this action, vzcpcon uses the corresponding *.xsl 
file located in the C:\Program Files\SWSoft\vzcp\xsl\req directory inside the 
Service VPS (or, the C:\vz\root\1\C\Program 
Files\SWSoft\vzcp\xsl\req directory on the Hardware Node). In our case, the 
pwd.xsl file is used. 
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Note: If the request does not need a response from the VPS being managed (for example, 
the request is for displaying a dashboard common for all the VPSs), and therefore, 
vzagent is not involved, vzcpcon proceeds directly to Step 5. This is shown as a side 
arrow on the scheme above. 

4 vzagent handles the request by connecting to the corresponding VPS and makes up a 
response to vzcpcon. This response is also in the XML format, since XML is the primary 
language of vzagent. 

5 The vzcpcon process merges this XML response with the corresponding *.xsl file 
located in the C:\Program Files\SWSoft\vzcp\xsl\screens directory inside 
the Service VPS (or the C:\vz\root\1\C\Program 
Files\SWSoft\vzcp\xsl\screens directory on the Hardware Node). In our case, it 
will be the pwd.xsl file. Any such xsl file can be regarded as a set of templates 
instructing vzcpcon of the way to convert the XML response from vzagent to a valid 
HTML page. The resulting HTML page is sent back to the Internet browser and displayed in 
the administrator's window. 

Thus, we see that it is modifying HTML templates inside the *.xsl files that tells upon the 
way the VZCC/VZPP pages are generated. To learn more about this process and to get to know 
certain nuances of customizing VZCC/VZPP, see the following subsections. 
 

Customizing Individual Pages 
You may alter the appearance of a basic VZCC/VZPP page, or you may add your own pages to 
VZCC/VZPP. These tasks are described below. 
 

Modifying Existing Page 
To modify an existing VZCC/VZPP page, you should first determine what xsl file is 
responsible for displaying this or that page. Let us assume you wish to reorganize the Services 
table in VZPP: 

Note: To modify a VZCC page, you should perform the same operations that are described 
below for customizing a VZPP page. 

1 Log in to VZPP and click the System Services link on the left menu. If you are using the 
framed layout for VZPP, you may determine the URL of the page, for example, by placing 
the mouse on the link and looking at the status bar of your browser. In our case, it should 
read .../cp/services. This means that this page is displayed with the help of the 
services.xsl file in the C:\Program Files\SWSoft\vzcp\xsl\screens 
directory inside the Service VPS. 
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2 Log in to the Service VPS with the Administrator account and open the C:\Program 
Files\SWSoft\vzcp\xsl\screens\services.xsl file for viewing and editing. 
You should make sure that you have enabled the Administrator account for the Service 
VPS; if not, turn to the Changing Administrator Password section (on page 71) for 
instructions on how to do it. If you are logged on to the Hardware Node where the Service 
VPS is hosted, but not to the Service VPS itself, you may as well work with the 
C:\vz\root\1\C\Program 
Files\SWSoft\vzcp\xsl\screens\services.xsl file. Still, another possibility 
for working with text files is provided by the VZMC file manager feature. 

3 To unravel the way this (and any) xsl file forms the HTML page, you should search for the 
following string in the file: 

<xsl:template name="screen"> 

This element marks the beginning of generating an HTML page, and, if you know the XSL 
language, you may learn what auxiliary templates it calls (located either in the 
services.xsl file or in other files enumerated as attributes in the <xsl:include/> 
elements at the end of the file) and modify these templates as needed. If XSL is not your 
forte, you should search for the HTML code in the services.xsl file resembling the 
table on the System Services page. For example, you may guess that the following code is 
responsible for displaying the header row in the table: 

<xsl:with-param name="browse"> 
  <ui:browse-setup id="services" item-url="/service-win" 
   url="/services-win" item-url-tip="service_screen"/> 
  <ui:cols> 
    <ui:column id="name" hidden="yes" for-url="yes" for-select="yes" 
     encode="no"/> 
   <ui:column id="display-name" nav-type="id"  
    title="{sw:text('Name')}" filter="auto" for-select="no" 
    for-url="no"/> 
   <ui:column id="status" sorting="yes" align="center" 
    title="{sw:text('Status')}"/> 
   <ui:column id="startup-type" sorting="yes" align="center" 
    title="{sw:text('Startup Type')}"/> 
   <ui:column id="status-hidden" title="{sw:text('Status')}" 
    filter="select" hidden="yes"> 
    <ui:filter-option value="Stopped" title="{sw:text('Stopped')}"/> 
    <ui:filter-option value="Running" title="{sw:text('Running')}"/> 
   </ui:column> 
   <ui:column id="startup-type-hidden" title="{sw:text('Startup 
Type')}" 
    filter="select" hidden="yes"> 
    <ui:filter-option value="Automatic" 
     title="{sw:text('Automatic')}"/> 
    <ui:filter-option value="Manual" title="{sw:text('Manual')}"/> 
    <ui:filter-option value="Disabled" title="{sw:text('Disabled')}"/> 
   </ui:column> 
   <ui:column id="logon-as" filter="auto" sorting="yes" align="center" 
    title="{sw:text('Logon as')}"/>  
  </ui:cols> 
</xsl:with-param> 

4 Modify the HTML code as needed. Mind that this code should comply with the XHTML 
requirements, i.e. you should close all orphan elements (e.g. <br/> instead of <br>) and 
do not use cross-nested elements (e.g. <b><i>text</i></b> is correct, whereas 
<b><i>text</b></i> is incorrect). If you are unsure whether your modifications comply 
with the XHTML requirements, you may use third-party software, for example, XMLSPY 
(www.altova.com) to check whether the resulting file is well-formed. 
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For example, you may exchange the places of the following fragments of code: 
<ui:column id="startup-type" sorting="yes" align="center" 
 title="{sw:text('Startup Type')}"/> 

 and 
<ui:column id="status-hidden" title="{sw:text('Status')}" 
 filter="select" hidden="yes"> 
 <ui:filter-option value="Stopped" title="{sw:text('Stopped')}"/> 
 <ui:filter-option value="Running" title="{sw:text('Running')}"/> 
</ui:column> 

After that, the Status and Startup Type columns will be exchanged in the Services table on the 
System Services page. Refresh your VZPP page to see the results. 
 

Adding New Page 
New VZCC/VZPP pages are created by adding new *.xsl files to the C:\Program 
Files\SWSoft\vzcp\xsl\screens folder inside the Service VPS. Since these xsl files 
are written specifically for the XML generated by vzagent, it is recommended not to create 
new files from scratch but use existing files as a starting point. In this subsection, we will 
consider a situation when you want to add a new dashboard to your VZPP, say, for housing 
external links related to your business. So, here is what you should do (we suppose that you are 
working inside the Service VPS): 

Note: The C:\Program Files\SWSoft\vzcp\xsl\screens directory inside the 
Service VPS contains the *.xsl files common for both VZCC and VZPP. However, there are 
a number of *.xsl files used for creating VZCC pages only. These files are located in the 
C:\Program Files\SWSoft\vzcp\xsl\screens\cc folder in the Service VPS. 

 Decide on any existing VZPP dashboard file and make a copy of it in the C:\Program 
Files\SWSoft\vzcp\xsl\screens directory. For example, you can copy the 
vps.xsl file to be a basis for your new page and call it my_dash.xsl. 

 Open the newly-created file for editing by means of a text editor (e.g. Notepad). 
 Find the following line in the file: 
<ui:screen id="07.03.00.00"  title="{sw:text('VPS Management')}" 
icon="vps_management" cred="/vps/management"> 

and change the value of the following attributes: 

 id. When defining the id values for your own VZPP pages, you should leave the first 
dyad intact (it identifies VZPP as a module), change the second one to a large number 
(to identify your personal screens), and have the last two ones at your choice (they 
would identify different subscreens within the group of your personal screens). Thus, 
you may define the following ID for your VZPP page: 

 <ui:screen id="07.99.01.00" …> 

 title. Change the value of the attribute to what you wish to be reflected as the title of 
your dashboard on the VZPP page. 



 

 Customizing VZCC/VZPP 167 
 

 icon. Change the value of the attribute to point to the icon file you wish to be displayed 
to the left of the dashboard title. The icon file itself should be placed to the 
C:\Program 
Files\SWSoft\vzcp\static\vz\skins\<skin_name>\icons folder with 
the following name mask: <id>_32.gif. The id value of this mask should be 
entered as the value of the select attribute instead of the vps_management string. 

Note: There are a number of subdirectories in the C:\Program 
Files\SWSoft\vzcp\static\vz\skins\ directory. One subdirectory corresponds 
to one VZPP skin defining such VZPP elements as its general layout, icons and images, and 
the color palette. Therefore, to allow your new icon to be displayed when using any of the 
existing skins, you should place the icon file in each subdirectory. 

 cred. Optional. Change the ID of the cred attribute responsible for granting VPS 
administrators access to this link on the VZPP menu. This ID should be specified in the 
C:\Program Files\SWSoft\vzcp\etc\vzcpcon.conf\vzcpcon.conf 
file inside the Service VPS between the <auth> and </auth> tags. Detailed 
information on the cred attribute is provided in the Adding VZCC/VZPP Links 
subsection (on page 157). 

Inasmuch as there is no need in connecting to any VPS for displaying any dashboard page, and 
so vzagent is not involved in the process, vzcpcon uses not the XML response from 
vzagent to build an HTML page, but the static C:\Program 
Files\SWSoft\vzcp\etc\pp\dashboard.xml file. So, you further need to define 
your dashboard in this file. Open it for editing by means of any editor (for example, of 
Notepad). 

Note: While adding a new VZCC page, you should work with the dashboard.xml file 
located in the C:\Program Files\SWSoft\vzcp\etc\cc\ directory. 

There are four <dashboard> elements defined in this file, including the top dashboard 
providing links to the three others. 

 Copy one of the children <dashboard> elements inside the file to provide a basis for 
defining your own dashboard, for example, the Services dashboard: 

<!-- VPS Services dashboard --> 
 <dashboard id="07.04.01.00" name="VPS Services" cred="/vps/services"> 
 <item href="$baseurl/services" title="System Services" 
 icon="services" tip="srv_screen" cred="system_services" 
 platform="linux"> 
         <text>On this screen you may manage various services 
    in this VPS.</text> 
 </item> 
 <item href="$baseurl/proc" title="System Processes" 
icon="processes" 
 tip="proc_screen" cred="system_processes"> 
    <text>On this screen you may check processes currently 
    running in your VPS and send them system signals.</text> 
 </item> 
 … 
 </dashboard> 

 Now edit this dashboard definition to reflect your own template: 
 Edit the commentary describing your dashboard; 
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 Edit the value of the id attribute of the <dashboard> element to reflect the screen ID 
you have specified in the my_dash.xsl file; 

 Edit the value of the name attribute of the <dashboard> element to provide a good 
description to your dashboard. There are no restrictions as to what this name should be; 

 Create as many <item> elements as the number of links on your dashboard; 

 Edit the value of the href attribute of each <item> element. This will be the value of 
the href attribute of the <a> element in the resulting HTML. You may specify an 
absolute path here as well. 

 Edit the value of the title attribute of each <item> element. This will be the text 
between the <a> and </a> tags in the resulting HTML. 

 Edit the value of the icon attribute of each <item> element to point to the icon you 
wish to be displayed to the left of the title. See above for details on how this value 
should be specified. 

 Edit the value of the tip attribute of each <item> element to display the brief 
description of the page currently opened in VZPP. The value of the tip attribute should 
be specified as the id attribute of the <tip> element in the 
C:\vz\private\1\root\Program Files\SWSoft\vzcp\etc\tips.xml 
file inside the Service VPS. 

 Edit the value of the cred attribute of each <item> element, if any, to grant a VPS 
administrator access to the VZPP page. Detailed information on the cred attribute is 
provided in the Adding VZCC/VZPP Links subsection (on page 157). 

 Enter win32 as the value of the platform attribute of each <item> element if you 
wish the link defined by this <item> element to be available on Windows Hardware 
Nodes only. Otherwise, remove this attribute from the <item> element. 

 You may additionally define the target attribute for any <item> element that would 
be copied as the target attribute for the <a> element in the resulting HTML. 

 Edit the text between the <text> and </text> tags for each <item> element. This 
will be the description of your link on the HTML page. 

 At last you have to create an additional <item> element for the top dashboard. For 
example, you may define it as follows: 

<item href="$baseurl/my_link" title="External Links" 
icon="external_links"> 
  <text> 
    Various external links gathered for your convenience. 
  </text> 
</item> 

That is almost all about creating a new dashboard of yours. You may now access it by typing 

https://<Service_VPS_IP_address_or_hostname>:<TCP_port>/cp/my_dash 

into the address line of your browser or by following the proper link from the top VZPP 
dashboard. However, after creating your new dashboard, you may naturally want to provide a 
link to it in the left VZPP menu. Please consult the Adding VZCC/VZPP Links subsection (on 
page 157) to know how to add your own links to the VZPP menu. 
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Customizing VZCC/VZPP Menu 
Inasmuch as there is no need in connecting to any VPS for displaying the VZCC/VZPP menu on 
any page, and so vzagent is not involved in the process, vzcpcon uses not the XML 
response from vzagent to build the menu, but the static C:\Program 
Files\SWSoft\vzcp\etc\cc\menu.xml and C:\Program 
Files\SWSoft\vzcp\etc\pp\menu.xml files inside the Service VPS, respectively. So, 
you may define your additional links and submenus in these particular files or change the 
properties of the existing ones. Detailed information on how to add your own links and 
submenus to the VZCC/VZPP menu is provided in the Adding VZCC/VZPP Links subsection (on 
page 157). The given subsection familiarizes you with the way to modify the existing links and 
submenus on the VZCC/VZPP menus only. 

You can customize the properties of the VZCC and VZPP links and submenus by editing the 
C:\Program Files\SWSoft\vzcp\etc\cc\menu.xml and C:\Program 
Files\SWSoft\vzcp\etc\pp\menu.xml files inside the Service VPS, respectively. Let 
us assume you wish to edit the VZCC menu. To this effect, open the C:\Program 
Files\SWSoft\vzcp\etc\cc\menu.xml file for editing by means of Notepad or any 
other XML editor. 

As you probably know from the Adding VZCC/VZPP Links subsection (on page 157), there are 
three <submenu> elements defined in this file by default. One <submenu> element 
constitutes one group on the VZCC menu providing links to the existing dashboards and 
grouping the links to individual VZCC pages presented by the <item> elements inside each 
<submenu> element. The properties of all <submenu> and <item> elements are defined by 
the values of their attributes and/or their subelements; so you should simply change these values 
to customize the VZCC menu properties. The table below describes the meaning of each 
attribute/subelement in the C:\Program Files\SWSoft\vzcp\etc\cc\menu.xml 
file: 

Attribute/subelement Description 
name The name of the dashboard link as it will be displayed on the menu. 

href The path the link references. This may be either an absolute or relative path. 
The $baseurl variable stands for 
https://<VPS_IP_address:TCP_port/vz/cp corresponding to 
C:\Program Files\SWSoft\vzcp\xsl\screens inside the 
Service VPS. If the path specifies an xsl file in this directory, its extension 
should be omitted. 

cred The ID of the cred attribute responsible for granting a Service VPS user 
access to this or that link on the VZCC menu. This ID should be specified in 
the C:\Program 
Files\SWSoft\vzcp\etc\vzcpcon.conf\vzcpcon.conf file 
inside the Service VPS between the <auth> and </auth> tags. Detailed 
information on the cred attribute is provided in the Adding VZCC/VZPP 
Links subsection (on page 157). 
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tip The value of the id attribute of the <tip> element in the C:\Program 
Files\SWSoft\vzcp\etc\tips.xml file inside the Service VPS. 
The contents of the corresponding <tip> element is the description of the 
link the Service VPS user sees when moving the mouse over the link. 

screen-id The ID of the screen the link refers to. This attribute has no special meaning 
apart from highlighting the link when you are on the corresponding VZCC 
page. 

type Defines the link area where the contents of the <tip> element will be 
shown when moving the mouse over the corresponding element on the 
VZCC interface. 

icon The ID of the icon file to be shown to the left of the link. The file should be 
located in the C:\Program 
Files\SWSoft\vzcp\static\vz\skins\<skin_name>/icons 
directory inside the Service VPS and have the following name pattern: 
<id>_16.gif. 

id The ID of the screen the link refers to. This attribute has no special meaning 
apart from highlighting the link when you are on the corresponding VZCC 
page. 

target An optional attribute of the <item> element acting as the target 
attribute of the HTML <a> element. For example, specifying 
target="_blank" will tell the browser to open the corresponding link 
in a new window. 

svps Indicates if the operation defined by the <item> element where this 
attribute is specified can be performed in the Service VPS context. To 
prevent the operation to be applied to the Service VPS, you should set the 
value of this attribute to deny. Omitting the attribute or specifying another 
value in this attribute will allow you to perform the operation in the Service 
VPS context. 

platform If specified, indicates the platform (Hardware Node) where the link defined 
by the <item> element containing this attribute will be displayed on the 
VZCC menu. The values that can be set in this attribute are the following: 

 win32: the link will be shown for all Hardware Nodes running the 
Windows Server 2003 OS; 

 linux: the link will be displayed for all Hardware Nodes running the 
Linux OS (Red Hat 9, Fedora Core 3, etc.). 

cond Is used to additionally check if the link should be displayed on the VZCC 
menu. 

<title> The name of the link under the dashboard link as it will be displayed on the 
menu to the right of its icon. 

<screen> Attaches screens whose identifiers are listed as the value of the id attribute.

<custom_script> Indicates what Java script should be executed while clicking the link on the 
VZCC menu. 

<template> Is used to check the version of the Confixx template and, depending on the 
version, to decide whether the Confixx link should be shown on the VZCC 
menu or will be unavailable for users. 
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Note: The aforementioned attributes and subelements can be specified in both files 
C:\Program Files\SWSoft\vzcp\etc\pp\menu.xml and C:\Program 
Files\SWSoft\vzcp\etc\cc\menu.xml, i.e. any of these elements can be used for 
building both the VZPP menu and the VZCC menu. 

The appearance proper of the VZCC menu is controlled by the C:\Program 
Files\SWSoft\vzcp\xsl\lib\nav_menu.xsl file inside the Service VPS. You may 
edit the HTML code in this file to create a different look for the menu. This procedure is 
covered in the Customizing Individual Pages subsection above. 
 

Customizing VZCC/VZPP Layout 
If you simply want to define a kind of layout (framed, non-framed, vzcc, etc.) to be used for 
building VZCC/VZPP pages, you should turn to the Adding Skins to VZCC/VZPP subsection for 
the instructions. 

If you want to perform a more intricate customization, you should modify the code inside one of 
the .xsl files in the Service VPS C:\Program Files\SWSoft\vzcp\xsl\layout\ 
directory. The .xsl files from this directory are used to transform the XML response from 
vzagent - a set of .xml files containing all the needed information on your pages, 
dashboards, menus, etc. in Virtuozzo Control Center and Virtuozzo Power Panels - to the 
HTML pages as they are displayed on your screen. In other words, these files are responsible for 
forming the VZCC/VZPP layout, although to a variable extent. For example, you can edit the 
plain.xsl or framed.xsl files in the C:\Program 
Files\SWSoft\vzcp\xsl\layout\ directory, which build up the body of the HTML 
page, to define the general VZCC/VZPP layout (the appearance and relative positions of the 
VZCC/VZPP menu, title bar, etc.). In its turn, the complete HTML page as such, i.e. beginning 
with its essential <html><head> elements and so on, is made up by the basic.xsl file 
located in this directory; so, you may modify this file to customize the VZCC/VZPP 
appearance.  

Note: To edit the .xsl files in the C:\Program Files\SWSoft\vzcp\xsl\layout\ 
directory, you should have sound knowledge of Extensible Stylesheet Language 
Transformations (XSLT). 

After you have edited and saved any layout .xsl file, it is necessary to restart vzcp for the 
changes to take effect by issuing the following commands on the Hardware Node: 
C:\Documents and Settings\Administrator>vzctl exec 1 sc stop vzcpd 
... 
Command 'exec' is successfully finished 
C:\Documents and Settings\Administrator>vzctl exec 1 sc start vzcpd 
... 
Command 'exec' is successfully finished 
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Adding Skins to VZCC/VZPP 
VZCC/VZPP skins are sets of parameters determining such VZCC/VZPP elements as the layout 
used (framed, non-framed, vzcc-plesk, vzcc-plesk, or plesk-integrated), the menu behavior 
(collapsing or static), as well as the icon and image files and CSS stylesheets used to form 
VZCC/VZPP pages. Multiple skins are available for VZCC/VZPP; you may also create and use 
your own skins. Any one of these skins may then be chosen on the Configure Control Center 
page of VZCC and the Configure Power Panels page of VZPP to be used in your browser. 

In our example, we will define a new skin for VZCC. To this effect, you should perform the 
following operations: 

1 In the Service VPS, open the C:\Program Files\SWSoft\vzcp\etc\skins.xml 
file for editing by means of Notepad or any other XML editor. 

2 Search for the following string in the file: 
<mode id="vzcc"> 

3 Copy an existing <skin> element inside the file (all the text between the <skin> opening 
tag and the </skin> closing tag including these tags themselves) to provide a basis for 
your own skin. Your new <skin> element should be placed between the <mode 
id="vzcc"> opening tag and the </mode> closing tag. 

Note: While creating a new skin for VZPP, make sure your new <skin> element is placed 
between the <mode id="vzcp"> opening tag and the </mode> closing tag inside the 
C:\Program Files\SWSoft\vzcp\etc\skins.xml file. 

4 Edit this <skin> element in the following way: 

 Between the <id> and </id> tags, enter a name that will be used to refer to your new 
VZCC skin. You may specify any name you consider suitable for your skin. 

 Between the <theme> and </theme> tags, provide a new string corresponding to the 
name of a subdirectory in the C:\Program 
Files\SWSoft\vzcp\static\vz\skins directory housing all the necessary 
image and CSS files. There are a number of pre-installed subdirectories (aqua, ice, 
etc.) as is seen from the <id> elements of the existing skins. When using your own 
skin, you should make sure that you have created the corresponding subdirectory in the 
C:\Program Files\SWSoft\vzcp\static\vz\skins directory. This 
subdirectory should, in its turn, contain the icons and images subdirectories with all 
the necessary icon and image files, correspondingly, and a custom CSS file named 
vz.css in its root. You should also make sure that all the icon and image files have 
names absolutely identical to those of any pre-installed skin and that your CSS file 
defines exactly the same styles as any pre-installed CSS file. 

 Between the <name> and </name> tags, provide a string that will be displayed when 
expanding the Interface Skin menu on the Configure Control Center page of VZCC. 

 Between the <layout> and </layout> tags, enter framed, non-framed, vzcc, 
vzcc-plesk, or plesk-integrated, depending on what kind of layout you wish 
to be associated with the current skin. 



 

 Customizing VZCC/VZPP 173 
 

 Between the <menu> and </menu> tags, enter either collapsing or static, 
depending on whether you want the left menu groups to be able to collapse or not for the 
current skin. 

 Between the <buttons> and </buttons> tags, enter either images or text, 
depending on whether you want the buttons on VZCC screens to be displayed as images 
found in the C:\Program 
Files\SWSoft\vzcp\static\vz\skins\<skin_name>\images directory 
or to be drawn by the browser. 

 Optionally, add the <background/> element to enable beautiful backgrounds on 
VZCC pages. 

5 Save the file. 

Now you can choose the relevant skin for your browser by means of the VZCC Configure 
Control Center page. 
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Configuring VPS Offline 
Management 

The offline management functionality allows you to manage a particular Virtual Private Server 
with the help of VZPP. When offline management is enabled for a VPS, this VPS is said to be 
subscribed to one or more offline services, which means that one or more ports of its IP address 
are permanently active whatever the VPS state. This is needed to ensure the VPS manageability 
in its down state. 

The currently supported services are vzpp (for managing Virtual Private Servers by means of 
Virtuozzo Power Panels) and plesk (for managing Virtual Private Servers by means of the 
Plesk control panel integrated with Virtuozzo Power Panels). The names of the accessible 
services should be given as the value of the OfflineServices parameter in the 
C:\vz\Conf\0.conf file; the active ports of the services should be set as the value of the 
vzpp and plesk entries in the HKLM\Software\SWSoft\Virtuozzo\Redirect 
subkey of the Windows registry in the following format: 
DESTINATION_VPSID:PORT 

where 

 DESTINATION_VPSID is the ID of the VPS where the requests coming to the specified 
port will be redirected (e.g. "1" for the Service VPS). 

 PORT denotes the port that should be entered in the address line of an Internet browser after 
the VPS IP address when managing a VPS by means of Virtuozzo Power Panels or the Plesk 
control panel (e.g. "4643" for the vzpp service). 

Note: During the Virtuozzo installation, the Conf folder is automatically created in the 
directory you specified for storing all VPS data. By default, the C:\vz\ directory is used. 
However, you might have defined another path for the directory. 

For example, specifying vzpp as the value of the OfflineServices parameter in the 
C:\vz\Conf\0.conf file and setting 1:4643 as the value of the vzpp entry in the 
HKLM\Software\SWSoft\Virtuozzo\Redirect subkey allows you to use VZPP for 
managing individual Virtual Private Servers and port 4643 for logging in to the VPS by means 
of VZPP. 

By default, offline management is enabled for all Virtual Private Servers residing on the Node. 
To start using the offline management feature, inform the VPS administrator of the TCP port 
that is the value of the vzpp or plesk entries in the 
HKLM\Software\SWSoft\Virtuozzo\Redirect subkey. It will be enough to enter 
https://<VPS_IP_address_or_hostname>:<TCP_port> 

in the address line of any browser and to log in as Administrator with the appropriate password 
(you should have specified this password during the VPS creation) to start to remotely manage 
the corresponding Virtual Private Server. This way of logging in to a VPS is very handy for 
VPS administrators because they need to know only the IP address/hostname of their VPS and 
its Administrator credentials to be able to manage the VPS. No additional information (e.g. the 
Service VPS IP address) is required. 
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In case the Plesk control panel application is installed in a Virtual Private Server and this VPS is 
subscribed to the plesk service, the Plesk admin account can also be used by the VPS 
administrator for logging in to Virtuozzo Power Panels. The Plesk control panel is integrated 
with VZPP is such a way that the Virtuozzo menu item on the Plesk menu allows the VPS 
administrator to access the standard VZPP functionality, whereas all the other menu items on 
the Plesk menu ensure the standard Plesk functionality. 

At any time, you can disable the offline management for the given VPS by setting the value of 
the OfflineMgmt parameter in the C:\vz\Conf\<VPS_ID>.conf file to 0. In its turn, 
setting the value of the vzpp or plesk offline services in the C:\vz\Conf\0.conf file to 
0 disables the offline management feature for all Virtual Private Servers residing on the Node. 

You can also disable the offline management for one or all VPSs on the Node by means of 
VZMC: 

 To disable the offline management for the given VPS: 
 Select the Virtual Private Servers item under the Hardware Node name; 

 Right-click the name of the VPS on the VPS list and select Properties on the context 
menu; 

 Go to the General tab; 

 Clear the Enable offline management checkbox; 

 Press OK. 
 To disable the offline management for all Virtual Private Servers residing on the Node at 

once: 
 Right-click the Hardware Node name and select Tasks --> Manage Offline Services 

Configuration; 

 In the Offline Services Configuration window, clear the Enable Virtuozzo Power Panels 
and Control Center services checkbox ; 

 Press OK. 

Note: If the OfflineMgmt and OfflineServices parameters are not present in the 
C:\vz\Conf\<VPS_ID>.conf file, the offline management feature is enabled for all 
offline services enumerated in the C:\vz\Conf\0.conf file provided the OfflineMgmt 
parameter in the latter file is set to "1". 
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Customizing VPS Desktop 
A VPS administrator may wish to customize the VPS desktop to meet their demands. Generally, 
Virtuozzo allows VPS administrators to configure their VPS desktops in the same way as they 
would do it in any other Windows system installed on a stand-alone computer: place the most 
frequently used icons to the desktop, arrange these icons in the desired order, change the display 
settings (e.g. color scheme, font size), etc. However, there are some VPS desktop features that 
require the performance of additional steps in comparison with a standard Windows system or 
are implemented in Virtuozzo VPSs only. 

These features include: 

 Changing the VPS desktop background (i.e. desktop wallpapers) and 
 Customizing the VPS ID and hostname string in the top right corner of the desktop. 

To change the desktop wallpaper in a standard Windows system, one should right-click on a 
spare place on the desktop, select Properties on the context menu, and, in the displayed window, 
go to the Desktop tab and choose the right wallpaper. However, to allow VPS administrators to 
change the desktop background inside their Virtual Private Servers in Virtuozzo-based systems, 
you should first perform the following operations: 

 Restart the Terminal Server installed on your Hardware Node in case you have never done 
so after the Virtuozzo installation. For example, you can do it by performing the following 
operations on the Node: 
 Selecting Programs --> Administrative Tools --> Terminal Services Manager on the 

Windows Start menu; 

 Choosing This computer --> Computer_Name --> RDP-Tcp (listener) in the left pane of 
the displayed window where Computer_Name denotes the hostname of your Node; 

 Right-clicking RDP-Tcp (listener) and selecting Reset on the context menu. 

Note: All running Virtual Private Servers on your Node (including the Service VPS) will be 
stopped during the Terminal Server restart. 

C H A P T E R  1 0  
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 Make sure that your Remote Desktop Connection client supports the desktop background 
management feature. To this effect: 
 Select Programs --> Accessories --> Communications --> Remote Desktop Connection on 

the Windows Start menu to open the Remote Desktop Connection dialog box. 

 Click Options, go to the Experience tab, and ascertain that the Desktop background 
checkbox is selected. 

By default, each Virtual Private Server on the Node has a string displayed in the top right corner 
of the desktop and identifying the ID of the VPS you are currently logged in to (e.g. VPS 133). 
You can prevent the VPS ID string from being displayed on the VPS desktop: 

 With the help of VZMC where you should right-click the corresponding VPS, select 
Properties on the context menu, go to the General tab, clear the Show VPS ID at desktop 
background checkbox, and click OK. Next time you log in to your VPS via RDP, the VPS 
ID string will be absent from your desktop. 

 By executing the vzctl set command and passing the --showvpsid no option to it. 
Next time you log in to your VPS via RDP, the VPS ID string will be absent from your 
desktop. For more information on this command, please consult the Reference chapter.  

Along with displaying the VPS ID string, you can make the VPS desktop show the hostname of 
the Virtual Private Server you are currently logged in to. To this effect, you should use the  
vzctl set command and pass the --showhostname yes option to it. Let us assume that 
VPS 101 has the hostname of My_Computer and that you wish this hostname to be displayed 
on the VPS desktop each time you are logged in to VPS 101. To display the My_Computer 
legend on the VPS desktop, you should execute the following command: 
C:\...\Administrator>vzctl set 101 --showhostname yes 
Command 'set' is successfully finished 

To remove the VPS hostname string from the VPS desktop, you should use the vzctl set 
command with the --showhostname no option. 

Note: You should log off from the Virtual Private Server and log in to it anew every time you 
customize your VPS desktop by using the vzctl set command or by means of VZMC. 
 

Migrating Physical Server to VPS 
This section provides information on how you can migrate an external physical server to a 
Virtual Private Server on your Hardware Node. 
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Overview 
Along with migrating Virtual Private Servers between your Hardware Nodes, you may wish to 
move a stand-alone physical server running the Windows Server 2003 operating system to a 
VPS on your Node. The migration process includes copying the whole contents of the physical 
server (i.e. all its files, folders, network settings, and so on) to a Virtual Private Server on the 
Hardware Node. After the server migration, you will have its exact copy in a VPS including the 
applications, the IP address(es), etc. 

You may wish to migrate a physical server to a VPS in the following situations: 

 You wish to reduce administrative and operation costs related to your physical servers 
management and, therefore, decrease the number of physical servers under management by 
moving them into virtual ones. Multiple Virtual Private Servers on the Node can then be 
managed as efficiently as a single server; and many physical servers (Nodes) and all their 
VPSs can be managed centrally by means of VZMC. 

 You wish to optimize resource utilization and move your physical servers, some of which 
might exploit their resources not to the full extent, to the Virtual Private Servers where each 
VPS is fully used and the resources are not wasted. 

 You wish to minimize downtime costs. You move your physical servers to the Virtual 
Private Servers any of which can be easily and transparently backed up and rapidly 
deployed in the event of a system failure. 

Virtuozzo allows you to migrate a physical server to a VPS on the Hardware Node: 

 By using Virtuozzo Management Console (VZMC); 
 By using the Virtuozzo p2v migrator; 
 By using the vzp2v Virtuozzo command line utility; 
 By using Virtuozzo Control Center (VZCC). 

Virtuozzo Management Console is considered a standard tool for migrating a physical server to 
a VPS on your Hardware Node. It enables you to easily and quickly move virtually any stand-
alone physical server running Windows Server 2003 to a Virtual Private Server. You may also 
be provided with the p2v migrator - a special Virtuozzo tool offering you all the VZMC 
migration functionality and a number of additional enhancements making your migration 
procedure more reliable and comfortable. The migration procedure by means of VZMC and the 
Virtuozzo p2v migrator is described in the following subsections. 

Besides, you can resort to the help of the vzp2v utility and VZCC to migrate a physical server 
to a Virtual Private Server. Detailed information on how to do it is provided in the Reference 
chapter and VZCC Administrator's Guide, respectively. 
 

Migration Requirements 
To avoid delays and problems while migrating your physical server to a Virtual Private Server 
on the Node, please make sure that the following requirements are fulfilled in respect of the 
server and the Hardware Node: 

1 The physical server to be migrated must be running the same version and Service Pack, if 
any, of Windows Server 2003 as the Hardware Node where this physical server is to be 
moved. 
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2 The language version of Windows Server 2003 running on the physical server and the 
Hardware Node must be identical. 

3 The Service VPS must exist on the Hardware Node. 

4 A network connection can be established between the physical server, the Hardware Node, 
and the Service VPS on this Node. 

 

Migration Restrictions 
Although Virtuozzo allows you to migrate virtually any physical server running the Windows 
Server 2003 operating system to a Virtual Private Server on your Hardware Node, there is a 
number of limitations which should be taken into account before deciding on the migration 
process: 

 Non-NTFS volumes cannot be migrated from the physical server to a Virtual Private Server 
on the Hardware Node. 

 After the physical server migration, the Quality of Service packet scheduler is disabled 
inside the VPS irrespective of its state on the server before the migration began. Please 
consult the Enabling QoS Scheduler for VPS subsection to learn how to enable it inside your 
Virtual Private Server. 
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Migrating Physical Server to VPS in VZMC 
VZMC provides a special wizard allowing you to quickly and reliably migrate a stand-alone 
physical server to a Virtual Private Server on your Node. You can launch the Migrate Physical 
Server to VPS wizard by right-clicking the Virtual Private Servers item under the Hardware Node 
where you wish to migrate the physical server and choosing Tasks --> Migrate Physical Server to 
VPS on the context menu. You will be presented with the following window: 

 

Figure 78: VZMC - Logging In to Physical Server 

The information you should enter in the fields provided is presented in the table below: 

Field Name Description 
Server IP Address or Hostname The IP address or hostname of the physical server you wish to 

migrate. 

User Name The user name used to log in to the physical server. You can 
specify the Administrator user in this field, which is offered 
by default, or may use any other account to log in to the server. 
However, in the latter case you should make sure that the specified 
user has all the rights and privileges of the Administrator user.

User Password The password used to log in to the physical server by the user 
specified in the User Name field. 
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Clicking Next in the Login to the Server being Migrated window starts the process of connecting 
to the physical server and collecting information on the server configuration. The process is 
displayed in the progress bar of the Collecting Server Configuration window. After the wizard 
has successfully connected to the physical server and finished collecting information on its 
configuration, the following window is displayed: 

 

Figure 79: VZMC - Reviewing Server Configuration 

The Review Server Configuration window allows you to check the configuration of the server 
you are going to migrate into a VPS. The information on the server is divided into three groups 
for your convenience: 

 The System Configuration group including information on the operating system the server is 
running, the number and power of the processor(s) installed on the server, etc. 

 The Network Configuration group containing information on the server hostname, the 
name(s) and IP address(es) of the network adapter(s) used to handle network traffic of the 
server, the IP address(es) of the default gateway used by the server to access other networks, 
and so on. 

 The Disk Configuration group holding data on the disk drive(s) of the physical server: their 
name, type, block size, disk space, etc. 

After reviewing information on the server and clicking Next, you will be presented with the 
Select Partitions Intended for Migration window: 
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Figure 80: VZMC - Selecting Disk Drives 

In this window, you should specify one or several disk drives on your physical server that will 
be migrated to a Virtual Private Server on the Hardware Node by selecting checkboxes in front 
of the corresponding disk drive(s). The contents of the selected disk drive(s) (files, folders, etc.) 
will be then moved to your VPS. To facilitate working with your physical server disk drives, 
you can make use of the Select All and Deselect All buttons to select and deselect all disk drives 
at once, respectively. 

Note: The C:\ drive of the physical server is always selected and cannot be excluded from the 
migration. 

On the next screen, you will be asked to define the ID of the Virtual Private Server where your 
physical server is to be migrated: 
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Figure 81: VZMC - Specifying VPS ID 

You can keep the ID offered by VZMC by default or specify your own VPS ID by entering the 
right value in the Virtual Private Server ID field or using the spin button. In any case, please make 
sure that there is no VPS on the Node with the ID specified in this field. After you have decided 
on the VPS ID, click Next. 

The last screen of the wizard allows you to review once more the configuration of the physical 
server to be migrated and to view the migration settings made on the previous steps. You can 
also select the Shut down server and start VPS after migration checkbox at the bottom of the 
screen to automatically stop the physical server and start the VPS after the successful migration. 
This may be necessary to avoid the conflict of the physical and virtual servers due to the 
identical network settings. If you are satisfied with the parameters set, click Finish to start 
migrating the physical server to the VPS. 
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Migrating Physical Server to VPS by Using p2v Migrator 
If you are provided with a special Virtuozzo tool - the p2v migrator, you can also use it to 
quickly and reliably migrate a stand-alone physical server to a Virtual Private Server on your 
Node. You can launch the Virtuozzo for Windows Migrator wizard by selecting Programs --> 
SWsoft --> Virtuozzo --> Virtuozzo p2v migrator on the Windows Start menu. You will be 
presented with the Welcome to the Virtuozzo Migrator Wizard window where you should click 
Next to proceed with the physical server migration. 

On the next screen, you should provide information for connecting to the physical server you 
are going to migrate to a VPS on your Hardware Node: 

 

Figure 82: Virtuozzo Migrator - Providing Physical Server Information 

The information you should enter in the fields provided is presented in the table below: 

Field Name Description 
Physical computer name or IP 
address 

The hostname, NetBIOS name, or IP address of the physical server 
you wish to migrate to a VPS on the Hardware Node. You can 
manually enter the right hostname/NetBIOS name/IP address or 
make use of the Browse button and select the server in the displayed 
window 

Login The user name used to log in to the physical server. You can 
specify the Administrator user in this field or may use any 
other account to log in to the server. However, in the latter case you 
should make sure that the specified user has all the rights and 
privileges of the Administrator user. 
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Password The password used to log in to the physical server by the user 
specified in the Login field. 

Clicking Next in the Physical computer selection window starts the process of connecting to the 
physical server and collecting information on the server configuration. The process is displayed 
in the progress bar at the bottom of the displayed window. After the wizard has successfully 
connected to the physical server and finished collecting information on its configuration, the 
following window is displayed: 

 

Figure 83: Virtuozzo Migrator - Selecting Disk Drives For Migration 

In this window, you should specify: 

 One or several disk drives on your physical server that will be migrated to a Virtual Private 
Server on the Hardware Node by selecting checkboxes next to the corresponding disk 
drive(s). The whole contents of the selected disk drive(s) (files, folders, etc.) will be moved 
to your VPS. The information on disk drives is presented in the table having the following 
columns: 

Column Name Description 
Name The letter assigned to the disk drive on the physical server. 

Space used The amount of disk space used on the disk drive on the physical server, in 
megabytes. 

Space after 
migration 

The amount of disk space to be used by the drive inside the Virtual Private 
Server on the Node where the physical server will be migrated, in megabytes. 
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The disk space values set in the Space after migration column for all disk drives to be 
migrated will make the VPS disk space quota. You can change the amount of disk space to 
be allocated to each drive inside the VPS and offered by the migrator by default. To this 
effect, you should select the corresponding disk drive, click on the Edit space button below 
the Disks table, and enter the right value in the Disk space in blocks field of the displayed 
window. However, while setting disk space for this or that disk drive, please keep in mind 
that the value set in the Space after migration column by default is the minimal amount of 
disk space needed for error-free operation of the VPS on the Hardware Node and cannot be 
decreased. 

Note: The C:\ disk drive of the physical server should always be selected and cannot be 
excluded from the migration. 
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 The ID of the Virtual Private Server where your physical server is to be migrated. You can 
keep the ID offered by the migrator by default or specify your own VPS ID by entering the 
right value in the VPS ID field. In any case, please make sure that there is no VPS on the 
Node with the ID specified in this field. 

After specifying the server disk drives to be migrated and VPS ID and clicking Next, you will be 
presented with the following window: 

 

Figure 84: Virtuozzo Migrator - Making Final Preparations 

In this window, you can perform the following operations: 

 In the Host Name field, enter a hostname for the Virtual Private Server where your physical 
server is to be migrated. You can leave the hostname assigned to the physical server and 
offered by the migrator by default or specify your own one which will redefine the original 
server hostname. 

 In the IP address field, enter an IP address for the Virtual Private Server where your 
physical server is to be migrated. You can leave the IP address assigned to the physical 
server and offered by the migrator by default or specify your own one which will redefine 
the original server IP address. 

Notes: 1. If there are several IP addresses assigned to the physical server, the first IP address 
set in the address file on the server is displayed in the IP address field. In this case entering a 
new IP address will redefine only the IP address shown in this field; all the other IP 
addresses will remain intact and be assigned to the VPS. 

2. In the current version of the p2v migrator, you can set only one IP address for the Virtual 
Private Server in the Virtual Private Server final configuration window. 
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 Select the Shut down physical computer checkbox to stop the physical server after its 
successful migration. This may be necessary to avoid the conflict of the physical and virtual 
servers due to the identical network settings. 

 Select the Start up Virtual Private Server checkbox to start the Virtual Private Server after the 
physical server migration. 

Clicking Next in the Virtual Private Server final configuration window starts migrating the 
physical server to the VPS. 

The process of migrating your physical server to the VPS on your Hardware Node may take a 
rather long run. Please wait until the process is completed. After the successful physical server 
migration, the Congratulations! ... window is displayed where you should click Finish to exit the 
Virtuozzo for Windows Migrator wizard. 
 

Configuring VPS QoS Parameters After Migration 
You may wish to configure the QoS parameters for the Virtual Private Server where your 
physical server was migrated. By default, the QoS parameters are in the following state after the 
migration: 

 The disk space quota imposed on the VPS is calculated on the basis of the amount of disk 
space used on all disk drives that were migrated to the VPS plus some additional free disk 
space needed for the VPS error-free performance. 

 The Virtual Private Server is allocated 1000 CPU units. 
 The Number of TS sessions and VPS memory parameters are set to 'unlimited'. 

You can configure any of the aforementioned parameters by using VZMC or Virtuozzo 
command line utilities. Detailed information on how you can do it is provided in the Managing 
Resources chapter (on page 95). 
 

Managing External Drives and 
Image Files for VPS 

The given section provides information on how you can add new virtual drives to your Virtual 
Private Servers and configure them to meet your demands. Besides, it explains you the way to 
mount available drives and image files located on the Hardware Node to drives and files inside a 
VPS to make them accessible from within the VPS. 
 

Managing VPS Virtual Disks 
Virtuozzo enables you to perform the following operations on VPS virtual disk drives: 

 Add additional disk drives to your Virtual Private Servers; 
 Increase/decrease the current size of the disk drive and modify its measurement units; 
 Remove an existing disk drive from your Virtual Private Server. 

All these operations are described below in detail. 
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Adding New Disk Drive to VPS 

In Virtuozzo-based systems, any Virtual Private Server is created with only one disk storage 
inside it - the C:\ disk drive. However, Virtuozzo allows you to add new virtual disk drives to 
any VPS residing on your Hardware Node. After a new disk drive has been successfully added 
to a VPS, it becomes visible: 

 On the Hardware Node: 
 As a file in the .efd format in the X:\vz\private\VPS_ID folder and 

 As a folder in the X:\vz\root\VPS_ID\ directory. 

 From inside the Virtual Private Server: log in to the VPS via RDP and launch Windows 
Explorer. Your new drive will be displayed among other local disk drives available inside 
your VPS. 

You can then use the newly created virtual disk drive in the same way as you would use it on a 
stand-alone computer: format it, create new files and folders within the drive, etc. 

To add a new virtual disk drive to a VPS, you should perform the following operations: 

1 In VZMC, expand the corresponding Hardware Node name and select the Virtual Private 
Servers item to display a list of VPSs currently existing on the Node. 

2 Right-click the VPS you wish to add a new virtual drive to and choose Tasks --> Manage 
Mounts on the context menu. 

Alternatively, you can open the Virtual Private Server Manager window for the given VPS 
and click on the Manage Mounts link in the Actions section of the VZMC view pane. 
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3 In the opened window, click on the Add button to display the Mount Point window: 

 

Figure 85: VZMC - Adding New Drive to VPS 

In this window, you should do the following: 
 In the Mount point list, click the drop-down arrow and select a drive letter under which the 

created disk drive will be accessible inside the Virtual Private Server. The specified letter 
will be also displayed as the name of the folder in the X:\vz\root\VPS_ID\ directory 
on the Node. 

 Select the Create new image radio button to make the options below active: 
 In the Size field, specify the size for your new disk drive either by using the spin button 

or by entering the needed value manually. You can also change the units in which the 
drive size will be measured by selecting GB (gigabytes) instead of MB (megabytes) on 
the drop-down menu. By default, you are offered to create a 10 Mb disk drive. 

 Under the Location subgroup, choose one of the following options to specify where on 
the Node the file corresponding to the created drive and having the .efd extension will 
be located: 

a Select the VPS private area radio button to create and locate the file in the private area of 
the corresponding VPS (i.e. in the X:\vz\private\VPS_ID folder on the Node). 
You can also specify the name of the file in the Image file name field. If you leave this 
field blank, the file name will be automatically generated by VZMC in the form of 
lpbkVPS_Number.efd where VPS_Number denotes the index number of the disk 
drive automatically created inside the VPS (i.e. lpbk0000.efd for the first disk drive, 
lpbk0001.efd for the disk second drive, etc.). 

b Select the Hardware node radio button to create and locate the file in a place other than 
the VPS private area. In this case you should specify the full path to the file on the 
Hardware Node (e.g. C:\MyFolder\MyFile.efd). 

1 Click OK. 
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In the command line, you can add a new virtual disk drive to your Virtual Private Server with 
the vzctl partadd command. Detailed information on this command is provided in the 
Reference chapter. 
 

Configuring VPS Disk Drive 

After a new disk drive has been created and added to your Virtual Private Server, you can start 
using it as a usual hard disk storage on a stand-alone computer. However, in certain situations 
you may wish to modify a particular disk parameter to meet your demands. For example, if may 
need more disk space in a Virtual Private Server but do not want to add another disk drive to it, 
you can instead change the maximum size of the VPS disk. 

The current version of Virtuozzo allows you to configure your VPS virtual disk drive as 
follows: 

 Increase/decrease the current size of the disk drive; 
 Change the units in which the VPS virtual disk is measured. 

Note: The aforementioned operations can be performed on any VPS virtual disk drive except 
for the C:\ drive. Detailed information on how you can manage your C:\ drive is provided in 
the Managing VPS Disk Space section (on page 95). 

To change the virtual drive size and/or its measurement units, you should perform the following 
operations: 

1 In VZMC, expand the corresponding Hardware Node name and select the Virtual Private 
Servers item to display a list of VPSs currently existing on the Node. 

2 Right-click the VPS whose disk drive you wish to configure and choose Tasks --> Manage 
Mounts on the context menu. 

Alternatively, you can open the Virtual Private Server Manager window for the given VPS 
and click on the Manage Mounts link in the Actions section of the VZMC view pane. 
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3 In the opened window, click on the Resize button to display the Mount Point window: 

 

Figure 86: VZMC - Configuring VPS Drive 

This is the same window as is used to create new disk drives and add them to your Virtual 
Private Server. However, all the options available on this screen are inactive except for the 
Size field where you can modify: 

 The drive size: use the spin button or type the needed value by hand to change the 
current size value. While changing the disk drive size, please note that it should not be 
less then the size of files and folders located on this drive; otherwise, the drive resizing 
will fail. 

 The units in which the drive size is to be measured: select MB (stands for megabytes) or 
GB (stands for gigabytes) on the drop-down menu. 

4 When you are ready with specifying new values for your virtual drive, click OK. 

You can also use the vzctl set command to change the current size of a VPS disk drive. 
Detailed information on this command can be found in the Reference chapter. 
 

Removing Disk Drive From VPS 

You can remove any existing disk drive from your Virtual Private Server except for the C:\ 
drive. To remove a virtual disk drive, you should perform the following operations: 

1 In VZMC, click the Virtual Private Servers item under the corresponding Hardware Node 
name to display a list of all Virtual Private Servers residing on the Node. 

2 Right-click the VPS from where you wish to remove a disk drive and select Tasks --> 
Manage Mounts on the context menu. Alternatively, you can open the Virtual Private Server 
Manager window for the given VPS and click on the Manage Mounts link in the Actions 
section of the VZMC view pane. 
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The Mount Points Manager window will be displayed where you can see all the drives 
currently available inside your VPS: 

 

Figure 87: VZMC - Removing Drive From VPS 

3 Select the disk drive you wish to remove from your VPS and click on the Remove From List 
button. 

4 In the Delete Drive window displayed after you click on the Remove From List button, you 
can do one of the following: 

 Click Yes without selecting the Delete image file ... checkbox. In this case the disk drive 
will become inaccessible from within the Virtual Private Server (i.e. invisible in 
Windows Explorer) and the corresponding folder will be deleted from the 
X:\vz\root\VPS_ID\ directory on the Hardware Node. However, the file in the 
.efd format in the X:\vz\private\VPS_ID folder on the Node conforming to the 
removed disk drive will remain intact. 

 Select the Delete image file ... checkbox and click Yes. In addition to the operations 
performed in the previous case, this will also remove the corresponding file in the .efd 
from the X:\vz\private\VPS_ID folder on the Hardware Node. 

Note: While deciding on your virtual disk drive removal, please keep in mind that all 
folders and files located on the drive will be deleted from the VPS without affording you an 
opportunity to restore them. 

In the command line, you should use the vzctl partdel command to remove an existing 
disk drive from your VPS. Detailed information on this command is provided in the Reference 
chapter. 
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Managing Hardware Node Drives 
In some circumstances, you may need to give your Virtual Private Server direct access to a 
drive on your Hardware Node. Virtuozzo allows you to mount a drive on the Node to a drive 
inside your VPS, thus, granting you access to this drive from inside the VPS. After mounting 
the drive, you can log in to the VPS via RDP and work with the mounted drive in the same way 
as you would do it on the Hardware Node. 

Virtually any drive available on the Node can be mounted to a VPS, e.g.: 

 a physical hard drive; 
 a DVD-ROM drive; 
 a CD-ROM drive; 
 a floppy disk, etc. 

To mount a Hardware Node drive to a VPS, you should perform the following operations: 

1 In VZMC, click the Virtual Private Servers item under the corresponding Hardware Node 
name to display a list of all Virtual Private Servers residing on the Node. 

2 Right-click the VPS where you wish to mount a drive from the Hardware Node and select 
Tasks --> Manage Mounts on the context menu. 

Alternatively, you can open the Virtual Private Server Manager window for the given VPS 
and click on the Manage Mounts link in the Actions section of the VZMC view pane. 

3 In the opened window, click on the Add button to display the Mount Point window: 

 

Figure 88: VZMC - Mounting Hardware Node Drive 

In this window, you should do the following: 
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 In the Mount point list, click the drop-down arrow and select a letter under which the 
mounted drive will be accessible inside the Virtual Private Server. 

 Check the Mount hardware node drive radio button and, on the drop-down menu, select a 
letter assigned to the drive on the Node that you wish to mount to the VPS. 

Note: The permissions of the drive mounted to a VPS correspond to those of this drive on the 
Hardware Node, i.e. you are able to perform the same operations on the drive inside the VPS as 
you are allowed on the Node. 

At any time, you can unmount the mounted drive from your Virtual Private Server. To this 
effect, do the following: 

1 In VZMC, click the Virtual Private Servers item under the corresponding Hardware Node 
name to display a list of all Virtual Private Servers residing on the Node. 

2 Right-click the VPS from where the drive is to be unmounted and select Tasks --> Manage 
Mounts on the context menu. 

Alternatively, you can open the Virtual Private Server Manager window for the given VPS 
and click on the Manage Mounts link in the Actions section of the VZMC view pane. 

3 In the Mount Points Manager window, you can see all the drives currently available inside 
the VPS: 

 

Figure 89: VZMC - Removing Hardware Node Drive 

Select the drive you wish to unmount from your VPS and click on the Remove From List 
button. 

4 In the opened window, click Yes to confirm your decision. 

In the command line, you can use the vzctl mountext and vzctl umountext 
commands to mount/unmount your Hardware Node drives to drives inside a VPS. Detailed 
information on this command is provided in the Reference chapter. 
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Managing Image Files 
Another possibility to use external files located on the Hardware Node from inside a VPS is to 
mount an image file located on the Node to a drive letter inside the VPS. Image files can be 
located anywhere on the Hardware Node (on your hard disk, CD-ROM drive, floppy drive, etc.) 
and should have either the .efd or .iso extensions. 

To mount a Hardware Node image file to a drive letter inside your VPS, you should perform the 
following operations: 

1 In VZMC, click the Virtual Private Servers item under the corresponding Hardware Node 
name to display a list of all Virtual Private Servers residing on the Node. 

2 Right-click the VPS where you wish to mount an image file from the Hardware Node and 
select Tasks --> Manage Mounts on the context menu. 

Alternatively, you can open the Virtual Private Server Manager window for the given VPS 
and click on the Manage Mounts link in the Actions section of the VZMC view pane. 

3 In the opened window, click on the Add button to display the Mount Point window: 

 

Figure 90: VZMC - Mounting Hardware Node Drive 

In this window, you should do the following: 

 In the Mount point list, click the drop-down arrow and select a letter under which the 
mounted image file will be accessible inside the Virtual Private Server. 

 Check the Mount existing image file radio button and do one of the following: 

a Type the full path to the image file on the Node by hand or 

b Use the ... button to specify the path to the image file. 
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Note: The permissions of the image file mounted to a VPS correspond to those of this image 
file on the Hardware Node, i.e. you are able to perform the same operations on the file inside the 
VPS as you are allowed on the Node. 

At any time, you can unmount the mounted image from your Virtual Private Server. To this 
effect, do the following: 

1 In VZMC, click the Virtual Private Servers item under the corresponding Hardware Node 
name to display a list of all Virtual Private Servers residing on the Node. 

2 Right-click the VPS from where your image is to be unmounted and select Tasks --> Manage 
Mounts on the context menu. 

Alternatively, you can open the Virtual Private Server Manager window for the given VPS 
and click on the Manage Mounts link in the Actions section of the VZMC view pane. 

3 In the Mount Points Manager window, select the image you wish to unmount from your VPS 
and click on the Remove From List button. 

4 In the displayed window, click Yes to confirm your decision. 
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Changing VPS Network Adapter 
In case there are several network interface cards (or network interface adapters) installed on the 
Hardware Node, Virtuozzo allows you to specify the preferred network adapter for a Virtual 
Private Server. Specifying the preferred adapter for a VPS means that this network adapter will 
be used to connect the VPS to the network and, therefore, to handle the whole network traffic 
for this VPS. 

Please see the following picture: 

 

Figure 91: Hardware Node With Several Adapters 

The picture presumes that the Hardware Node has two network interface cards (depicted as NIC 
1 and NIC 2) installed. The network adapters are playing the following roles: 

 NIC 1 controls all the network flows of VPS 1; 
 NIC 2  controls all the network flows of VPS 3, and 
 both network adapters NIC 1 and NIC 2 handle network traffic for VPS 2. 

All three of the VPSs use the Virtuozzo Network Adapter to exchange the traffic among 
themselves and to receive data to/from other networks. However, in the latter case all IP packets 
from/to the Virtual Private Servers come first to the Virtuozzo Network Adapter and are then 
redirected to different network interface cards on the Hardware Node thru which the VPSs 
communicate with the outer world: VPS 1 thru NIC 1, VPS 3 thru NIC 2, and VPS 2 thru both 
NIC 1 and NIC 2. This may have the following consequences: 
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 Although all the VPSs can easily communicate with each other by using the Virtuozzo 
Network Adapter, VPS 1 may have no access to the computers on other networks that can be 
accessed by VPS 3, and vice versa. This is caused by the fact that NIC 1 and NIC 2 (used to 
control network flows of VPS 1 and VPS 3, respectively) may be connected to different 
networks and, therefore, provide access for VPS 1 and VPS 3 to different networks. 

 VPS 2 have access to all the computers on other networks that can be accessed by both VPS 
1 and VPS 3. This is explained by the fact that VPS 2 use both network adapters (NIC 1 and 
NIC 2) to communicate with the outer world. 

Every network interface card installed on the Hardware Node is identified by its unique Media 
Access Control (MAC) address assigned to it. So, to set a preferred adapter for a particular 
Virtual Private Server on the Node, you should associate the adapter MAC address with this 
VPS. 
 

Setting Default Network Adapter for VPSs 
To set one or several default network adapters for all Virtual Private Servers residing on your 
Node, you should do the following: 

1 Right-click the Virtual Private Servers item under the corresponding Hardware Node name in 
the VZMC left pane and select Tasks --> Set Default Network Interfaces on the context menu: 

 

Figure 92: VZMC - Setting Default Network Adapter for VPS 

In this window, you can see all network adapters currently available on the Node. The active 
adapters are marked with the green tick and the inactive ones are indicated with the red 
criss-cross. 

2 Select one or more network adapters that you wish to use for handling the network traffic 
for all Virtual Private Servers residing on the Hardware Node and click on the Enable button 
if the selected adapters are disabled. If necessary, disable all the other network adapters. 

Note: If you have only one network adapter installed on the Node, this adapter should 
always be enabled; otherwise, your VPSs will be inaccessible from other networks. 

3 Click OK. 
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In the command line, you can use the vzctl set command and pass the --
preferred_adapter parameter to it to set one or several network interface adapters for the 
given VPS. Detailed information on the vzctl set command and all its options is provided 
in the Reference chapter. 

Note: After the Virtuozzo installation, all active adapters on the Hardware Node are used to 
control network traffic for all VPSs residing on the Node. 
 

Changing VPS Network Adapter 
You may also wish to change the network adapter used to handle all network traffic for the 
given Virtual Private Servers. To this effect, you should perform the following operations in 
VZMC: 

1 Click the Virtual Private Servers item under the corresponding Hardware Node name in the 
VZMC left pane. 

2 Right-click the Virtual Private Server to which you wish to assign another network adapter 
and select Properties on the context menu. 

3 In the displayed window, go to the Network tab: 

 

Figure 93: VZMC - Changing Network Adapter for VPS 

All network adapters currently available on the Hardware Node are listed in the table at the 
bottom of the displayed window. By default, all network adapters available on the Node and 
listed in the table are used to control network flows of the given VPS. 
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4 Clear the Use system default checkbox, select the adapter(s) you do not wish to use for the 
VPS, and click on the Disable button. 

Note: If you disable all the network adapters for the Virtual Private Server, the network 
adapters of VPS 0 (i.e. of the Node itself) will be used to control network flows for the 
corresponding VPS. If there is no adapter set for VPS 0, then all the adapters currently 
active on the Node will handle the VPS network traffic. 

5 Click OK. 
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Configuring VZAgent 
VZAgent is the managing protocol and server-side software for Virtuozzo. Basically, it is 
supposed to be the Hardware Node control interface and should be used for tuning, monitoring, 
and managing the Hardware Node itself and all the VPSs residing on it. VZAgent was created in 
order to unify the way the client software accesses the Hardware Node, to provide an easy and 
standard means of using Virtuozzo services, and to limit the impact on HN resources caused by 
an excessive number of clients connecting to it and using it at one and the same time, while 
allowing them to share the collected information instead of repeatedly fetching it. 

VZAgent provides a great number of different services. Among them are the following: 

 VPS management: VPS creation, starting, stopping, migrating, cloning, moving, mounting, 
unmounting, getting information on current VPS statistics and resource usage. 

 Hardware Node management: fetching lists of existing VPSs, Virtuozzo logs, Hardware 
Node characteristics such as disk, network, and other system information, editing sample 
and global Virtuozzo configuration files, etc. 

Note: Detailed information on all VZAgent functionality is provided in the VZAgent Developer's 
Guide shipped with Virtuozzo. 

VZMC allows you to adjust VZAgent configuration by changing some of its keys, subkeys, and 
parameters in the following way: 

 Loading the configuration from a local file that you might have previously saved; 
 Saving the current configuration to a local file; 
 Reloading the VZAgent configuration from the Service VPS to VZMC; 
 Adding a key with a specified name to the same level as the currently selected key; 
 Adding a subkey with a specified name under the key currently selected; 
 Adding a parameter with a specified name and value to the subkey currently selected; 
 Modifying the name of the selected subkey or the name and the value of the selected 

parameter; 
 Deleting the selected key/parameter; 
 Cutting the selected key/parameter to the clipboard; 
 Copying the selected key/parameter to the clipboard; 
 Pasting the selected key/parameter from the clipboard to the key currently selected; 
 Creating a copy of the selected key/parameter on the same level; 
 Expanding all the configuration keys/subkeys; 
 Collapsing all the configuration keys/subkeys. 

To perform these operations, right-click the corresponding Hardware Node and select Tasks -> 
Manage VZAgent Configuration on the context menu (all operations listed above correspond to 
the icons on the toolbar from left to right). After you have made corrections, click the Apply 
button for the changes to take effect with VZAgent. 
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To get more information on what key, subkey, or parameter to change to achieve this or that 
goal and how to change them, please consult the Appendix B Configuration chapter of the 
VZAgent Developer's Guide where each option is described in detail. 
 

Viewing Global Virtuozzo 
Parameters 

VZMC allows you to view and configure various settings configured for the Virtuozzo system 
on your Hardware Node. Below is the description of all the parameters defined in this version of 
Virtuozzo: 

Parameters Description 
actionlogdir This is the directory where Virtuozzo keeps a log of its actions. 

controlpanel_port This port must be entered in the address line of an Internet 
browser after the VPS IP address when managing the VPS by 
means of Virtuozzo Power Panels or Virtuozzo Control Center. 

install This is the directory where Virtuozzo files are installed. 

offline_management Specifies whether the VPS can be directly managed by its root 
from any browser at its own IP address. 

template This is the directory where all Virtuozzo templates installed on 
the Hardware Node are located. 

ve_private This is a path to the VPS private area, where VZFS keeps its 
private data.  

ve_root This is a path to the VPS root directory where the VPS private 
area is located. 

vz_root This is a path to the directory where all the data used by Virtual 
Private Servers are stored: private areas, installed templates, 
patches, logs, etc. 
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To view any of the aforementioned parameters in VZMC, select the Configuration item in the 
VZMC left pane and double-click the corresponding parameter in the right pane: 

 

Figure 94: VZMC - Viewing Global Virtuozzo Parameters 
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This chapter provides the information about those problems that may occur during your work 
with Virtuozzo and suggests the ways to solve them, including getting technical support from 
SWsoft. 

In This Chapter 
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Establishing Secure Channel to SWsoft Support .................................................................. 211 
 
 

General Considerations 
The general issues to take into consideration when troubleshooting your Virtuozzo system are 
listed below. You should read them carefully before trying to solve more specific problems. 

 Make sure a valid license is always loaded on the Hardware Node. If your license has 
expired and the grace period is over, all the VPSs on your Node (except the Service VPS) 
will be stopped! 

 Check that the directory where the Windows Server 2003 OS is installed is C:\WINDOWS. 
Otherwise, you might have problems with running Virtuozzo on your computer. 

 If a Hardware Node is experiencing slow performance, you can launch Virtuozzo 
Management Console and select the Services and Monitor --> Processes items in the VZMC 
main window to find out what process or service might affect your system performance. In 
case of discovering any, you can terminate the problem process/service. Anyway, try to 
investigate what reason may have brought about the problem before resorting to the last 
means - rebooting the Node. 

 Please do not install and run Microsoft Terminal Server inside Virtual Private Servers. You 
are able to open terminal sessions with VPSs thanks to the MS Terminal Server installed on 
the Host OS. Terminal Server installed inside a VPS is completely irrelevant and may 
interfere with normal VPS operation. By default, you are allowed to have only 2 (two) 
RDP/MS TSC sessions per Hardware Node opened at the same time. If you wish to be able 
to open more RDP/MS TSC sessions at once, you should install additional TSAL (Terminal 
Service Access License) licenses on the Hardware Node. 

 Run Virtuozzo Updater at regular intervals (at least once a week). Along with the Virtuozzo 
updates, this will allow you to automatically download and install the latest Windows Server 
2003 updates on your Hardware Node. Please do not try to update the Windows Server 2003 
OS manually. It may cause Virtuozzo to malfunction. 

 

C H A P T E R  1 1  

Troubleshooting 



 

 Troubleshooting 206 
 

Problems With VPS Management 
This section includes recommendations on how to settle some problems with your VPSs. 
 

Failure to Start VPS 
An attempt to start a Virtual Private Server fails. 

Solution 1 

Make sure you have assigned at least one IP address to the VPS. If you have not, please do it. 
To assign an IP address in VZMC, select the Virtual Private Servers item in the VZMC left pane, 
right-click the problem VPS in the right pane, and choose Properties on the context menu. On 
the Network tab of the displayed window, click the Add IP Address button and specify a valid IP 
address. You can also use the vzctl set --ipadd command to add a new IP address to the 
VPS. 

Solution 2 

Check if the IP address assigned to the problem VPS is not already in use. You can view all IP 
addresses of the existing Virtual Private Servers by selecting the Virtual Private Servers item in 
the VZMC left pane and examining the IP address column in the right pane or by issuing the 
vzlist -a command in the command line. If the IP address of the problem VPS coincides 
with that of another VPS, please remove it and specify a new valid IP address, as is shown 
above. 
 

Failure to Access VPS From Network 
Solution 1 

The IP address assigned to this Virtual Private Server might be already in use in your network. 
Make sure it is not. Otherwise, please replace the existing IP address with another one, as is 
described in the previous subsection. 

Solution 2 

Make sure the routing to the Virtual Private Server is properly configured. Virtual Private 
Servers can use the default router for your network, or you may configure the Hardware Node 
as rooter for its VPSs. 
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Failure to Log In to VPS 
The Virtual Private Server starts successfully, but you cannot log in. 

Solution 1 

You are trying to connect via RDP or MS TSC, but access is denied. Probably you have not set 
the password of the Administrator user yet. Detailed information on how to set the 
Administrative password is provided in the Setting Administrator Password section (on page 71). 

Solution 2 

While connecting to the VPS via RDP or MS TSC, you have got the following message: The 
terminal server has exceeded the maximum amount of allowed 
connections. Make sure you have no more than 2 (two) RDP/MS TSC sessions per 
Hardware Node opened at the same time. If it is the case, you should close one of your opened 
sessions or install additional TSAL (Terminal Service Access License) licenses on the Hardware 
Node to be able to connect to the VPS. 

Solution 3 

You are trying to connect to the VPS by means of VZCC/VZPP, but the corresponding page 
cannot be displayed by your browser. Make sure the offline management is enabled for the 
given VPS. To this effect, select the Virtual Private Servers item in the VZMC left pane, right-
click the problem VPS in the right pane, and choose Properties on the context menu. On the 
General tab of the displayed window, ascertain that the Enable offline management checkbox is 
selected. If it is not, select it and press OK. 
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Failure to Manage VPSs in PAE-disabled System 
You created a multitude of Virtual Private Servers on the Hardware Node. However, after a 
while, they became non-operational. For example, you cannot execute the vzctl enter 
VPS_ID command (where VPS_ID denotes the VPS the command refers to), run any 
application inside your VPS, or may get error messages with code 128 returned (an unspecified 
error) when performing VPS-related operations. 

The problem might be caused by the fact that your VPSs and their applications have reached the 
4-gigabyte paging file limit. By default, Hardware Nodes running the 32-bit editions of 
Windows Server 2003, Standard or Enterprise Edition, support only 32-bit memory addressing 
and thus set the limit on paging files to 4 GB. When the 4-gigabyte limit is reached, which is 
most likely the case when running tens of VPSs or performance-intensive applications in them, 
you may start experiencing performance problems or even get your VPSs in an non-operational 
state. 

Note: This problem does not concern PAE(Physical Addressing Extensions)-enabled operating 
systems allowing paging files up to several terabytes. PAE is automatically enabled when you 
have more than 4 GB of physical memory installed on your system, or you can enable PAE 
manually as is described below in Solution 2. 

To be sure the problem is caused by reaching the paging file limit, you can check the size of the 
pagefile.sys file located in the C:\ directory on your Node. By default, the 
pagefile.sys file is hidden. To view this file, do the following: 

1 Click on the Tools menu in any folder window and select Folder Options on the drop-down 
menu. 

2 On the View tab of the displayed window, under Advanced settings, clear the Hide protected 
operating system files checkbox. 

3 Click OK. 

Alternatively, you can open Windows Task Manager, click on the Performance tab, and view 
the paging file size in the PF Usage window. 

Note: The size shown in the PF Usage window may not correspond to the size of the 
pagefile.sys file because the former contains information on both the paging file itself and 
the paged memory (the memory that can be moved to your hard drive) in RAM, whereas the 
latter displays the size of the paging file only. 

If your computer is running near the maximum of the paging file limit, i.e. coming very close to 
4 GB, you can take the following measures: 

Solution 1 

If your Hardware Node has several drives, you can create a paging file for every drive on the 
Node. You can also create several paging files on a single drive by placing them in separate 
folders. In the example below, we show you how to create multiple paging files in case your 
Node has only one drive: 

1 On the drive, create as many folders as the number of paging files you wish to be created 
(e.g. C:\Pagefile1, C:\Pagefile2). 
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2 Select Start --> Run and execute the regedit command to open Registry Editor. 

3 Locate the 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\SessionMa
nager\MemoryManagement key. 

4 In the right pane of the Registry Editor window, double-click the PagingFiles value to 
open it for editing. 

5 Remove any existing value and add the following values: 

 C:\pagefile1\pagefile.sys 3000 4000 

 C:\pagefile2\pagefile.sys 3000 4000 

where 3000 and 4000 denote the initial size of the extra paging files and their maximum 
size, respectively. The size is measured in megabytes. 

6 Click OK. 

7 Restart your Node for the changes to take effect. 

Solution 2 

Enable Physical Addressing Extensions (PAE) allowing your Host OS and applications access 
to the additional physical memory (up to several terabytes). To this effect, you should perform 
the following operations: 

1 Select Start --> Run. 

2 Type X:\boot.ini where X is the drive letter where your boot files are located. 

3 Modify the line that corresponds to your Host OS by appending the /PAE switch to it. 

4 Save the file and then restart the computer. 

Solution 3 

Find out what process or service might affect your system performance, i.e. consumes a large 
amount of memory (for example, by selecting the Services and Monitor --> Processes items in 
the VZMC main window). In case of discovering any, you can terminate (or kill) the problem 
process/service by sending the corresponding signal to it. This will free memory for other 
processes running in your system. 
 

Failure to Run Sound Files in VPS 
You have successfully connected to a Virtual Private Server thru RDP. However, you cannot 
play any sound file inside this VPS. 

Solution 

To be able to run sound files in a VPS, you should perform the following operations: 

Note: If you have any open RDP session, please close it before completing the tasks below. 

1 On the Hardware Node, choose Programs --> Administrative Tools --> Terminal Services 
Configuration on the Windows Start menu. 
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2 In the Terminal Services Configuration window, double-click the RDP-Tcp connection in the 
right part of the screen. 

3 On the Client Settings tab of the RDP-Tcp Properties window, clear the Audio mapping 
checkbox. 

4 Press the Apply button. 

5 Now start the Remote Desktop Connection client by choosing Programs --> Accessories --> 
Communications --> Remote Desktop Connection on the Windows Start menu or by selecting 
Start --> Run and executing the mstsc command. 

6 Click on the Options button to expand the Remote Desktop Connection window. 

7 On the Local Resources tab under the Remote computer sound group, select the Bring to this 
computer option on the drop-down menu. 

8 On the General tab of the Remote Desktop Connection window, specify the IP address of the 
Virtual Private Server you wish to connect to and press the Connect button. 

 

Failure to See Mounted Drives Inside VPS 
You have mounted a drive from the Hardware Node to a directory inside your Virtual Private 
Server. However, the mounted drive is not displayed among other drives in My Computer. 

Solution 1 

Inside your VPS, open My Computer by double-clicking the My Computer icon on the desktop 
and type the path to the mounted drive in the address line of Windows Explorer. For example, if 
you mounted the CD-ROM from the Hardware Node, you should specify C:\CDROM in the 
address line and press Enter to display the CD-ROM content. 

Solution 2 

Close your current terminal session and then log in to your VPS anew. Open My Computer by 
double-clicking the My Computer icon on the desktop. Now your mounted drive will be shown 
in the My Computer folder and can be accessed by double-clicking on its name. 
 

Submitting Problem Report to 
Technical Support 

In most cases, the SWsoft support team must rely on the customer's observations and 
communications with the customer in order to diagnose and solve the problem. Therefore, a 
detailed problem report is extremely important. The Submit Support Issue wizard helps you 
draw up such a report and automatically send it to the SWsoft support team. To invoke the 
wizard, select Programs --> SWsoft --> Virtuozzo --> Submit Support Issue on the Windows Start 
menu. The wizard will guide you thru a number of steps asking you to provide your first name, 
last name, e-mail, and detailed problem description, collecting Virtuozzo logs and information 
on your system network settings into a special zip file, and sending it to the SWsoft technical 
support team. You can also find the generated zip file in the X:\vz\Reports\ directory 
(where X:\vz\ is the path you specified for storing all VPS data while installing Virtuozzo) 
and send it manually later to vzwin-support@swsoft.com. 
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Establishing Secure Channel to 
SWsoft Support 

Virtuozzo provides you with a special tool - Virtuozzo Support Tunnel - which allows you to 
establish a private secure channel to the SWsoft support team server. After establishing such a 
channel, the support team will be able to quickly and securely connect to your Node and 
diagnose and solve your problem. The secure connection to your computer is achieved thru a 
Virtual Private Network (VPN) created between the SWsoft support team server and your 
Hardware Node. 

To start using the Virtuozzo Support Tunnel tool, you should first ask SWsoft for a special 
certificate which will uniquely identify you as a Virtuozzo user. Certificates are issued by 
SWsoft in the form of files and should be copied to the C:\Program 
Files\SWsoft\Virtuozzo\Licenses folder on your Node. 

After you have received a certificate and copied it to the right folder on the Node and in case 
you encountered a Virtuozzo-related problem, you can do the following to get assistance from 
the SWsoft support: 

1 Make sure that your Hardware Node is connected to the Internet. 

2 On the Node, select Programs --> SWsoft --> Virtuozzo --> Virtuozzo Support Tunnel on the 
Windows Start menu to establish a VPN between your Node and the SWsoft support server. 

3 Contact the SWsoft support team (by telephone or via e-mail) and inform them of the 
problem you encountered. You should also mention that you have launched the Virtuozzo 
Support Tunnel tool and established a VPN to the SWsoft support server. 

4 After that, the SWsoft support team will closely examine your problem, connect to your 
Node by using the secure VPN established, if needed, and make its best to solve your 
problem as quickly as possible. 

 



 

 212 
 

In This Chapter 
Configuring VPSs ................................................................................................................. 212 
Adding Custom Action Scripts ............................................................................................. 214 
Virtuozzo Command Line Interface...................................................................................... 217 
 
 

Configuring VPSs 
Each Virtual Private Server has its own configuration file, which is stored in the 
X:\vz\Conf\ directory and has a name of VPS_ID.conf. The parameters in the 
X:\vz\Conf\<VPS_ID>.conf file are presented in the form of the 
PARAMETER="value" pattern. The main parameters defining the VPS configuration can be 
subdivided into the following categories: miscellaneous, resource management, and networking 
parameters. 

Note: During the Virtuozzo installation, the Conf subdirectory is automatically created in the 
directory you specified for storing all VPS configuration files. By default, the C:\vz\ 
directory is used. However, you might have defined another path for this directory. 

Miscellaneous parameters: 

Parameter Description Default value 
VzPrivate The path to the VPS private area. You specify 

the location of the VPS private area by passing 
the --private path argument  to the 
vzctl create command. This parameter is 
omitted if the VPS private area is located in the 
C:\vz\private\ directory. 

C:\vz\private\ 

GUID The pseudo-random number used to uniquely 
identify the Virtual Private Server. GUIDs 
(Globally Unique Identifiers) are written using a 
four-byte word, 3 two-byte words, and a six-byte 
word, such as: 

{3F2504E0-4F89-11D3-9A0C-
0305E82C3301} 

 

    - 

Autoboot Specifies whether the VPS should be started 
automatically on system startup. Virtuozzo 
automatically starts all Virtual Private Servers 
that have this value set to “1”. 

 

    1 
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OfflineMgmt Specifies whether the VPS can be managed by 
the VPS administrator using the offline services 
indicated in the OfflineServices 
parameter in this file provided the 
OfflineMgmt parameter in the 
C:\vz\Conf\0.conf file is set to "1". 

 

    1 

OfflineServices Overrides the OfflineServices parameter 
from the C:\vz\Conf\0.conf file. The 
services enumerated in this parameter can be 
used by the VPS administrator for managing 
Virtual Private Servers, if the OfflineMgmt 
parameter in the C:\vz\Conf\0.conf file is 
set to "1". 

 

    - 

TEMPLATE This is the name of the OS template the VPS is 
based upon. 

    w2k3 

TEMPLATES Provides a list of application templates. You are 
not recommended to modify this parameter since 
it is used to track the history of the added 
templates. This parameter is omitted if no 
templates have been added to the VPS. 

 

    - 

WindowsDir The path to the folder where the Windows 
Server 2003 system files for the given Virtual 
Private Server are located. In the current version 
of Virtuozzo, you cannot change the default path 
set during the VPS creation. 

   C:\WINDOWS 

Resource management parameters control the amount of resources a VPS can consume. All 
resources are described in the Managing Resources chapter (on page 95) in detail; here is only a 
list of parameters that can be found in the C:\vz\Conf\<VPS_ID>.conf file: 

Parameter Description 
DiskQuota The total size of disk space that can be consumed by the Virtual Private 

Server, in 1-Kb blocks. 

CpuUnits The positive integer number that defines how much CPU time one Virtual 
Private Server will receive in comparison with the other VPSs on the 
Hardware Node in case all the CPUs of the Node are fully used. 

ProcessCountLi
mit 

The maximal number of processes the VPS may create. Upon hitting this 
limit, the VPS will not be able to start a new process or thread. 

SessionCountLi
mit 

The number of terminal sessions. This parameter is used to limit the number 
of simultaneous terminal sessions, i.e. the number of users that are allowed to 
connect to the VPS at the same time thru MS TSC, RDP, etc. 

CommittedMemor
yLimit 

The size of private (or potentially private) memory that can be allocated by 
the VPS, in bytes. The memory that is always shared among different 
applications is not included in this resource parameter. 

NetAllowBroadc
asts 

Setting this parameter to "1" enables the network browsing for the VPS. The 
network browsing, if enabled, allows the VPS administrator to view all the 
network servers and file sharing resources available on the Microsoft 
Windows network. By default, the network browsing is disabled. You can 
enable this feature for all VPSs on your Node at once by setting this 
parameter to "1" in the C:\vz\Conf\0.conf file. 
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NetQoSPacketSc
heduler 

Setting this parameter to "1" enables the Windows QoS packet scheduler for 
the VPS. The QoS packet scheduler is used to regulate how much traffic an 
application inside your VPS is allowed, thus enforcing the QoS parameters 
originally set for a particular application. By default, the QoS packet 
scheduler is disabled. 

Note: In case you have enabled the QoS packet scheduler for a 
running Virtual Private Server, you should restart this VPS for the 
changes to take effect. 

Network-related parameters allow you to set a hostname, an IP address, and a network mask for 
the given VPS: 

Parameter Description 
Hostname Specifies the hostname of the VPS. 

IP Sets an IP address for the VPS. Several IP addresses per VPS are allowed; in 
this case they should be divided by the semicolon and a space. 

IPMASK The network mask of the VPS. It should be the same for all the VPSs located 
on a specific physical network segment. 

 
 

Adding Custom Action Scripts 
Virtuozzo allows you to write and execute your own scripts on the Hardware Node to do 
additional actions when certain VPS-related operations are performed. There are two kinds of 
scripts you can specify for execution on the Node or in the VPS context: 

 Preoperation scripts. These scripts are executed before some action is performed. They 
should be specified in the form of the vz-pre<action_name>.<ext> pattern, where 
<action_name> denotes the name of the operation to be performed (e.g. start), and 
<ext> is the extension of the file containing the script. Currently, the files with the .exe, 
.cmd, .bat, .vbs extensions are supported. 

 Postoperation scripts. These scripts are executed after some action has been successfully 
completed. They should be specified in the form of the vz-
post<action_name>.<ext> pattern where <action_name> denotes the name of 
the operation to be performed (e.g. stop), and <ext> is the extension of the file 
containing the script. Currently, the files with the .exe, .cmd, .bat, .vbs extensions are 
supported. 

The names of all possible scripts that may be specified for executing before or after performing 
an operation are listed in the table below: 

Script Name Description 
vz-precreate.<ext> This script is to be run before the VPS creation. 

vz-postcreate.<ext> This script is to be run after the VPS creation. 

vz-premount.<ext> This script is to be run before mounting the VPS private area. 

vz-postmount.<ext> This script is to be run after mounting the VPS private area. 

vz-preunmount.<ext> This script is to be run before unmounting the VPS private area. 
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vz-postmount.<ext> This script is to be run after unmounting the VPS private area. 

vz-prestart.<ext> This script is to be run before the VPS start.  

vz-poststart.<ext> This script is to be run after the VPS start. 

vz-prestop.<ext> This script is to be run before stopping the VPS. 

vz-poststop.<ext> This script is to be run after stopping the VPS. 

vz-preclone.<ext> This script is to be run before copying the VPS. 

vz-postclone.<ext> This script is to be run after copying the VPS. 

vz-prechangevpsid.<ext> This script is to be run before changing the VPS ID. 

vz-postchangevpsid.<ext> This script is to be run after changing the VPS ID. 
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Note: All the scripts are executed in the Host OS context. 

You may specify scripts that will be applied to all Virtual Private Servers residing on the 
Hardware Node. To this effect, you should place your script to the C:\vz\Scripts\. In its 
turn, locating a script to the C:\vz\private\VPS_ID\scripts\ directory allows you to 
set this script for executing in the given VPS only (per-VPS script). In the latter case, you may 
need to create the C:\vz\private\VPS_ID\scripts\ directory manually since it is not 
created by creating a Virtual Private Server. When executed, any script takes only one 
parameter - the ID of the corresponding VPS. 

Note: During the Virtuozzo installation, the Scripts subdirectory is automatically created in 
the directory you specified for storing all VPS configuration files. By default, the C:\vz\ 
directory is used. However, you might have defined another path for the directory. 

Let us assume you have created Virtual Private Server 101 with the private area located in the 
C:\vz\Private\101\ directory. And now you wish to write a script that will be executed 
each time after the VPS start and display the number of events currently recorded in the VPS 
System event log. To this effect, you should open Notepad or another text editor and write the 
following script code: 
strComputer = "." 
Set objWMIService = GetObject("winmgmts:" _ 
    & "{impersonationLevel=impersonate}!\\" & strComputer & 
"\root\cimv2") 
Set colLogFiles = objWMIService.ExecQuery _ 
    ("Select * from Win32_NTEventLogFile where LogFileName='System'") 
For Each objLogFile in colLogFiles 
    Wscript.Echo objLogFile.NumberOfRecords 
Next 

After that, you should save the file with the vz-poststart.vbs name, create the scripts 
subdirectory in the C:\vz\Private\101\ directory, and place your script to this 
subdirectory. Make sure that the full path of the script is 
C:\vz\Private\101\scripts\vz-poststart.vbs. From this point on, the  vz-
poststart.vbs script will be executed every time you start VPS 101. 

Note: By default, Virtuozzo is shipped with the vz-poststart.cmd script located in the 
C:\vz\Scripts\ directory. This script is needed for all Virtual Private Servers residing on 
the Hardware Node to perform certain operations necessary for VPS error-free functioning. 
However, specifying your own per-VPS scripts (i.e. scripts in the 
C:\vz\private\VPS_ID\scripts\ directory) prevents the vz-poststart.cmd 
script from running. Therefore, you should make sure that each of your per-VPS scripts calls the 
C:\vz\Scripts\vz-poststart.cmd script. 
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Virtuozzo Command Line Interface 
This section documents the utilities supported in the current version of Virtuozzo for Windows. 
For every utility, all available command-line options are described. 

All the Virtuozzo utilities are supposed to be run on the Hardware Node by using the cmd.exe 
command interpreter, which can be opened by selecting Start --> Run and executing the cmd 
command. There are a number of regulations which should be observed while working in the 
command prompt window. One of such rules would be to enclose in quote marks any parameter 
consisting of two or more words (e.g. "C:\Program Files"). Please consult the Microsoft 
Command-line reference 
(http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-
us/ntcmds.mspx) to learn the rules of working in the command prompt window. 

The Virtuozzo command-line utilities can be subdivided into the following categories: general 
utilities, licensing utilities, VPS migration utilities, VPS backup utilities, template management 
utilities, and supplementary utilities. 

General utilities are intended for performing day-to-day maintenance tasks: 

vzctl Utility to control Virtual Private Servers. 

vzlist Utility to view a list of VPSs existing on the Node with additional information. 

vzquota Utility to control Virtuozzo disk quotas. 

Licensing utilities allow loading new license files and viewing the state of the license: 

vzlicview Utility to show the Virtuozzo license status and parameters. 

vzlicload Virtuozzo license loader. 

VPS migration utilities allow to migrate Virtual Private Servers between Hardware Nodes or 
within one Hardware Node: 

vzmigrate Utility for migrating VPSs to another Hardware Node. 

vzmlocal Utility for the local cloning or moving of the Virtual Private Servers. 

VPS backup utilities allow to back up and restore the VPS private areas, configuration files, and 
quota information: 

vzexport Utility to back up Virtual Private Servers and to store them on the Hardware Node 
where these VPSs are residing. 

vzimport Utility to restore Virtual Private Servers backed up by using the vzexport 
utility. 

vzbackup Utility to back up Virtual Private Servers and to store them either on a local Node 
or a special Backup Node. 

vzrestore Utility to restore Virtual Private Servers backed up by using the vzbackup 
utility. 

Template management utilities allow template creation, maintenance, and installation of 
applications into a VPS: 

vzpkgls Utility to get a list of templates available on the Hardware Node and in VPSs. 

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/ntcmds.mspx
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/ntcmds.mspx
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vzpkgdeploy Utility to deploy and install OS and application templates on the Hardware Node. 

vzpkgadd Utility to add a new template to a VPS. 

Supplementary utilities perform a number of tasks and are used by other Virtuozzo utilities: 

vzsveinstall Utility to create the Service VPS on the Hardware Node. 

vzkeygen Utility to show the Hardware Node ID. 

vzcache Utility to cache common files across Virtual Private Servers. 

vzlscache Utility to list the directories created by vzcache. 

vzuncache Utility to detach a Virtual Private Server from its cache and copy the cached files 
back to the VPS private area. 

 
 

vzctl 
vzctl is the primary tool for Virtual Private Server management. To use it, you have to log in 
to the Hardware Node as the administrator. The syntax of vzctl is: 
vzctl [--quite | --verbose] command VPS_ID 
vzctl --version 
vzctl --help 

Where command can be one of the following: 

create Used to create Virtual Private Servers. 

destroy Used to destroy a Virtual Private Server. 

mount Used to mount the VPS private area. 

unmount Used to unmount the VPS private area. 

start Starts a Virtual Private Server. 

stop Stops a Virtual Private Server. 

restart Restarts a Virtual Private Server. 

status Displays a Virtual Private Server status. 

set Used to set Virtual Private Server parameters, including resource control settings, 
the VPS private area location, its hostname, IP addresses, etc. 

enter Provides a way for hardware node administrator to “enter” a Virtual Private Server 
without knowing VPS root password. Use this command with caution and never run 
it on un-trusted Virtual Private Servers. 

exec, exec2 These two commands allows running arbitrary commands inside a VPS without 
logging in to the corresponding VPS. The difference between two is the returned 
status. 

mountext Used to mount folders and drives of the Hardware Node to a Virtual Private Server. 

umountext Used to unmount external folders and drives of the Hardware Node from a Virtual 
Private Server. 

partadd Used to create a new VPS drive by mounting it to a loopback file on the Hardware 
Node. 

partdel Used to unmount the VPS drive mounted by means of the vzctl partadd 
command from a file on the Hardware Node. 
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Verbosity options can be used with any of the above commands and they are: 

--quiet Disables logging to the display and to the log file. 

--verbose Sets the log level to the maximum possible value for this vzctl session. 

You can also pass to vzctl one of the following options: 

--version Displays the Virtuozzo version currently installed on the Hardware Node. 

--help Displays the usage information on vzctl. 
 
 

vzctl create 

This command is used to create a new Virtual Private Server. It has the following syntax: 
vzctl create VPSID --pkgset name [--ipadd ip_address]  
[--hostname hostname] [--config filename] [--private path] 

With this command, you can create regular VPSs. A Virtual Private Server ID is required for 
this command and shall be unique within a Hardware Node. 

Note: Virtual Private Server IDs from 1 to 100 are reserved for internal Virtuozzo needs. Do not 
use IDs from 1 to 100 for your Virtual Private Servers. 

Command arguments are as follows: 

Name  Description 
--pkgset name Mandatory. Specified when creating a regular Virtual Private Server. 

Denotes the OS template to use when creating the Virtual Private 
Server. 

--ipadd ip_address Optional. Adds IP address to the list of IP addresses the Virtual 
Private Server can use and brings up network interface with this 
address inside the VPS.  

--hostname hostname Optional. Sets the hostname to the specified name. 

--config filename Optional. If this option is given, vzctl copies the values from the 
sample VPS configuration file located in C:\Program 
Files\SWSoft\Virtuozzo\Configs and having the name in 
the form of ve-<name>.conf-sample. The sample 
configuration files usually have a number of resource control limits 
for the VPS and some application templates to be added to the VPS 
immediately upon its creation. If you skip this option, you will have 
to set resource control parameters for the VPS by using the vzctl 
set command before you are able to start the VPS. The application 
templates will have to be also added manually. 
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--private path Optional. Specifies the location of the VPS private area. The VPS 
private area can be placed anywhere on your hard disk. For example, 
you may specify the --private F:\MyPrivateArea argument 
to locate your VPS private area in the MyPrivateArea directory 
on the F:\ volume in case the F:\ volume exists on the hard drive. 
While defining a path for this directory, you should take care of the 
following: 

 This directory cannot be a mount point, i.e. you cannot mount 
external disk partitions to this directory. 

 This directory cannot be a network share, i.e. it cannot be located 
on a computer network drive. 

 The hard disk partition where this directory will be located 
should have no less than 10 Gb of free disk space. 

When creating a new Virtual Private Server, you should specify a unique ID for it. There are no 
restrictions besides uniqueness from the vzctl standpoint. However, it is advisable to assign 
different ID ranges to hardware nodes in multi-node environments. For example, you can use 
IDs from 101 to 2000 on the first node, IDs from 2001 to 4000 on the second one and so on. 
This will help you in tracking down the node where VPS was created and will eliminate 
possibility of VPS IDs conflicts when migrating Virtual Private Servers between Nodes. 
 

vzctl destroy 

The syntax of this command is: 
vzctl destroy <VPSID> 

This command is used to delete a Virtual Private Server, which is no longer needed. It 
physically removes all the files located in VPS private area. This command does not take any 
additional arguments and requires the Virtual Private Server to be stopped and its private area to 
be dismounted. 
 

vzctl mount and vzctl umount 

These commands take no additional arguments: 
vzctl mount  <VPSID> 
vzctl umount <VPSID> 

The first command mounts the VPS private area to the VPS root directory (for example, 
C:\vz\root\<VPS_ID> on the Hardware Node) without starting it and the VPS registry to 
the HKEY_LOCAL_MACHINE\<VPS_ID> key in the registry of the Node. Normally you do 
not have to use this command as the vzctl start command mounts the VPS private area 
and registry automatically. 

The vzctl umount command unmounts the VPS private area and registry. Usually there is 
no need in using this command either, for vzctl stop unmounts the VPS private area and 
registry automatically. 
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vzctl mountext and vzctl umountext 

You may wish to mount a drive or one of the folders on the Hardware Node to a drive or 
directory inside your Virtual Private Server. To this effect, you can use the vzctl mountext 
command. It has the following syntax: 
vzctl mountext VPSID --srcdir path --dstdir path 

The command should be used with the following arguments: 

Name Description 
VPSID The ID of the Virtual Private Server where an external folder/drive from 

the Hardware Node will be mounted.  

--srcdir path The drive/folder inside your Virtual Private Server where a folder/drive 
from the Node will be mounted. You may use any existing directory or 
drive or create a new directory to mount the desired folder/drive. 

--dstdir path The full path to the folder/drive on the Node that is to be mounted inside 
your Virtual Private Server. 

However, before mounting drives and folders from the Hardware Node to any of your Virtual 
Private Servers, you should first make them accessible by executing the vzctl set --
devadd command (see page 222). The session below demonstrates how you can make your 
CD-ROM drive on the Hardware Node available for VPS 101: 
vzctl set 101 --devadd D: 
Command output 
vzctl mountext 101 --srcdir C:\CDROM --dstdir D: 
Command output 

In the example above, we granted VPS 101 access to the D: drive on the Node (assuming this is 
used as the Node CD-ROM drive) and mounted this drive to the C:\CDROM directory inside 
VPS 101. 

You might as well mount the Node CD-ROM drive to a separate drive letter inside the VPS: 
vzctl set 101 --devadd D: 
Command output 
vzctl mountext 101 --srcdir E: --dstdir D: 
Command output 

Note: The permissions of the directory/drive mounted to a VPS correspond to those of this 
directory/drive on the Hardware Node, i.e. you are able to perform the same operations on the 
directory/drive inside the VPS as you are allowed on the Node. 

At any time, you can use the vzctl umountext command to unmount external folders and 
drives of the Hardware Node from a Virtual Private Server. So, if you used the first example for 
mounting the CD-ROM drive, you can issue the following command to unmount it from VPS 
101: 
vzctl umountext 101 --srcdir C:\CDROM 

As can be seen from our example, you should pass the VPSID and --srcdir path 
arguments to the command to identify the Virtual Private Server where the mounted 
directory/drive exists and the directory/drive itself that will be unmounted from this VPS. 
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vzctl start, vzctl stop, vzctl restart, and vzctl status 

These four commands have the same syntax and take no obligatory arguments: 
vzctl start   <VPSID> 
vzctl stop    <VPSID> 
vzctl restart <VPSID> 
vzctl status  <VPSID> 

The first command is used to start a Virtual Private Server. It will set up all network interfaces, 
initialize VPS quota, if needed, etc.  

vzctl stop shuts the Virtual Private Server down.  

The vzctl restart <VPSID> command consecutively performs the stopping and starting 
of the corresponding VPS. 

The vzctl status command shows the current VPS state. It outputs the following 
information: what IP address is assigned to the VPS and whether the VPS is running as in the 
example below: 
C:\Documents and Settings\Administrator> vzctl status 101 
VpsId 101 exist unmounted down 
 

vzctl set 

This command is used for setting VPS parameters. It has the following syntax: 
vzctl set <vpsid> <setting_name> <value> [ --save ] 

An optional –-save switch tells vzctl whether to save changes into the VPS configuration 
file. Practically all VPS settings can be changed dynamically without the necessity of VPS 
reboot. The only exception is the –-onboot option. 

The settings that can be passed to the vzctl set command are subdivided into the following 
categories: miscellaneous, networking, and resource management parameters. 

Miscellaneous settings: 

--onboot yes|no This setting requires the –-save switch. If you set it to 
“yes”, Virtuozzo will automatically start this Virtual 
Private Server on next system startup. 

--userpasswd user:password This setting creates a new user with the specified password 
inside the Virtual Private Server, or changes the password 
of an already existing user. Omitting the user name (e.g. 
:2wse3rd) will change the password for the built-in 
Administrator account inside the VPS, even though it was 
renamed for some reason or other. 

--offline_management yes|no Enabling/disabling the direct managing of the VPS thru a 
common Internet browser by means of Virtuozzo Power 
Panels. To enable/disable the offline management feature 
for the Hardware Node and, therefore, for all VPSs residing 
on it, you should set this parameter for the VPS with ID 0. 

--devadd device This setting allows you to grant access to any 
directory/drive on the Hardware Node from inside a Virtual 
Private Server. 
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--devdel device This setting shuts down access to a directory/drive on the 
Hardware Node granted by means of the --devadd 
setting. 

--showvpsid yes|no If set to yes, the VPS ID string is displayed in the top right 
corner of the VPS desktop helping you identify the ID of 
the VPS you are currently logged in to. If set to no, the 
string is not shown on the VPS desktop. By default, the 
VPS ID string is displayed on the VPS desktop. Please 
keep in mind that you should log off from the VPS and log 
in to it anew for the changes to take effect. 

--showhostname yes|no If set to yes, the VPS hostname string is displayed in the 
top right corner of the VPS desktop helping you identify 
the hostname of the VPS you are currently logged in to. If 
set to no, the string is not shown on the VPS desktop. By 
default, the hostname string is hidden from the VPS 
desktop. Pleas keep in mind that you should log off from 
the VPS and log in to it anew for the changes to take effect. 

Resource management settings control the amount of resources a VPS can consume. 

-p, --numproc number The number of processes allowed to simultaneously run 
inside the VPS. Upon hitting this limit, the VPS will not be 
able to start a new process. 

-t, --numsessions number The number of terminal sessions that can be opened 
simultaneously to the VPS. 

--cpuunits units Allowed CPU power. This is a positive integer number that 
defines how much CPU time one Virtual Private Server 
will receive in comparison with the other VPSs on the 
Hardware Node in case all the CPUs of the Node are fully 
used. 

--diskspace number The total size of disk space that can be consumed by the 
VPS, in 1 Kb blocks. You can additionally use the --
drive option to specify for which VPS drive the disk 
space is to be set. If the --drive option is omitted, the 
disk space limit is set for the C:\ drive. 

--drive drive_name The name of the drive inside the VPS for which a disk 
space limit is to be set. This option should be used in 
conjunction with the --diskspace option. 

--vprvmem number The size of private (or potentially private) memory 
allocated by an application, in 4 Kb pages. The memory 
that is always shared among different applications is not 
included in this resource parameter. 

Network-related settings allow you to set the hostname, IP address(es), DNS server address(es), 
etc. that a Virtual Private Server can use: 

--hostname name Sets the hostname of the VPS. 

--ipadd addr Adds an IP address to a list of IP addresses the Virtual 
Private Server can use and brings up the network interface 
with this address inside the VPS.  

--ipadd addr/netmaskbits 

--ipadd addr:netmask 

Along with adding an IP address, it sets a subnet mask that 
determines what subnet the given IP address belongs to. 
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--ipdel addr Allows you to revoke an IP address from the Virtual 
Private Server. 

--nameserver addr The DNS server IP address for the VPS. More than one 
server may be specified in space-separated format. 

--searchdomain domain The DNS search domain for the VPS. You may specify 
several domains and separate them by spaces. 

--psched on|off Enabling/disabling the Quality of Service packet scheduler 
for the specified Virtual Private Server; by default, it is 
disabled.The QoS packet scheduler is used to regulate how 
much traffic an application inside your VPS is allowed, 
thus enforcing the QoS parameters originally set for a 
particular application. After enabling the Quality of Service 
packet scheduler, any VPS can be managed as a normal 
stand-alone Windows 2003 server in respect of setting and 
working with all Windows Quality of Service components. 

Note: In case you have enabled the QoS packet 
scheduler for a running Virtual Private Server, you 
should restart this VPS for the changes to take effect. 

--isolate on|off Defines whether the Virtual Private Server should be 
isolated within its subnet or can also be accessed from 
other subnets: 

 Use the on command switch to allow the VPS to 
communicate only with the computers from the same 
subnet(s). 

 Use the off command switch to enable the VPS to 
access/be accessed by the computers located both on 
the same subnet and on other ones. 
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--preferred_adapter 
Adapter_ID 

In case there are several network adapter cards installed on 
the Hardware Node, you can use this option to specify the 
preferred network adapter for a Virtual Private Server. 
Specifying the preferred adapter for a VPS means that this 
network adapter will be used to connect the VPS to the 
network and, therefore, to handle the whole network traffic 
of the VPS. 

In Virtuozzo-based systems, network adapters are 
identified by the Media Access Control (MAC) addresses 
assigned to them. So, if  you wish to set a particular adapter 
to be used for this or that VPS on the Node, you should 
specify its MAC address as the value of this option. For 
example, the following command 
# vzctl set 101 --preferred_adapter 00-
0A-CR-32-F1-FD 

sets the network adapter card with the MAC address of 
00-0A-CR-32-F1-FD to be used for handling all the 
network traffic for VPS 101. 

While working with network adapters in Virtuozzo-based 
systems, please keep in mind the following: 

 After the Virtuozzo installation, all active adapters on 
the Hardware Node are used to control network traffic 
for all VPSs residing on the Node. 

 You can specify several network adapters for any VPS 
on the Node and separate them by spaces. In this case 
the corresponding VPS will be able to access all 
networks to which the specified adapters are 
connected. 

 If you use the option without specifying any value (i.e. 
execute the vzctl set VPS_ID --
preferred_adapter "" command), the network 
adapters of VPS 0 (i.e. of the Node itself) will be used 
to control network flows for the corresponding VPS. If 
there is no adapter set for VPS 0, then all the adapters 
currently active on the Node will handle the VPS 
network traffic. 

 
 

vzctl partadd and vzctl partdel 

The vzctl partadd command is used to create a new drive inside your Virtual Private 
Server by mounting it to a loopback file on the Hardware Node. After the command execution, 
the mounted drive becomes visible 

 On the Hardware Node: 

 As a folder in the X:\vz\root\VPS_ID\ directory and 

 As a file in the .efd format in the X:\vz\private\VPS_ID folder. 
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 From inside the Virtual Private Server: log in to the VPS via RDP and launch Windows 
Explorer. Your new drive will be displayed among other local drives available inside your 
VPS. 

You can then use the newly created VPS drive in the same way as you would use it on a stand-
alone computer: format it, create new files and folders within the drive, etc. 

The vzctl partadd command has the following syntax: 
vzctl partadd VPS_ID --drive VPS_drive --size drive_size 
[--file File_Name] 

The options that can be passed to vzctl partadd are explained in the table below: 

Option Description 
--drive VPS_drive Mandatory. The name of the VPS drive to be created inside the Virtual 

Private Server. After the command completion, this name will be shown 
as the name of the folder in the X:\vz\root\VPS_ID\ directory on 
the Node (e.g. C:\vz\root\101\F). If you log in to the VPS via 
RDP, you can see this name by launching Windows Explorer where it 
will be listed among your other local drives. The formats that can be used 
for specifying the drive name are X, X: or X:\ where X denotes the 
name of the drive you wish to create inside the VPS. 

--size drive_size Mandatory. The size of the VPS drive to be created inside the Virtual 
Private Server, in kilobytes. If you use this option without specifying any 
value, the VPS drive size will be set to 100 Mb. 

--file File_Name Optional. The name of the file to be created on the Node. After the 
command completion, this name will be visible as the name of the file in 
the .efd format located in the X:\vz\private\VPS_ID folder on 
the Node (e.g. C:\vz\private\101\My_File.efd). 
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Let us assume that you wish to create a new drive having the name of F:\ and the size of 50 
Mb inside VPS 101. Besides, you want the drive to be displayed as the 
MyVirtualDisk.efd file inside the C:\vz\private\101\ folder on the Hardware 
Node. To this effect, you should issue the following command on your Node: 
vzctl partadd 101 --drive F:\ --size 51200 --file MyVirtualDisk 

After the command execution, the newly created drive becomes visible as the 
C:\vz\root\101\F folder and the C:\vz\private\101\MyVirtualDisk.efd file 
on your Hardware Node. You can also log in to VPS 101 via RDP and check (e.g. by launching 
Windows Explorer) that a new drive with the name of Local Disk (F:) is now available 
inside the VPS. This drive has the size of 50 Mb and can be used as any other drive on a stand-
alone computer. 

The vzctl partdel command is used to unmount the VPS drive mounted by means of the 
vzctl partadd command from a file on the Hardware Node. It has the following syntax: 
vzctl partdel VPS_ID --drive VPS_drive [--delete] 

The command requires only the --drive option to be specified. However, you may also use 
the --delete option to remove the file from the X:\vz\private\VPS_ID folder on the 
Node which, otherwise, remains intact. 

For example, to unmount the F:\ drive that was mounted to VPS 101 in the example above and 
delete the MyVirtualDisk file from the C:\vz\private\101 folder on the Node, you 
should execute the following command: 
vzctl partdel 101 --drive F:\ --delete 
 

vzctl exec, vzctl exec2, and vzctl enter 

These commands are used to run arbitrary commands inside a Virtual Private Server being 
authenticated as administrator on the Hardware Node. The syntax of these commands is as 
follows: 
vzctl { exec, exec2 } <VPSID> <command> 
vzctl enter <VPSID> 

where command is a string to be executed in the Virtual Private Server. 

The difference between exec and exec2 is the exit code. vzctl exec returns 0 in case 
vzctl has been able to launch the command and does not take into account the exit code of the 
command itself. vzctl exec2 returns the exit code of the command executed in the Virtual 
Private Server. 

vzctl enter is similar to vzctl exec. The difference between the two is that vzctl 
enter makes the command line believe that it is connected to a terminal. As such, you receive 
a command line prompt and are able to execute multiple commands as if you were logged in to 
the Virtual Private Server. 
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vzlist 
The vzlist utility is used to list the VPSs existing on the given Hardware Node together with 
additional information about these VPSs. The output and sorting of this information can be 
customized as needed. The utility has the following syntax: 
vzlist [-a] [-S] [-o specifier[,specifier...]] [-H] [VPSID [VPSID...] 
  [-s specifier | -specifier]  [-h [*]pattern[*]] 
  [--quite] [--verbose] 
vlist -L 
vlist --help 

Here follows the description of available options: 

Option Description 
-a, --all List all the VPSs existing on the Node. By default, only running 

VPSs are shown. 

-S, --stopped List only stopped VPSs. 

-o parameter[.specifier] This option is used to display only particular information about 
the VPSs. The parameters and their specifiers that can be used 
after the -o option are listed in the following subsection. To 
display a number of parameters in a single output, they should be 
separated with commas, as is shown in the synopsis above. 

-H, --no-header Do not display column headers. 

-L, --list List all the parameters available. 

--help Display the usage info and exit. 

-s, --sort 

[-]parameter[.specifier] 

Sort the VPSs in the list by the specified parameter. If "-" is given 
before the name of the parameter, the sorting order is reversed. 

-h, --hosthame 

hostname_pattern 

Display only those VPSs that correspond to the specified 
hostname pattern. The following wildcards can be used: *. 

--quiet Disables logging to the display and to the log file. 

--verbose Sets the log level to the maximum possible value for this 
vzlist session. 

 
 

vzlist Output Parameters and Their Specifiers 

Some parameters that can be used after the -o and -s switches of the vzlist utility can be 
specified by the "dot+letter" combination following the parameter and denoting one of the 
following things: 

Specifier Description 
.b The barrier on using the corresponding resource set for the given VPS. 

.h The hard limit on using the corresponding resource set for the given VPS. 
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The following parameters are available for using with the utility: 

Parameter Output Column Description 

veid VEID The VPS ID. 

hostname HOSTNAME The VPS hostname. 

ip IP_ADDR The VPS IP address. 

status STATUS Specifies whether the VPS is running or stopped. 

numproc NPROC Number of processes allowed. Can be used with the .b 
specifier. 

numsessions SESSIONS Number of terminal sessions opened to the VPS. Can be used 
with the .b specifier. 

diskspace DQBLOCKS Total size of disk space consumed by the VPS, in 1 Kb 
blocks. Can be used with the .h specifier defining the hard 
limit on using disk space. 

cpuunits CPUUNI Allowed CPU power. This is a positive integer number, which 
determines the minimal guaranteed share of the CPU the 
Virtual Private Server will receive. 

vprvmem VPRVMEM The size of private (or potentially private) memory allocated 
by an application. The memory that is always shared among 
different applications is not included in this resource 
parameter. 

templates TEMPLATES Displays the OS and application templates applied to the 
Virtual Private Server. If the veid parameter is not specified, 
all templates available on the Hardware Node are shown. 

If a parameter that can be used with a specifier is used without any specifier in the command 
line, the current usage of the corresponding resource is shown by default. 

 
 

vzquota 
This command is used to configure and see disk quota statistics for Virtual Private Servers. 
vzctl uses vzquota internally to configure quotas and you usually do not have to use 
vzquota except for checking current quota statistics. The syntax of vzquota command is as 
follows: 
vzquota [--quiet | --verbose] [-b] setlimit vps_id -B num 
vzquota [--quiet | --verbose] [-b] stat vps_id 
vzquota [--quiet | --verbose] [-b] show vps_id 
vzquota --help 

General options available to all vzquota commands are: 

-v Verbose  mode. Causes vzquota to print debugging messages about its progress. You 
can give up to two –v switches to increase verbosity. 

-q Quiet mode. Causes all warning and diagnostic messages to be suppressed. Only fatal 
errors are displayed. 
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--help Display the usage info and exit. 

-b Set the batch mode. 

vzquota understands the following commands: 

setlimit Allows changing the quota limits for the running quota. 

stat Shows quota statistics for the running quota. 

show Shows quota usage from quota file. 

 
 

vzquota setlimit 

This command updates limits for the running VPS quota. It requires at least one limit to be 
specified. The syntax of this command is: 
vzquota setlimit <VPSID> -B num [--drive name] 

Currently, only one option can be used with the command: 

-B, --block-hardlimit num Required. Specifies the disk quota block hard limit, in 1 Kb 
blocks. This limit cannot be exceeded by the Virtual Private 
Server. 

--drive name Optional. Specifies the disk drive inside the VPS for which 
the disk quota limit is to be set. 

The only required parameter for this command is the ID of the Virtual Private Server whose 
disk quota limit you wish to set. However, you can additionally use the --drive option to 
specify to what VPS disk drive the defined quota limit is to be applied. For example, the 
following command sets the disk quota limit of 100 Mb for the F:\ drive inside VPS 101: 
C:\...\Administrator>vzquota setlimit 101 -B 102400 --drive F:\ 
Command 'setlimit' is successfully finished 

Note: The disk quota limit for all VPS disk drives except for the C:\ drive is set on the fly. To 
make the disk quota limit changes apply to the C:\ drive, you should restart the Virtual Private 
Server where the drive is located. 
 

vzquota stat and vzquota show 

These commands are used for querying the VPS quota statistics. The syntax is as below: 
vzquota show <VPSID> 
vzquota stat <VPSID> 

You can use both the vzquota stat and vzquota show commands to view disk quota 
parameters. A typical output of the commands is below: 
C:\Documents and Settings\Administrator>vzquota stat 101 
disk   resource    usage     hardlimit   path 
C:     1k-blocks   32768     122880      C:\vz\private\101\root.efd 

The output shows that only one disk drive - C:\ - exists inside Virtual Private Server 101. It is 
located in the C:\vz\private\101 folder on the Hardware Node. VPS 101 currently uses 
32 Mb of disk space available on the C:\ drive and the hard limit for this drive is set to 120 
Mb. 
 



 

 Reference 231 
 

Licensing Utilities 
vzlicload 

This utility loads Virtuozzo licenses. It has the following syntax: 
vzlicload [options]  

This utility is called automatically by the Hardware Node initialization scripts and searches the 
C:\Program Files\SWsoft\Virtuozzo\Licenses directory for a vzlicense file. 
If the file is found, the utility loads its contents. You can run this utility when you received a 
new license and want to load it. You need a new license if your hardware configuration changed 
or you need to run more Virtual Private Servers than your current license allows. 

The utility accepts the following options: 

-f, --license-file <file> File to load. If omitted, then the C:\Program 
Files\SWsoft\Virtuozzo\Licenses directory is 
used. 

-i, --stdin Use standard input as a license file. 

 
 

vzlicview 

This utility displays license content along with license status information. It has the following 
syntax: 
vzlicview [options]  

It is important to remember that this utility always operates on a license file. When the utility 
runs without arguments it returns content and status of the license found in the default location 
C:\Program Files\SWsoft\Virtuozzo\Licenses. 

The following options can be used with this utility: 

-f, --license-file <file> File to load. If omitted, then C:\Program 
Files\SWsoft\Virtuozzo\Licenses is used. 

-i, --stdin Use standard input as a license file. 

The utility reports the following statuses for the license: 

ACTIVE The license file is loaded, verified for validity and active. 

VALID The license is valid, but has not been loaded into the kernel. 

GRACED The license will be disabled after grace period expiration, but currently is still active. 
The license either bound to different hardware configuration or expired. 

EXPIRED The expired license, which has not been loaded. 

UNKNOWN License status is unknown. Virtuozzo support is not installed on the system. 
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Migration Utilities 
Very often it is necessary to migrate one or more Virtual Private Servers from one Hardware 
Node to another (e.g. in the case of the Hardware Node upgrade). Sometimes you may want to 
move or copy a VPS within one and the same Node, i.e. to change the VPS ID and/or the VPS 
private area path. These tasks are performed by means of the migration tools described further 
on. 
 

vzmigrate 

This utility is used for moving Virtual Private Servers to another system (i.e. from the Source 
Node to the Destination Node) with minimal downtime. It has the following syntax: 
vzmigrate [-r yes|no] [-n] -A ServerNodeAddr \ 
-P ServerPassword {VPS_list} 
{VPS List} = <source_VPSID>[:<dest_VPSID>] [...] 
vzmigrate --help 

The following options can be used with the vzmigrate utitlity: 

-r, --remove-area yes|no If “yes” is specified, then the private area will be deleted after 
the corresponding VPS is successfully migrated to the 
Destination Node. If “no” is specified, the private area will not 
be deleted. In this case the VPS configuration file will be 
renamed from VPS_ID.conf to 
VPS_ID.conf_migrated. By default, the VPS private 
area is removed from the Source Node. 

-n, --nostart Do not attempt to start the VPS on the Destination Node after 
its successful migration. This option does not have any effect 
if the Virtual Private Server was not running on the Source 
Node. 

-A, --srv_addr The IP address or the hostname of the Destination Node, i.e. 
of the Node where the VPS is to be migrated. 

-P, --srv_pswd The password of the vzagent0 user. You should provide the 
password you use to log in as vzagent0 to the Service VPS 
on the Destination Node. 

-h, --help Displays the utility usage and exits. 

--quiet Disables logging to the screen and to the log file. 

--verbose Sets the log level to the maximum possible value for this 
vzmigrate session. 
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To migrate the VPS, you should execute the vzmigrate command on the Source Node and 
pass the corresponding options to it. {VPS_list} is a list of 
<source_VPSID>[:<dest_VPSID>] denotations separated by spaces. A different 
destination VPS ID parameter is needed in case the Source Node (the one where you run the 
vzmigrate command) and the Destination Node have Virtual Private Servers with one and 
the same ID. You can specify multiple Virtual Private Servers at once for migration. 

If the Virtual Private Server is running on the Source Node, vzmigrate copies its private 
files, registry settings, etc. to the Destination Node, stops the Virtual Private Server on the 
Source Node, copies the files changed after the first copying to the Destination Node again, and 
starts the VPS on the Destination Node (if the -n option is not specified). 

Since a Virtual Private Server consists of thousands of files, copying all of them to a new 
Hardware Node may take considerable time. However, vzmigrate stops the Virtual Private 
Server only after all the files have been copied to the new Hardware Node and resynchronizes 
only those files that have been changed while being copied. This brings down a typical VPS 
downtime to the time required for restarting a Virtual Private Server. 

For example, to migrate VPS 101 residing from the Source Node to VPS 111 on the Destination 
Node having the IP address of 123.154.154.123, you can execute the following command: 
C:\...\Administrator>vzmigrate -A 123.154.154.123 -P qw3r5f 101:111 
 

vzmlocal 

Moving/copying a VPS within one and the same Hardware Node consists in changing/adding 
the VPS ID, private area, and root paths. Thus, you may use the vzmlocal utility either to 
change the ID and/or the private area path and/or the root path of any existing VPS(s) or to 
clone a VPS, i.e. to create a complete copy of an existing VPS with different ID and path. It has 
the following syntax: 
vzmlocal <VPS List> 
<VPS List> = <source_VPSID>:<dest_VPSID>[:<dest_private>] [...] 
vzmlocal -C <VPS List> 
<VPS List> = <source_VPSID>:<dest_VPSID>[:<dest_private>] [...] 
vzmlocal --help 

The options are the following: 

-C, --copy Clone the source Virtual Private Server instead of moving it. 

--quiet Disables logging to screen and to the log file. 

--verbose Sets log level to maximum possible value for this vzlist session. 

--help Display the utility usage. 
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You should specify the source VPS ID (<source_VPSID>) and, if you are cloning a VPS, the 
destination VPS ID (<dest_VPSID>). Specifying the destination VPS private area path 
(<dest_private>) is optional; it allows you to override the default path of 
X:\vz\private\<VPSID>. For example, you can issue the following command to move 
VPS 101 to VPS 201, i.e. to change the VPS ID from 101 to 201, and to locate the VPS private 
area in the C:\MyVPS folder on the Hardware Node: 
C:\...\Administrator>vzlist -a 
 VEID  NPROC  STATUS   IP_ADDR         HOSTNAM 
    1     22  running  192.168.45.63   VPS1 
  101      0  stopped  10.198.198.101  VPS101 
C:\...\Administrator>vzmlocal 101:201:C:\MyVPS 
Command 'vzmlocal' is successfully finished 

Note: In the current version of Virtuozzo, you can change IDs of stopped Virtual Private 
Servers only. 
 

vzp2v 

vzp2v is used to migrate a physical server to a Virtual Private Server on your Hardware Node. 
It has the following syntax: 
vzp2v VPS_ID -A Physical_Server_IP_Address -U username -P password 
      [-S] [-n] [-x drive [...]] 
vzp2v --help 

The options that can be used with the vzp2v utility are listed in the table below: 

Name Description 
-A, --src_addr Mandatory. The IP address or hostname of the physical server you are 

going to migrate to a VPS on your Node. 

-U, --src_user Mandatory. The username to log in to the physical server. This user should 
possess the rights of the Administrator. 

-P, --src_pswd Mandatory. The password of the user specified as the value of the -U 
option. 

-S, --src_stop Optional. Stop the physical server after its successful migration. If the 
option is omitted, the physical server continues running after the 
migration. 

-n, --nostart Optional. Do not start the Virtual Private Server after the physical server 
migration. If the option is not specified, the VPS is automatically started 
after the physical server has been successfully moved to the VPS on your 
Hardware Node. 

-x, --exclude Optional. The names of the drives which will be excluded from copying to 
the VPS. The formats that can be used for specifying the drive name are X, 
X: or X:\ where X denotes the name of the drive you do not wish to copy 
to the VPS. If you omit this option, all disk drives available on the 
physical server will be migrated to the VPS. 

--help Display the utility usage. 
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To migrate a physical server, you should execute the vzp2v command on the Hardware Node 
and pass the corresponding options to it. Before starting the migration process, please make sure 
that there is no Virtual Private Server on your Node with the ID specified as VPS_ID; 
otherwise, the migration will fail. 

For example, the following command 
C:\...\Administrator>vzp2v 101 -A 123.154.154.123 -U Administrator \ 
      -P qw3r5f -S -x E:\ 

allows you to log in to the physical server having the IP address of 123.154.154.123 with 
the credentials of Administrator and qw3r5f and to migrate this physical server to VPS 
101 on your Hardware Node. The -S option tells vzp2v to stop the physical server after its 
migration and -x E:\ excludes the E:\ partition on the physical server from the migration 
process. 
 

Backing-Up Utilities 
Any Virtual Private Server is defined by its private area and configuration parameters stored in 
the registry. Backing up these components allows you to restore the whole Virtual Private 
Server at any time in case the VPS gets broken. 

The following subsections provide the complete reference on the Virtuozzo backup and restore 
utilities: 

 vzexport; 
 vzimport; 
 vzbackup; 
 vzrestore. 

 

vzexport 

The vzexport utility is used to back up the given VPS to some file on your Hardware Node. 
Later on, the VPS backup may be restored from this file. The following components are backed 
up to a zip file: 

 C:\vz\private\<VPS_ID>: the directory where the VPS private area is stored; it 
contains all the VPS-related data. 

 HKLM\Software\SWSoft\Virtuozzo\Ve\<VPS_ID>: the subkey in the registry 
where all basic VPS configuration parameters are stored. 

The vzexport utility has the following syntax: 
vzexport VPS_ID --backup_file name [-s] 
vzexport --help 

The backup options are the following: 

-b, --backup_file 
name 

Used to define the name of the file the Virtual Private Server will be 
backed up to. 

-s Stops the Virtual Private Server, in case it is running, for the time 
necessary for its backing up. 

--help, /? Displays the utility help. 
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vzimport 

The vzimport utility uses the VPS backups stored in the corresponding file on the Hardware 
Node to restore them to their original state. The syntax of the command is the following: 
vzimport --backup_file name [-s] [-f] 
vzimport --help 

The restore options are the following: 

-b, --
backup_file name 

The name of the file the Virtual Private Server was backed up to. This file 
should have the .zip extension. 

-f Restores the backed up Virtual Private Server even in case a VPS with the 
same ID exists on the Node. Keep in mind that the VPS will be restored 
with all the values overwritten from the backup, including the hostname, IP 
address, application set, etc. 

-s Stops the Virtual Private Server, in case it exists on the Node and is running, 
for the time necessary for its restoring. 

--help, /? Displays the utility help. 
 
 

vzbackup 

The vzbackup utility is used to create and manage Virtual Private Server backups. As distinct 
from vzexport, you can: 

 Run this utility on virtually every Node in your network. It can be: 
 The Source Node where the VPS to be backed up is residing; 

 The Backup Node - a special Node intended for storing VPS backups, or 

 Any other Virtuozzo-based physical server in your network. 

The only requirements that should be met to execute vzbackup is to have a computer with 
Virtuozzo 3.5.1 for Windows installed on it and to provide the network connectivity for this 
computer to be able to establish connections to the Source and Backup Nodes, if necessary. 
The created VPS backups are then stored on the Backup Node which can also be presented 
by any Node with running Virtuozzo software. 

 Use this utility to manage your existing VPS backups in the following way: 
 List all VPS backups available on the Backup Node and display detailed information on 

them; 

 Change the path to the folder on the Backup Node where VPS backups are to be stored; 

 Remove a VPS backup. 
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The vzbackup utility has the following syntax: 
vzbackup VPS_ID [backup options] 
vzbackup --help 

The backup options are the following: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node where the VPS is to be 
backed up. If the option is omitted, the Source Node will be used to store 
the VPS backup and act the Backup Node. In the case of running 
vzbackup on a Node other than the Backup Node, you should 
obligatorily specify this option. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzbackup to log in to the Backup Node. This 
option is taken into account in case the -A option is specified during the 
vzbackup execution. If the -A option is used and the -U option is 
omitted, the utility tries to log in to the Backup Node as vzagent0 
created on the Backup Node during the Virtuozzo installation. 

-P, --srv_pswd 
BackupNodePasswrd 

The password of the user specified as the value of the -U option. This 
option is taken into account in case the -A option is specified during the 
vzbackup execution. If the -A option is used and the -U option is 
omitted, you should enter the password of the vzagent0 user. This is 
the same password you entered during the Virtuozzo installation on the 
Backup Node for managing your Node and all its VPSs by means of 
VZMC and VZCC. 

-a, --clnt_addr 
SourceNodeAddress 

The IP address or hostname of the Source Node, i.e. of the Node where 
the VPS to be backed up is residing. If the option is omitted, the VPS to 
be backed up will be taken from your local Node. In the case of running 
vzbackup on a Node other than the Source Node, you should 
obligatorily specify this option. 

-u, --clnt_user 
SourceNodeUser 

The user name used by vzbackup to log in to the Source Node. This 
option is taken into account in case the -a option is specified during the 
vzbackup execution. If the -a option is specified and the -u option is 
omitted, the utility tries to log in to the Source Node as vzagent0 
created on the Source Node during the Virtuozzo installation. 

-p, --clnt_pswd 
SourceNodePasswrd 

The password of the user specified as the value of the -u option. This 
option is taken into account in case the -a option is specified during the 
vzbackup execution. If the -a option is used and the -u option is 
omitted, you should enter the password of the vzagent0 user. This is 
the same password you entered during the Virtuozzo installation on the 
Source Node for managing your Node and all its VPS by means of 
VZMC and VZCC. 

-s Stops the Virtual Private Server, in case it is running, for the time 
necessary for its backing up. 

-I Make an incremental backup or, if no full backups are available, a full 
backup. 

-d BackupID Remove the VPS backup with the specified backup ID. 

While running, vzbackup performs the following operations: 

1 Connects via SSH to the Source Node where the Virtual Private Server you wish to back up 
is residing; 
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2 Compresses the VPS private area and registry settings to a file in the .zip format; 

3 Connects via SSH to the Backup Node; 

4 Transfers the compressed file from the Source Node to a special backup folder on the 
Backup Node. 

For example, you can issue the following command to back up VPS 101 from the Source Node 
having the IP address of 134.156.156.134 and to place the VPS backup to the Backup 
Node with the IP address of 203.156.156.203: 
C:\...\Administrator>vzbackup 101 -S 203.156.156.203 -U Administrator 
-P 5tghy7ui8 -c 134.156.156.134 -u Administrator 
connection adjust... 
backing up... 
Command 'vzbackup' is successfully finished 

After the command completion, you can find your VPS backup on the Backup Node, in the 
folder specified during the Virtuozzo installation for storing all VPS backups. By default, the 
X:\vz\Backups folder on the Node is used. However, you can specify another folder on the 
Backup Node for storing your VPS backups by using the vzbackup storage command. 
Detailed information on this command is given in the vzbackup storage subsection. 
 

vzbackup list 
The vzbackup list command lists all Virtual Private Servers backups available on the 
Backup Node. It has the following syntax: 
vzbackup list VPS_ID [options] 
vzbackup list -b backup_ID [options] 

The options that can be passed to vzbackup list are presented in the table below: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node where the VPS 
backup is stored. If the option is omitted, your local Node will be 
searched for available backups of the specified VPS.  In the case of 
executing vzbackup list on a Node other than the Backup Node, 
you should obligatorily specify this option. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzbackup list to log in to the Backup 
Node. This option is taken into account in case the -A option is 
specified during the vzbackup list execution. If the -A option is 
used and the -U option is omitted, the utility tries to log in to the 
Backup Node as vzagent0 created on the Backup Node during the 
Virtuozzo installation. 

-P, --srv_pswd 
BackupNodePassword 

The password of the user specified as the value of the -U option. This 
option is taken into account in case the -A option is specified during 
the vzbackup list execution. If the -A option is used and the -U 
option is omitted, you should enter the password of the vzagent0 
user. This is the same password you entered during the Virtuozzo 
installation on the Backup Node for managing your Node and all its 
VPSs by means of VZMC and VZCC. 

--all Displays detailed information on the Virtual Private Server backup(s).
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-b backup_ID Lists all disk drives contained in the VPS backup with the specified 
backup ID.  

Note: If you use the -b option, you should not specify the 
Virtual Private Server ID (e.g. vzbackup list -b 
{BB05D401-CD53-...}\000011bk). 

-f FolderName Displays the contents of the specified folder in the VPS backup. If the 
option is omitted, the contents of the C:\ folder is shown. This option 
should be used in conjunction with the -b option. 
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For example, if you wish to list all available backups of VPS 101 on the Backup Node having 
the IP address of 203.156.156.203, you can issue the following command on the Hardware 
Node: 
C:\...\Administrator>vzbackup list 101 -S 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 --all 
connection adjust... 
listing... 
 
VPS 101 
 
backup ID                type   node          created 
{BB05D401-CD53-...}\000011bk  full   MyNode   17/09/2005 14:20:26 

In the example above, the connection to the Backup Node is established by using the 
Administrator credentials (specified as the values of the -U and -P options). The output shows 
us that only one backup of VPS 101 exists on the Backup Node having the IP address of 
203.156.156.203. Information on the VPS backup is presented in the table having the 
following columns: 

 type: the backup type. It can be either full or incremental. In our case we created a full 
VPS backup containing the whole VPS private area and its registry settings. Detailed 
information on backup types is provided in the Backing Up and Restoring VPS section (on 
page 45). 

 node: the hostname of the Backup Node where the VPS backup is stored. In our case the 
Backup Node has the MyNode hostname which corresponds to the IP address of 
203.156.156.203. In the case of omitting the -all option, this information is not displayed. 

 created: the date and time of the backup creation. As can be seen, our VPS backup was 
created on September 17, 2005 at 14:20:26. 

 backup ID: the backup ID assigned to the VPS backup during its creation. 

The last point needs further explanation. Any VPS backup is recognized by a unique ID 
assigned to the backup during its creation. Backup identifiers are automatically generated by the 
vzbackup utility and can have the following forms: 

 {xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx}\Backup_numberbk for a full 
VPS backup (e.g. {39EF8C5C-C470-4166-AE51-5F5BEB0CF864}\000029bk) 
and 

 {xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx}\Backup_numberbk# for an 
incremental VPS backup where # denotes the index number of the incremental backup (e.g.  
{39EF8C5C-C470-4166-AE51-5F5BEB0CF864}\000029bk2 for the second 
incremental backup created for the given VPS). 

Backup identifiers can then be used by the vzbackup list and vzbackup delete 
commands to manage VPS backups with the corresponding backup IDs: list disk drives inside 
the VPS backup, remove the VPS backup with the specified backup ID from the Backup Node, 
etc. You should also specify a VPS backup ID while running the vzrestore utility to point 
out what VPS backup is to be restored. 

You can also use the -b and -f options to display information on the backed up VPS disk 
drives and the contents of a particular folder (i.e. all its subfolders and files) inside your VPS 
backup. In this case you should use the backup ID instead of the VPS ID to specify the backup 
the disk drives or folders of which is to be shown: 

 To see information on the backed up VPS disk drives, issue the following command: 
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C:\...\Administrator>vzbackup list -b {BB05D401-CD53-...}\000011bk \ 
-S 203.156.156.203 -U Administrator -P 5tghy7ui8 
connection adjust... 
listing... 
 
name  size  date 
C:          Dec 31 16:00:00 1999 

 To view the contents of a particular folder inside the VPS backup with the backup ID 
specified, you should provide the full path to the folder inside the VPS at the moment of the 
VPS backup creation. So, if you wish to view the contents of the Private subfolder that 
was located in the C:\MyDocs folder inside VPS 101 at the moment of the backup 
creation, you can execute the following command (assuming that the backup is taken from 
the example above): 

C:\...\Administrator>vzbackup list -b {BB05D401-CD53-...}\000011bk \ 
-S 203.156.156.203 -U Administrator -P 5tghy7ui8 -f C:\MyDocs\Private 
connection adjust... 
listing... 
 
 C:\MyDocs\Private 
        Document1.doc 
 

vzbackup storage 
The vzbackup storage command is used to manage the folder on the Backup Node where 
VPS backups are to be stored. It has the following syntax: 
vzbackup storage [options] 
vzbackup storage -G [options] 
vzbackup storage -D [options] 

You can use the following options with the vzbackup storage command: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node where the VPS backup 
folder location is to be changed. If the option is omitted, the path to the 
backup folder on your local Node will be modified. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzbackup storage to log in to the Backup 
Node. This option is taken into account in case the -A option is specified 
during the vzbackup storage execution. If the -A option is used and 
the -U option is omitted, the utility tries to log in to the Backup Node as 
vzagent0 created on the Backup Node during the Virtuozzo installation. 

-P, --srv_pswd 
BackupNodePasswor
d 

The password of the user specified as the value of the -U option. This option 
is taken into account in case the -A option is specified during the 
vzbackup storage execution. If the -A option is used and the -U 
option is omitted, you should enter the password of the vzagent0 user. 
This is the same password you entered during the Virtuozzo installation on 
the Backup Node for managing your Node and all its VPSs by means of 
VZMC and VZCC. 

-a The path to the folder on the Backup Node. It can be a local folder or a 
folder on your network share. In case you wish to locate your backup folder 
on a network share and this share is password-protected, you should 
additionally specify the -u and -p options to access the folder. 

-u The user name used to log in to the network share where your backup folder 
is to be located. If your network share is not password-protected, you can 
omit this option. 
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-p The password of the user specified as the value of the -u option. 

-G Displays information about the VPS backup folder on the Backup Node. 

-D Deletes information about the current backup folder on the Backup Node. 
After removing information on the backup folder, you should set the backup 
folder anew (by executing the vzbackup storage -a command) to be 
able to save VPS backups on the Backup Node. 

All VPS backups are stored in the folder on the Node you specified during the Virtuozzo 
installation for storing all VPS backups. By default, the X:\vz\Backups folder on the Node 
is used. To change the VPS backup folder location, you should execute the vzbackup 
storage command. For example: 
C:\...\Administrator>vzbackup storage -A 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 -a G:\MyBackups -u Peter -p 3ewr45t 
connection adjust 
Command 'storage' is successfully finished 

In our example, we specified the MyBackups folder located on the Backup Node with the IP 
address of 203.156.156.203 for storing your VPS backups. This folder is located on the 
G:\ network disk drive mapped to the Backup Node. The G:\ drive is password-protected and 
can be accessed by providing the Peter user name and the 3ewr45t password. 

Note: Before specifying another backup folder for storing VPS backups, please make sure that 
this folder already exists on the Backup Node; otherwise, the vzbackup storage -a 
command will fail. 

To display information on the VPS backup folder located on the Backup Node with the IP 
address of 203.156.156.203, you can execute the following command: 
C:\...\Administrator>vzbackup storage -G -A 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 
path = G:\MyBackups 
login = Peter 

The output shows us that: 

 The G:\MyBackups folder is currently used to store VPS backups on the Backup Node 
with the IP address of 203.156.156.203; 

 The MyBackups folder is located on the password-protected G:\ network drive and the 
Peter user name is used to log in to this network drive. 
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vzbackup delete 
The vzbackup delete command is used to remove a VPS backup from the Backup Node. 
This command takes the backup ID to identify what VPS backup is to be removed from the 
Node. It has the following syntax: 
vzbackup delete backupID [options] 

You can use the following options with vzbackup delete: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node from where the VPS 
backup is to be removed. If the option is omitted, the backup from your 
local Backup Node will be deleted. In the case of executing 
vzbackup delete on a Node other than the local Backup Node, 
you should obligatorily specify this option. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzbackup to log in to the Backup Node. If 
the option is omitted, the utility tries to log in to the Backup Node as 
vzagent0 created on the Backup Node during the Virtuozzo 
installation. 

-P, --srv_pswd 
BackupNodePasswrd 

The password of the user specified as the value of the -U option. In 
case the -U option is omitted, you should enter the password of the 
vzagent0 user. This is the same password you entered during the 
Virtuozzo installation on the Backup Node for managing your Node 
and all its VPSs by means of VZMC and VZCC. 

If you are going to run the vzbackup delete command on the Backup Node itself, you only 
need to specify the VPS backup ID to remove it from the Node. However, to delete a VPS 
backup by executing the command on a Node other then the local Backup Node, you should 
also use the options described in the table above. 

For example, the following session shows how do delete the backup of VPS 101 located on the 
Backup Node with the IP address of 203.156.156.203: 

 To learn what ID is assigned to the backup of VPS 101: 
C:\...\Administrator>vzbackup list 101 -S 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 
connection adjust... 
listing... 
 
VPS 101 
 
backup ID                type   node          created 
{BB05D401-CD53-...}\000011bk  full   MyNode   17/09/2005 14:20:26 

 To delete the backup of VPS 101: 
C:\...\Administrator> vzbackup delete {BB05D401-CD53-...}\000011bk 
connection adjust... 
deleting... 
Command 'delete' is successfully finished 
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vzrestore 

The vzrestore utility is used to restore and manage Virtual Private Server backups. It uses 
the VPS backups stored on the Backup Node to restore them to their original Hardware Node(s) 
or to any other Node on your network. Similarly to vzbackup, it can be: 

 Run on virtually every Node in your network: 
 On the Backup Node where VPS backups are stored; 

 On the Destination Node where the backed up VPS is to be restored, or 

 On any other Virtuozzo-based physical server in your network 

The only requirements that should be met to execute vzrestore is to have a computer 
with Virtuozzo 3.5.1 for Windows installed on it and to provide the network connectivity for 
this computer to be able to establish connections to the Backup and Destination Nodes, if 
necessary. 

 Used to manage your existing VPS backups: 
 List all VPS backups available on the Backup Node and display detailed information on 

them; 

 Change the path to the folder on the Backup Node where VPS backups are to be stored; 

 Remove a VPS backup. 

The vzrestore utility has the following syntax: 
vzrestore VPS_ID -b backupID [options] 
vzrestore --help 

The following options can be used with the vzrestore utility: 

Name Description 
-b backupID The ID assigned to the VPS backup during its creation and uniquely 

identifying the backup. 

-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node from where the VPS 
is to be restored. If the option is omitted, the VPS backup from your 
local Backup Node will be restored. In the case of running 
vzrestore on a Node other than the local Backup Node, you should 
obligatorily specify this option. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzrestore to log in to the Backup Node. 
This option is taken into account in case the -A option is specified 
during the vzrestore execution. If the -A option is used and the -U 
option is omitted, the utility tries to log in to the Backup Node as 
vzagent0 created on the Backup Node during the Virtuozzo 
installation. 

-P, --srv_pswd 
BackupNodePasswrd 

The password of the user specified as the value of the -U option. This 
option is taken into account in case the -A option is specified during 
the vzrestore execution. If the -A option is used and the -U option 
is omitted, you should enter the password of the vzagent0 user. This 
is the same password you entered during the Virtuozzo installation on 
the Backup Node for managing your Node and all its VPSs by means 
of VZMC and VZCC. 
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-a, --clnt_addr 
DestNodeAddress 

The IP address or hostname of the Destination Node where the VPS 
backup is to be restored. If the option is omitted, the VPS backup will 
be restored to your local Backup Node which will act in this case as the 
Destination Node. In the case of running vzrestore on a Node other 
than the Destination Node, you should obligatorily specify this option. 

-u, --srv_user 
DestNodeUser 

The user name used by vzrestore to log in to the Destination Node. 
This option is taken into account in case the -a option is specified 
during the vzrestore execution. If the -a option is specified and 
the -u option is omitted, the utility tries to log in to the Destination 
Node as vzagent0 created on the Destination Node during the 
Virtuozzo installation. 

-p, --srv_pswd 
DestNodePasswrd 

The password of the user specified as the value of the -u option. This 
option is taken into account in case the -a option is specified during 
the vzrestore execution. If the -a option is used and the -u option 
is omitted, you should enter the password of the vzagent0 user. This 
is the same password you entered during the Virtuozzo installation on 
the Destination Node for managing your Node and all its VPSs by 
means of VZMC and VZCC. 

-f, --files 
FileName 

The full path to the file/folder inside the VPS backup with the specified 
backup ID that you wish to restore. You can specify several 
files/folders and separate them by spaces. 

To restore a particular VPS backup, you should specify two options: 

 the VPS ID and 
 the backup ID. 

For example, to restore a backup of VPS 101 having the backup ID of {BB05D401-CD53-
...}\000011bk and residing on the Backup Node with the IP address of 
203.156.156.203 to the Destination Node with the IP address of 122.133.133.122, 
you should do the following: 
C:\...\Administrator>vzrestore 101 -b {BB05D401-CD53-...}\000011bk \ 
-A 203.156.156.156 -U Administrator -P 5tghy7ui8 -a 122.133.133.122 \ 
-u Administrator -p t6uj8js0 
connection adjust 
restoring 
Command 'vzrestore' is successfully finished 

Note: The VPS on the Destination Node you are going to restore should be stopped; otherwise, 
the restoring process will fail. 
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vzrestore list 
The vzrestore list command lists all Virtual Private Servers backups available on the 
Backup Node. It has the following syntax: 
vzrestore list VPS_ID [options] 
vzrestore list -b backup_ID [options] 

The options that can be passed to vzrestore list are presented in the table below: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node where the VPS 
backup is stored. If the option is omitted, your local Backup Node 
will be searched for available backups of the specified VPS. In the 
case of executing vzrestore list on a Node other than the local 
Backup Node, you should obligatorily specify this option. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzrestore to log in to the Backup Node. 
This option is taken into account in case the -A option is specified 
during the vzrestore list execution. If the -A option is used 
and the -U option is omitted, the utility tries to log in to the Backup 
Node as vzagent0 created on the Backup Node during the 
Virtuozzo installation. 

-P, --srv_pswd 
BackupNodePassword 

The password of the user specified as the value of the -U option. This 
option is taken into account in case the -A option is specified during 
the vzrestore list execution. If the -A option is used and the -
U option is omitted, you should enter the password of the vzagent0 
user. This is the same password you entered during the Virtuozzo 
installation on the Backup Node for managing your Node and all its 
VPSs by means of VZMC and VZCC. 

--all Displays detailed information on the Virtual Private Server backup(s).

-b backup_ID Lists all disk drives contained in the VPS backup with the specified 
backup ID.  

Note: If you use the -b option, you should not specify the Virtual 
Private Server ID (e.g. vzrestore list -b {BB05D401-
CD53-...}\000011bk). 

-f FolderName Displays the contents of the specified folder in the VPS backup. If the 
option is omitted, the contents of the C:\ folder is shown. This option 
should be used in conjunction with the -b option. 
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For example, if you wish to list all available backups of VPS 101 on the Backup Node having 
the IP address of 203.156.156.203, you can issue the following command on the Hardware 
Node: 
C:\...\Administrator>vzrestore list 101 -S 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 --all 
connection adjust... 
listing... 
 
VPS 101 
 
backup ID                type   node          created 
{BB05D401-CD53-...}\000011bk  full   MyNode   17/09/2005 14:20:26 

In the example above, the connection to the Backup Node is established by using the 
Administrator credentials (specified as the values of the -U and -P options). The output shows 
us that only one backup of VPS 101 exists on the Backup Node having the IP address of 
203.156.156.203. Information on the VPS backup is presented in the table having the 
following columns: 

 type: the backup type. It can be either full or incremental. In our case we created a full 
VPS backup containing the whole VPS private area and its registry settings. Detailed 
information on backup types is provided in the Backing Up and Restoring VPS section (on 
page 45). 

 node: the hostname of the Backup Node where the VPS backup is stored. In our case the 
Backup Node has the MyNode hostname which corresponds to the IP address of 
203.156.156.203. 

 created: the date and time of the backup creation. As can be seen, our VPS backup was 
created on September 17, 2005 at 14:20:26. 

 backup ID: the backup ID assigned to the VPS backup during its creation. 

You can also use the -b and -f options to display information on the backed up VPS disk 
drives and the contents of a particular folder (i.e. all its subfolders and files) inside your VPS 
backup. In this case you should use the backup ID instead of the VPS ID to specify the backup 
the disk drives or folders of which is to be shown: 

 To see information on the backed up VPS disk drives, issue the following command: 
C:\...\Administrator>vzrestore list -b {BB05D401-CD53-...}\000011bk \ 
-S 203.156.156.203 -U Administrator -P 5tghy7ui8 
connection adjust... 
listing... 
 
name  size  date 
C:          Dec 31 16:00:00 1999 

 To view the contents of a particular folder inside the VPS backup with the backup ID 
specified, you should provide the full path to the folder inside the VPS at the moment of the 
VPS backup creation. So, if you wish to view the contents of the Private subfolder that 
was located in the C:\MyDocs folder inside VPS 101 at the moment of the backup 
creation, you can execute the following command (assuming that the backup is taken from 
the example above): 

C:\...\Administrator>vzrestore list -b {BB05D401-CD53-...}\000011bk \ 
-S 203.156.156.203 -U Administrator -P 5tghy7ui8 -f C:\MyDocs\Private 
connection adjust... 
listing... 
 
 C:\MyDocs\Private 
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vzrestore storage 
The vzrestore storage command is used to manage the default backup folder on the 
Backup Node, i.e. the folder where all VPS backups are to be stored. It has the following 
syntax: 
vzrestore storage [options] 
vzrestore storage -G [options] 
vzbackup storage -D [options] 

You can use the following options with the vzrestore storage command: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node where the VPS backup 
folder location is to be changed. If the option is omitted, the path to the 
backup folder on your local Node will be modified. 

-U, --srv_user 
BackupNodeUser 

The user name used by vzrestore storage to log in to the Backup 
Node. This option is taken into account in case the -A option is specified 
during the vzrestore storage execution. If the -A option is used and 
the -U option is omitted, the utility tries to log in to the Backup Node as 
vzagent0 created on the Backup Node during the Virtuozzo installation. 

-P, --srv_pswd 
BackupNodePasswor
d 

The password of the user specified as the value of the -U option. This option 
is taken into account in case the -A option is specified during the 
vzrestore storage execution. If the -A option is used and the -U 
option is omitted, you should enter the password of the vzagent0 user. 
This is the same password you entered during the Virtuozzo installation on 
the Backup Node for managing your Node and all its VPSs by means of 
VZMC and VZCC. 

-a The path to the folder on the Backup Node. It can be a local folder or a 
folder on your network share. In case you wish to locate your backup folder 
on a network share and this share is password-protected, you should 
additionally specify the -u and -p options to access the folder. 

-u The user name used to log in to the network share where your backup folder 
is to be located. If your network share is not password-protected, you can 
omit this option. 

-p The password of the user specified as the value of the -u option. 

-G Displays information about the VPS backup folder on the Backup Node. 

-D Deletes information about the current backup folder on the Backup Node. 
After removing information on the backup folder, you should set the backup 
folder anew (by executing the vzbackup storage -a command) to be 
able to save VPS backups on the Backup Node. 



 

 Reference 249 
 

All VPS backups are stored in the folder on the Node you specified during the Virtuozzo 
installation for storing all VPS backups. By default, the X:\vz\Backups folder on the Node 
is used. To change the VPS backup folder location, you should use the vzrestore 
storage command. For example: 
C:\...\Administrator>vzrestore storage -A 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 -a G:\MyBackups -u Peter -p 3ewr45t 
connection adjust 
Command 'storage' is successfully finished 

In our example, we specified the MyBackups folder on the Backup Node with the IP address 
of 203.156.156.203 for storing your VPS backups. This folder is located on the G:\ 
network disk drive mapped to the Backup Node. The G:\ drive is password-protected and can 
be accessed by providing the Peter user name and the 3ewr45t password. 

Note: Before specifying another backup folder for storing VPS backups, please make sure that 
this folder already exists on the Backup Node; otherwise, the vzbackup storage -a 
command will fail. 

To display information on the VPS backup folder located on the Backup Node with the IP 
address of 203.156.156.203, you can execute the following command: 
C:\...\Administrator>vzrestore storage -G -A 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 
path = G:\MyBackups 
login = Peter 

The output shows us that: 

 The G:\MyBackups folder is currently used to store VPS backups on the Backup Node 
with the IP address of 203.156.156.203; 

 The MyBackups folder is located on the password-protected G:\ network drive and the 
Peter user name is used to log in to this network drive. 

 
 

vzrestore delete 
The vzrestore delete command is used to remove a VPS backup from the Backup Node. 
This command takes the backup ID to identify what VPS backup is to be deleted from the Node. 
It has the following syntax: 
vzrestore delete backupID [options] 

You can use the following options with vzrestore delete: 

Name Description 
-A, --srv_addr 
BackupNodeAddress 

The IP address or hostname of the Backup Node from the where the 
VPS backup is to be removed. If the option is omitted, the backup will 
be deleted from your local Backup Node. In the case of executing 
vzrestore delete on a Node other than the local Backup Node, 
you should obligatorily specify this option. 
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-U, --srv_user 
BackupNodeUser 

The user name used by vzrestore delete to log in to the Backup 
Node. This option is taken into account in case the -A option is 
specified during the vzrestore delete execution. If the -A 
option is used and the -U option is omitted, the utility tries to log in to 
the Backup Node as vzagent0 created on the Backup Node during 
the Virtuozzo installation. 

-P, --srv_pswd 
BackupNodePasswrd 

The password of the user specified as the value of the -U option. This 
option is taken into account in case the -A option is specified during 
the vzrestore delete execution. If the -A is used and the -U 
option is omitted, you should enter the password of the vzagent0. 
This is the same password you entered during the Virtuozzo 
installation on the Backup Node for managing your Node and all its 
VPSs by means of VZMC and VZCC. 

If you are going to run the vzrestore delete command on the Backup Node itself, you 
only need to specify the VPS backup ID(s) to remove it from the Node. However, to delete a 
VPS backup by executing the command on a Node other then local Backup Node, you should 
also use the options described in the table above. 

For example, the following session shows how do delete the VPS backup of VPS 101 located on 
the Backup Node with the IP address of 203.156.156.203: 

 To learn what ID is assigned to the backup of VPS 101: 
C:\...\Administrator>vzrestore list 101 -S 203.156.156.203 \ 
-U Administrator -P 5tghy7ui8 
connection adjust... 
listing... 
 
VPS 101 
 
backup ID                type   node          created 
{BB05D401-CD53-...}\000011bk  full   MyNode   17/09/2005 14:20:26 

 To delete the backup of VPS 101 with the backup ID of {BB05D401-CD53-
...}\000011bk: 

C:\...\Administrator> vzrestore delete {BB05D401-CD53-...}\000011bk 
connection adjust... 
deleting... 
Command 'delete' is successfully finished 
 

Template Management Utilities 
Template (or package set) is a set of original application files, repackaged for mounting over 
Virtuozzo File System. There are two types of templates in Virtuozzo: OS templates are used to 
create new Virtual Private Servers. A typical example of the OS template is the template 
containing the Windows Server 2003 distribution kit. OS template cannot be installed into VPS, 
because VPS is already based on some OS template. Application templates can be installed into 
VPS after VPS creation; more than one application template may be installed in the same VPS. 
Examples of application templates are the msde template, openssh template, or template with 
any other application (possibly more than one in single template) not included into OS template 
for some reason. 
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vzpkgls 

This utility lists templates installed on the Hardware Node or already installed into a particular 
VPS. It has the following syntax: 
vzpkgls [options] [<VPSID> ...] 

If you specify one or more Virtual Private Server IDs to this command, it lists templates applied 
to the VPSs. Without the <VPSID> argument, the utility lists templates available for Virtual 
Private Servers on the Hardware Node. Other options available to the vzpkgls command are 
listed below: 

-h, --help Displays the usage information and exits. 

-d, --deployed List the templates ready to be used for Virtual Private Servers. 

-s, --separate 

 

By default vzpkgls outputs template and all its updates on a single line 
separated by a space. This option changes output and prints a separate line for 
each available version of the template. 

--quiet Disables logging to the display and to the log file. 

--verbose Sets the log level to the maximum possible value for this vzpkgls session. 

 
 

vzpkgdeploy 

This utility is used for managing OS and application templates on the Hardware Node. It has the 
following syntax: 
vzpkgdeploy [options] PACKAGESTUB DISTRIBPATH  
vzpkgdeploy [options] --install | --uninstall PACKAGE... 
vzpkgdeploy --help 

The options available to this command are: 

-i, --install 
PACKAGE... 

Install deployed template(s) on the Hardware Node. 

-u, --uninstall 
PACKAGE... 

Uninstall template(s) already installed on the Hardware Node. 

-s Add Windows Server 2003 components necessary for running 
Virtuozzo to the Host OS. 

-h, --help Display the usage information and exit. 

--quiet Disables logging to the display and to the log file. 

--verbose Sets the log level to the maximum possible value for this 
vzpkgdeploy session. 
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vzpkgadd 

This utility is used to add an application template to a Virtual Private Server. It has the 
following syntax: 
vzpkadd [options] <VPSID> PACKAGE[/VERSION]... 

This command will add a template (<template>) to the Virtual Private Server with the ID of 
<VPSID>. The <version> parameter specifies the template version to use if there are 
available upgrades; by default, the latest available version is used. 

You may specify a number of templates for adding to a VPS. 

Options available to this command are: 

-h, --help Display the usage info and exit. 

-f, --force Force template installation. 

--quiet Disables logging to the display and to the log file. 

--verbose Sets the log level to the maximum possible value for this 
vzpkgadd session. 

A Virtual Private Server has to be running in order to apply a template to it. 
 

Supplementary Tools 
vzsveinstall 

This utility is used for the Service Virtual Private Server installation. The Service VPS is needed 
for running VZAgent, which is used by Virtuozzo Management Console. The syntax of this 
command is as follows: 
vzsveinstall -s IP [-t OS_Template] [-p] [-w] [-f] 

This utility creates and starts the Service Virtual Private Server. This utility accepts the 
following options: 

-h, --help Displays the utility help. 

-s <svpsip> Required. IP address to be assigned to the Service Virtual Private Server. 

-t <OS template> Optional. OS template to use for the Service Virtual Private Server. By 
default, w2k3 is used. 

-p Optional. Reads the vzagent0 password from the standard input. By 
default, it reads from the console. 

-w Optional. Allows to install the Virtuozzo Control Center application to the 
Service VPS. 

Upon creating the Service Virtual Privates Server and installing the necessary packages into it, 
vzsveinstall will prompt you for the vzagent0 user password. Remember this 
password: you will need it when registering the Hardware Node in Virtuozzo Management 
Console. 
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vzkeygen 

This utility is used to generate the Hardware Node ID to uniquely identify the Node. You should 
send your HWID together with a Virtuozzo license request to the SWsoft sales department to 
obtain a license for running Virtuozzo. It has the following syntax: 
vzkeygen [-n, --company-name NAME] [-o, --output-file FILENAME] 
vzkeygen [-h, --help] 

When using the utility without any options, the output is directed to stdout. By providing the 
-n and -o options, the Hardware Node ID will be stored in the specified file in the 
C:\Documents and Settings\Administrator directory. 
 

vzcache 

There may be situations when one and the same application or application update is installed not 
as a template, but separately inside each and every VPS. A good example of this is the Adobe 
Acrobat Reader application that can be installed inside a number of Virtual Private Servers thus 
having a vast amount of identical files throughout the VPSs. This fact tells dramatically on the 
VPS quotas, which may be avoided by putting all the identical files to the Hardware Node 
template area and creating links instead of real files inside the affected VPSs. 

The problem like the one described above is solved by using the vzcache utility. The 
vzcache utility scans the specified Virtual Private Servers for common files and caches these 
files in the Hardware Node template area (in the C:\vz\templates\__vzcache 
directory), replacing the real files inside the VPSs with links or the so-called stubs, to the 
template area. In case of a significant number of identical files, using this utility results in a 
notable disk space gain. vzcache has the following syntax: 
vzcache [options] VPSID-list 

The following command-line options can be used with the vzcache utility: 

Option Description 
-h, --help Print usage information. 

--version Display the utility version. 

-v, --verbose Verbose mode. Causes vzcache to print debugging messages about 
its progress. Multiple -v options increase verbosity. The maximal 
number of allowed options is 2. 

-q, --quiet Quiet mode. Causes all warning and diagnostic messages to be 
suppressed. Only fatal errors are displayed. 

-a, --append Use an existing cache for comparing its files with the regular files 
inside the specified Virtual Private Servers. Should be used together 
with the -n option. 

-n, --cache-name NAME The name of the cache subdirectory in the 
C:\vz\templates\__vzcache directory.  

-t, --test Do not perform any caching. Just collect and display the statistics on 
identical files. 

-s, --size-limit N Do not process files smaller than N bytes. By default, only empty 
files are not processed. 

-c, --comm-index M Cache files found at least M times. The default value is 2. 
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-f, --force Force vzcache operations for a single Virtual Private Server and 
single regular files. 

Here are some examples on using the vzcache utility: 

To create a cache named myfirstcache for VPSs 153 and 154 caching only those files 
which are greater than 1024 bytes by using the vzcache utility, you should issue the following 
command: 
vzcache -s 1024 -n myfirstcache 153 154 

To append VPS 155 to the existing myfirstcache cache: 
vzcache -a -n myfirstcache 155 
 

vzlscache 

The vzlscache utility displays a list of cache directories created by the vzcache utility (see 
above). It can be used to show either all the cache directories created on the given Hardware 
Node, or those used by the specified VPS(s). The syntax of the command is the following: 
vzlscache [options] [VPSID ...] 

The following options may be given: 

Option Description 
-h, --help Print usage information. 

-q, --quiet Quiet mode. Causes all warning and diagnostic messages to be 
suppressed. Only fatal errors are displayed. 

 
 

vzuncache 

Whereas the vzcache utility helps effectively gain disk space both in the Hardware Node and 
within Virtual Private Servers, there may be situations when it is necessary to detach a Virtual 
Private Server from its cache and copy the cached files back to the VPS private area. A typical 
example of this is migrating a VPS to another Hardware Node. The migration is not possible if 
there are links in the VPS private area pointing to the C:\vz\templates\__vzcache 
directory on the Hardware Node. 

The vzuncache utility is used to copy the regular files from the specified cache directory on 
the Hardware Node (located in the C:\vz\templates\__vzcache directory) back to the 
private area of the specified VPS, replacing the corresponding links or stubs inside the VPS with 
the real files and thus detaching the VPS from its cache. vzuncache has the following syntax: 
vzuncache [options] VPSID [cache-directory-name ...] 

The following command-line options can be used with the vzuncache utility: 

Option Description 
-h, --help Print usage information. 

--version Display the utility version. 

-q, --quiet Quiet mode. Causes all warning and diagnostic messages to be 
suppressed. Only fatal errors are displayed. 
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-v, --verbose Verbose mode. Causes vzuncache to print debugging messages 
about its progress. Multiple -v options increase verbosity. 

-a, --all Detach the specified Virtual Private Server from all the caches. The 
list of cache directories is not needed if this option is specified. 

-t, --test Do not copy files from the cache. Just collect and display the 
relevant statistics. 

-f, --force Detach the specified Virtual Private Server from its cache even in 
case the cache does not exist. 

For example, you can use the vzuncache utility to learn what cache(s) a certain VPS is using 
or to ensure that it does not use any caches: 
vzuncache -t -f -a <VPSID> 
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Application template is a template used to install a set of applications in Virtual Private Servers. 
See also Template. 

Hardware Node (or Node) is a computer where Virtuozzo is installed for hosting Virtual Private 
Servers. 

HN is an abbreviation of Hardware Node. 

Host Operating System (or Host OS) is an operating system installed on the Hardware Node. 
Sometimes, it is marked as VPS 0. 

HSPcomplete is an end-to-end solution for Hosting Service Providers by SWsoft. Is dependent 
on Virtuozzo. 

OS template (or Operating System template) is used to create new Virtual Private Servers. See 
also Template. 

Package set is a synonym for Template. 

Private area is a part of the file system where VPS files that are not shared with other Virtual 
Private Servers are stored. 

QoS is an abbreviation of Quality of Service. 

Quality of Service specifies the performance properties of a VPS. It allows you to provide a fair 
share of the main system resources among Virtual Private Servers and better service quality for 
preferred VPSs. 

Service Virtual Private Server denotes a special secure VPS running VZAgent which is 
responsible for managing all the Virtual Private Servers of the given Hardware Node. You 
should use the IP address of the Service VPS to connect to a Hardware Node by means of 
VZMC or VZCC. The Service VPS is always marked as Virtual Private Server 1. 

Service VPS is an abbreviation of Service Virtual Private Server. 

SSH stands for Secure Shell. It is a protocol for logging on to a remote machine and executing 
commands on that machine. It provides secure encrypted communications between two 
untrusted hosts over an insecure network. 

Stub is a special file (usually inside a Virtual Private Server) containing a pointer to a real file 
on the Node. The size of this file is equal to 0. However, thanks to the Virtuozzo File System, 
stubs appear to a VPS user as real files. 

TCP (TCP/IP) stands for Transmission Control Protocol/Internet Protocol. This suite of 
communications protocols is used to connect hosts on the Internet. 
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Template (or package set) is a set of original application files (packages) repackaged for 
mounting over Virtuozzo File System. There are two types of templates. OS Templates are used 
to create new Virtual Private Servers. Application templates are used to install an application or 
a set of applications in Virtual Private Servers. 

UBC is an abbreviation of User Beancounter. 

User Beancounter is the subsystem of Virtuozzo for managing VPS memory and some system-
related resources. 

Virtual Environment or VE is an obsolete designation of a virtual private server. See Virtual 
Private Server. 

Virtual Private Server is a virtual private server, which is functionally identical to an isolated 
standalone server, with its own IP addresses, processes, files, its own users database, its own 
configuration files, its own  applications, system libraries, and so on. Virtual Private Servers 
share one Hardware Node and one OS kernel. However, they are isolated from each other. 
Virtual Private Server is a kind of ‘sandbox’ for processes and users. Virtual Private Server 0 is 
used to designate the Hardware Node itself. 

Virtuozzo is a complete server automation and virtualization solution allowing you to create 
multiple isolated Virtual Private Servers on a single physical server to share hardware, licenses, 
and management effort with maximum efficiency. 

Virtuozzo Adapter is a virtual networking device, a gateway from a VPS to the external network. 
Virtuozzo Adapter is automatically created during the Virtuozzo installation. 

Virtuozzo Control Center is a tool designed for managing a particular Hardware Node and all 
Virtual Private Servers residing on it with the help of a standard Web browser on any platform. 

Virtuozzo File System is a virtual file system for mounting to VPS private areas. VZFS links are 
seen as real files inside Virtual Private Servers. 

Virtuozzo license is a special license that you should load to the Hardware Node to be able to 
start using Virtuozzo. Every Hardware Node shall have its own Virtuozzo license file. 

Virtuozzo Management Console is a Virtuozzo management and monitoring tool with graphical 
user interface. It uses VZagent Protocol to control Hardware Nodes and their Virtual Private 
Servers. VZMC is cross–platform and runs on both Microsoft Windows and Linux 
workstations. 

Virtuozzo Power Panels is a means for administering personal Virtual Private Servers with the 
help of a standard Web browser (Internet Explorer, Mozilla, etc.) on any platform. 

VPS is an abbreviation of Virtual Private Server. 

VPS 0 is used to designate a Hardware Node where Virtuozzo is installed. 

VZAgent is a special software used to tune, monitor, and manage the given Hardware Node and 
all the Virtual Private Servers residing on this Node. 

VZagent Protocol is an XML–based protocol used to monitor and manage a Hardware Node. 
The vzagent software implements this protocol and is a backend for the Virtuozzo 
Management Console and other Virtuozzo utilities. 
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vzagent0 is the user who has a full administrative access to the Service VPS. You will need to 
provide this user name and password when connecting to a Hardware Node by means of VZMC 
and VZCC. 

VZCC is an abbreviation of Virtuozzo Control Center. 

VZCC license is a license needed to activate VZCC. You should enter it the first time you log in 
to VZCC. 

VZFS is an abbreviation of Virtuozzo File System. 

VZMC is an abbreviation of Virtuozzo Management Console. 

VZMC license is a license needed to activate VZMC. You should enter it the first time you 
launch VZMC. 

VZPP is an abbreviation of Virtuozzo Power Panels. 
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